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Typographic Conventions 

Type Style Description 

Example Words or characters quoted from the screen. These include field names, screen titles, 

pushbuttons labels, menu names, menu paths, and menu options. 

Textual cross-references to other documents. 

Example Emphasized words or expressions. 

EXAMPLE Technical names of system objects. These include report names, program names, 

transaction codes, table names, and key concepts of a programming language when they 

are surrounded by body text, for example, SELECT and INCLUDE. 

Example Output on the screen. This includes file and directory names and their paths, messages, 

names of variables and parameters, source text, and names of installation, upgrade and 

database tools. 

Example Exact user entry. These are words or characters that you enter in the system exactly as 

they appear in the documentation. 

<Example> Variable user entry. Angle brackets indicate that you replace these words and characters 

with appropriate entries to make entries in the system. 

EXAMPLE  Keys on the keyboard, for example, F2  or ENTER . 
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1 Introduction 

The SAP Business One Administrator's Guide provides a central point for the technical implementation of SAP 

Business One, including server components, client components, and add-ons.  

 Note  

Visit sappartneredge.com and select SAP Business One in you profile to ensure you receive the latest 

information about SAP Business One directly on your home page 

 Note  

This guide covers only the installation, configuration, and upgrade of SAP Business One and its add-ons.  

For information about installing the remote support platform (RSP) for SAP Business One, see 

Administrator’s Guide to Remote Support Platform for SAP Business One. You can find the guide 

(RSP_AdministratorGuide.pdf) under ...\Documentation\Remote Support Platform\System Setup\ on the 

SAP Business One product DVD, or on sappartneredge.com. 

For information about installing SAP Crystal Reports, version for the SAP Business One application, see 

Installing SAP Crystal Reports, version for the SAP Business One Application. 

This guide consists of the following main sections: 

 Prerequisites 

Outlines the prerequisite steps you must complete before you can proceed with the installation and 

configuration of SAP Business One components. 

 Installing SAP Business One 

Provides instructions for installing and configuring SAP Business One components, and for removing the 

application. 

The typical installation scenarios are: 

o Server–client installation 

o Standalone installation 

o Remote installation 

 Installing SAP Crystal Reports, version for the SAP Business One application 

Provides instructions for installing the application. 

 Uninstalling SAP Business One  

Provides the process flow and instructions for uninstalling the application. 

 Upgrading SAP Business One 

Provides instructions for upgrading SAP Business One. You can use either of the following upgrade methods: 

o Upgrading with the SAP Business One upgrade wizard — You can use the SAP Business One upgrade 

wizard to guide you through the upgrade of server components and client files. After completing the 

wizard successfully, you can log on to SAP Business One to upgrade the client application.  

 Upgrading directly from upgrade folders — You can upgrade some SAP Business One components directly 

from files in the upgrade folder. This option is suggested for advanced users only.Performing Post-

Installation Activities 

http://sappartneredge.com/
file:///C:/D/Work/Projects/B1H/9.1H/PL00/Documentation/sappartneredge.com
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Provides instructions for configuring SAP Business One components after you complete the installation. 

The activities include: 

o Configuring services  

o Assigning SAP Business One add-ons 

o Installing Microsoft Outlook integration standalone version 

o Performing post-installation activities for the integration framework 

 Maintaining Databases 

Assists you with the following routine operations of SAP Business One and its database: 

o Database server administration, including: 

o Starting and stopping database services 

o Performing weekly tasks 

o Performing regular tasks 

o Performing backups 

o Performing restore functions 

o Working with Data Transfer Workbench  

 Managing Security in SAP Business One 

Explains how to implement a security policy and provides recommendations for meeting the security 

demands of SAP Business One.  

 Getting Support  

Introduces the means by which you can get support from SAP, including: 

o SAP Business One online help documentation 

o SAP Notes 

o Support desk 

To find out how to access other information about SAP Business One, see the Easy Start Guide in the product 

folder. 

1.1 Application Components Overview 

This section provides a description of the important software components of SAP Business One and how they are 

used by SAP Business One’s business processes. 

SAP Business One is a client-server application, consisting of a fat client and database server. The SAP Business 

One database stores only data and does not use triggers. However, the database does use views, especially for 

reporting and upgrade purposes. 

SAP Business One can run on Windows Terminal Services or Citrix Server, and can run in several instances for 

different sessions. 

The following figure provides an overview of the server architecture of SAP Business One. 
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SAP Business One Server Architecture 

A typical installation scenario consists of the following components: 

 Mandatory SAP Business One server components: 

o SAP Business One server 

Includes the system database SBOCOMMON as well as a shared folder.  

SBOCOMMON is the central database that holds system data, version information, and upgrade information. 

Unlike company databases, SBOCOMMON does not store any business or transactional data. 

o License server 

Works with Microsoft SQL Server to maintain user sessions and purchased licenses. You can install the 

license server on a different machine to the main SAP Business One server. 

o System Landscape Directory (SLD) 

Authenticates users and manages an entire SAP Business One landscape. You must install the SLD on the 

same machine on which the license server is installed. You can access the SLD using a Web interface to: 

o Add, remove, and edit database servers 

o Manage authentication settings for database servers 

o View information about the companies on a database server 

o Enable single sign-on functionality 

o Manage encryption keys 

o Change the SAP Business One site password 

 Optional SAP Business One server components: 

o Other services of SAP Business One server tools 

o Remote support platform for SAP Business One 

Proactively manages the installation and maintenance of SAP Business One. The platform remotely 

monitors the health of an SAP Business One installation and provides automated healing, backup 

support, and distribution of software patches. 

o Microsoft Outlook Integration Server Add-On 
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 The SAP Business One client is the application executable. The client computer holds the following SDK 

components used by add-ons: 

o Data Interface API — COM-based API and an applicative dll (OBSever.dll) file that enables add-ons to 

access and use SAP Business One business objects. 

o User Interface API — COM-based API that is connected to the running application and enables add-ons to 

perform runtime manipulation and enhancement of the SAP Business One GUI and its flow. 

Note 

All SAP Business One components must be installed in the same LAN (local area network). For users 

outside the LAN of the server (for example, using VPN connection), we recommend that you use a remote 

desktop to access the SAP Business One client instead of installing the SAP Business One client directly. 

 

The following figure provides an overview of the architecture of SAP Business One. 

 

SAP Business One Architecture 

More Information 

For the latest information that may not appear in this guide, see the following SAP Notes: 

 SAP Note 2001307 (Central Note for SAP Business One 9.1) 

 SAP Note 528296  (General Overview Note for SAP Business One Releases) 

 SAP Note 2012414 (Release Update Note for SAP Business One 9.1 Limitations) 

https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303331343639303030303035323637343230313426
https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303631353332303030303032363833323230303226
https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303331343639303030303035323637343230313426
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 SAP Note 2004987 (Collective Note for SAP Business One 9.1 Upgrade issues) 

 SAP Note 2014689  (Collective Note for SAP Business One 9.1 Documentation issues) 

 SAP Note 2014732  (Collective Note for SAP Business One 9.1 General issues) 

 

https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303331343639303030303033373633363230313426
https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303331343639303030303035373138363230313426https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303331343639303030303035373138363230313426
https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303331343639303030303035373232303230313426
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2 Prerequisites 

 For information on hardware requirements, see the SAP Business One Hardware Requirements Guide on 

sappartneredge.com. 

 For an overview of support platforms for SAP Business One and related products, see the SAP Business One 

Platform Support Matrix on sappartneredge.com. 

 For information about platform availability, including database platforms and operating systems, see the 

Product Availability Matrix on sappartneredge.com. 

 For compatibility information regarding the SAP Business One client and SAP Business One OnDemand, see 

SAP Note 1756002.  

 You have installed SAP Crystal Reports, version for the SAP Business One application. For more information, 

see Installing SAP Crystal Reports, version for the SAP Business One Application. 

 You have installed a supported version of Microsoft SQL Server. 

 Note 

If you have not installed Microsoft SQL Server, you can install it during the installation process if you have 

installation media for Microsoft SQL Server. 

 You have installed Microsoft .NET Framework 4.0 on the server. 

 Note 

If you do not have Microsoft .NET Framework 4.0 installed, it is installed during the SAP Business One 

installation process. However, you will have to restart your machine. To avoid a restart, you may choose 

to install the framework before starting the SAP Business One installation.  

 In the SAP Business One server installation and upgrade procedures, you have the option of installing remote 

support platform for SAP Business One. For more information, see Administrator’s Guide to Remote Support 

Platform for SAP Business One.  You can find the guide (RSP_AdministratorGuide.pdf) under 

...\Documentation\Remote Support Platform\System Setup\ on the SAP Business One product DVD, or on 

sappartneredge.com. 

 You have installed one of the following Web browsers on the machine on which you want to install the System 

Landscape Directory service: 

o Microsoft Internet Explorer 8 or later 

o Mozilla Firefox 9 or later 

o Google Chrome 12 or later 

 To display dashboards in the SAP Business One client application, ensure you have installed Adobe Flash 

Player for the embedded browser Google Chrome on each of your workstations. You can download Adobe 

Flash Player at http://www.adobe.com.  

Note 

The download link provided by Adobe is by default for Microsoft Internet Explorer. To download Adobe 

Flash Player for other browsers, choose to download for a different computer, and then select the correct 

operating system and a Flash Player version for other browsers. 

http://sappartneredge.com/
http://sappartneredge.com/
http://sappartneredge.com/
http://service.sap.com/sap/bc/bsp/spn/smb_searchnotes/display2.htm?note_langu=E&note_numm=1756002
http://sappartneredge.com/
http://www.adobe.com/
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 You have ensured that the names of the machines on which you want to install SAP Business One do not 

contain one or more non-standard characters (standard characters are letters, digits, and hyphens).  

Using non-standard characters in the name of a machine prevents it from being found on networks, and 

causes the installation of SAP Business One to fail. 

2.1 Constraints 

You can run the SAP Business One for 31 days without a license. To continue working with the application after 31 

days, you must install a valid license key assigned by SAP. 

 Note 

If you are a partner, for more information about installing the license key, see SAP Business One License 

Guide on sappartneredge.com. 

The demonstration databases provided are not for productive use. The application supports 40 localizations in 

the demonstration databases. 

2.2 User Privileges 

The following table summarizes the requirements and recommendations for the group setup of the displayed 

operating system: 

Operation Operating System User Group  

 Recommended Minimum 

Client installation Microsoft® Windows operating 

systems 

 

 

Administrator Administrator 

Client upgrade Administrator Administrator 

Runtime Users Users 

SAP Business One supports the Windows 7 and Windows 8 operating systems in a server configuration 

environment for standalone systems and clients. 

 Note 

For more information about possible installer issues related to the user account control (UAC) in 

Microsoft Windows operating systems, see SAP Note 1492196. 

2.3 Installation Checklist 

To perform a correct and complete installation of SAP Business One, do the following: 

 Install Microsoft SQL Server 2008, 2008 R2, 2012, or 2014. 

 Install the SAP Business One server tools. 

http://sappartneredge.com/
http://service.sap.com/sap/bc/bsp/spn/smb_searchnotes/display2.htm?note_langu=E&note_numm=1492196
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 Install the SAP Business One server components. 

 Install the SAP Business One client application on workstations. 

 Install optional components (add-ons, SDK). 

 Install the integration framework of SAP Business One.  

 If you want to design your own Crystal Reports layouts and reports, install SAP Crystal Reports, version for 

the SAP Business One application. 

The precise sequence of these steps depends on your installation scenario. For more information, see the relevant 

sections in Installing SAP Business One. 
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3 Installing SAP Business One 

Based on common business scenarios, the typical installation scenarios for SAP Business One are as follows: 

 Server–client mode — SAP Business One server and server tools are installed on one machine; one or more 

clients are installed on other machines. 

 Standalone mode — SAP Business One server components and clients are installed on a single machine. 

 Remote mode — SAP Business One is installed on a terminal server or in a Citrix environment. 

Latency and bandwidth requirements 

All SAP Business One components must be installed in the same LAN (local area network). Putting the client and 

the server into two different locations (for example, VPN) will have an impact on the performance of SAP Business 

One. Thus, latency should be as low as possible (< 1 ms). 

The same LAN means: 

 Sufficient bandwidth > 100 M 

 Small latency < 1 ms 

 Same WINS server 

 Same local DNS server, if configured 

 Same AD server, if AD is being used 

For users outside the LAN of the server (for example, those using VPN connection), we recommend that you use a 

remote desktop or the SAP Business One Browser Access service to access the SAP Business One client instead 

of installing the SAP Business One client directly. 

3.1 Installation Scenarios 

You can install SAP Business One using one of the following scenarios: 

 Server–client mode 

Server-client mode is considered best practice for an SAP Business One installation. In this mode, you install 

the following on the server: 

o SAP Business One server tools 

o SAP Business One server 

o Microsoft Outlook integration add-on 

o The integration framework of SAP Business One 

You install the following on client machines: 

o SAP Business One client  

o Optional client components, which include:  

o SBO Mailer and fax service 
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o Software Development Kit (SDK) 

o Data Transfer Workbench 

o Microsoft Outlook integration add-on standalone version 

 Standalone mode 

You install the following server and client components on a single machine: 

o SAP Business One server tools 

o SAP Business One server 

o Microsoft Outlook integration server installer add-on 

o The integration framework of SAP Business One 

o SAP Business One client  

o Optional client components 

 Remote mode 

This mode enables users to log on to SAP Business One from a remote location. You install the following on a 

remote server: 

o SAP Business One server tools 

o SAP Business One server components 

o Microsoft Outlook integration add-on 

o The integration framework of SAP Business One 

o SAP Business One client  

o Optional client components 

o Microsoft Windows server terminal services 

On client machines, you install Microsoft terminal services client. 

3.2 Installing SAP Business One in Server–Client Mode 

In this scenario, you perform the server and client machine installations separately, as shown in the following 

figure. 
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Server-Client Mode 

 Performing Server Installations 

You need to perform the following actions on the server: 

 Install SAP Business One server tools, including the following: 

o System Landscape Directory (SLD) 

o License service 

o Extension manager: Manages lightweight deployment of add-ons. 

 Install SAP Business One server, including: 

o Shared folder (B1_SHR) 

o System database (SBOCOMMON) 

o Demo databases 

o Online help files in all supported languages 

o Microsoft Outlook integration server 

 Note 

You can install SAP Business One server tools together with the SAP Business One server. However, if 

you want to install them separately, you must install the server tools first. The System Landscape 

Directory is a precondition for all other server and client components. 

 Register add-ons.  

The installation of the server components automatically registers all SAP add-ons on the server. There is no 

need for additional registering. 

The SAP Business One server application automatically registers SAP add-ons to all companies on the server. 

Add-ons appear in the Available Add-Ons list in the Add-On Administration window. 

For more information, see Assigning SAP Business One Add-Ons. 
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 Caution  

The SAP Business One installation creates a new SQL user and password. Do not modify or delete this 

user ID or password. They are essential for the correct operation of the SAP Business One application. 

 Change the sa login password or create an alternative user.  

For security reasons, we recommend that you set up a strong password for the sa user right after installing 

the SAP Business One database server.  Alternatively, as a safer option, create another database user 

account as a substitute for the sa user. For more information, see Database Authentication. 

 Caution 

If you change the database administrator account, you must re-install the System Landscape Directory. 

For more information, see Installing Server Tools.  

Prerequisites 

 The installation computer complies with all hardware and software requirements. For information on 

hardware and software requirements, search for related information on sappartneredge.com. 

 You have administrator rights on the machine on which you are performing the installation. 

 Note 

For more information about possible installer issues related to the user account control (UAC) in 

Microsoft Windows operating systems, see SAP Note 1492196. 

 If the machines on which the SAP Business One client and DI API run use an HTTP proxy for network access, 

you have added the System Landscape Directory server to the list of proxy exceptions. 

3.2.1.1 Installing Microsoft SQL Server 

 Note  

The information given for Microsoft SQL Server 2008 is also valid for Microsoft SQL 2008 R2, Microsoft 

SQL 2012, and Microsoft SQL 2014. 

 Note  

For more information about upgrading Microsoft SQL Server, see the following documents: 

o SAP Note 928839.  

o "Hardware and Software Requirements for Installing SQL Server 2014" as stipulated by Microsoft® 

Corp. 

o For the latest detailed platform support information, refer to the following overview pages: 

Partners — See the Platform Support Matrix for SAP Business One on sappartneredge.com. 

Customers — http://service.sap.com/smb/sbocustomer → Documentation → Release Family 9.0 → 

SAP Business One 9.1 → System Administration → Platform Support Matrix for SAP Business One. 

http://sappartneredge.com/
http://service.sap.com/sap/bc/bsp/spn/smb_searchnotes/display2.htm?note_langu=E&note_numm=1492196
https://i7p.wdf.sap.corp/sap/support/notes/928839
http://msdn.microsoft.com/en-us/library/ms143506.aspx
http://sappartneredge.com/
http://service.sap.com/smb/sbocustomer


 

18 

CUSTOMER  

©  2016 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Installing SAP Business One 

 

Procedure 

 If the product package is zipped, you must first unzip the folder.  

 Navigate to the product root folder and double-click the Autorun.exe file. 

If you are using Windows Server 2008 or Windows 7, right-click the Autorun.exe file and choose Run as 

administrator. 

The SAP Business One Installation window appears. 

 In the installation window, select the Server radio button, and choose the Next button.  

If you have already installed a supported version of Microsoft SQL Server, proceed with Changing the sa 

Logon Password and Creating an Alternative User. 

   

 If Microsoft SQL Server is not detected, the Microsoft SQL Server installation window appears. Do one of the 

following: 

o To install Microsoft SQL Server, select the Install supported Microsoft SQL Server on this machine 

checkbox and then choose the Next button. 

 Caution 

Ensure that the name of the server on which you installed Microsoft SQL Server does not contain any 

special characters, such as: &, <, >, ”, or ’. 

o If you have installed Microsoft SQL Server, to continue with the SAP Business One installation, select the 

If  a compatible version of Microsoft SQL Server has already been installed, continue installing SAP 

Business One checkbox.  

Proceed to Installing Server Tools.  
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 In the Microsoft SQL Server Installation window, do the following: 

1. Insert the Microsoft SQL Server DVD in the DVD drive. 

2. In the Installation Folder field, specify the location where you want to install Microsoft SQL Server. 

3. To start the silent installation, choose the Install button. 

     

 In the message dialog box, choose the OK button. 

 In the Choose file window, locate the Microsoft SQL Server  installation file (setup.exe). 
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Choose the Open button. 

The setup begins a silent installation of Microsoft SQL Server components and applies the default values 

shown in the following table. 

 Note 

If you do not have Microsoft .NET Framework 4.0 installed, it is installed during the silent installation 

process. This requires restarting your machine before you can proceed with the installation of Microsoft 

SQL Server. 

After restarting your machine, you need to start the installation procedure from the beginning (step 1). In 

step 6, in the Choose file window, locate the Microsoft SQL Server installation file (setup.exe) and 

proceed with the installation procedure. 

 Note  

Due to the following limitation in Windows Server 2008, the following applies: 

If you are installing Microsoft SQL Server 2008, at the end of the silent installation, the Windows Desktop 

may disappear because of the Run as Administrator permissions settings.  

If the Windows Desktop disappears, log off from Windows after the Microsoft SQL Server installation, 

then log back on and start the SAP Business One installation process from step 1. 

 Note  

If you install Microsoft SQL Server separately instead of during the SAP Business One installation, ensure 

that you enter the connection settings shown in the following table. 

 

Window Name Fields 

Registration Information  Name — Copied from the local system 

 Company — Copied from the local system 

 CDKey — Copied from the installation DVD 

Components to Install SQL Server Database Service 

Workstation Components, Books Online, and development tools 

Instance Name MSSQLServer 

Note  

Ensure that in the TCP/IP protocol properties of your SQL Server 

instance, the TCP Port field is set to 1433. 

 Note  

If port 1433 is blocked by another application, you may use a 

different port. However, you must add the alternate port (for 

example, 9033) to the server name as follows: SERVER_NAME,9033. 

Service Account  Use the built-in system account – Local System 

 Start the services at the end of the setup – SQL Server 

Authentication Mode  Mixed Mode (Windows Authentication and SQL Server Authentication) 
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Window Name Fields 

 Password — SAPB1Admin 

Collation Settings SQL collations – Dictionary order case-insensitive, for use with 1252 

Character set, Accent - Sensitive (SQL_Latin1_General_CP1_CI_AS). 

 Note  

If you manually install SQL Server, in the Collation Settings window, 

select the SQL collations (used for compatibility with previous 

versions of SQL Server) radio button and choose the 

SQL_Latin1_General_CP1_CI_AS option from the list. 

Error and Usage Report 

Settings 

None marked 

 When Microsoft SQL Server is installed successfully, and you can see the confirmation window, you can 

remove the Microsoft SQL Server DVD.  

To continue with the SAP Business One installation, choose the Next button. 

 Note  

To create high-availability for your server, you can use the AlwaysOn Failover Cluster Instances and Log 

Shipping high-availability solution options provided by the Microsoft SQL Server. For more information, 

see the Microsoft documents at www.microsoft.com. 

3.2.1.2 Changing the sa Logon Password and Creating an 
Alternative User 

For security reasons, set up a strong password for the sa user right after installing the SAP Business One 

database server. Alternatively, as a safer option, create another database user account as a substitute for the sa 

user. For more information, see Database Authentication. 

 Caution 

If you change the database administrator account, you must re-install the System Landscape Directory. 

For more information, see Installing Server Tools.  

3.2.1.3 Installing Server Tools 

 Caution 

If you are installing the server tools on Microsoft Windows Server 2008 R2, you must first turn off 

Microsoft Internet Explorer Enhanced Security Configuration (IE ESC), as follows: 

1. In Windows, choose Start → All Programs → Administrative Tools → Server Manager. 

2. In the Security Information area of the Server Manager window, click Configure IE ESC. 

http://www.microsoft.com/
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The Internet Explorer Enhanced Security Configuration window appears. 

3. In the Administrators and Users areas, choose both Off checkboxes. 

4. Choose the OK button. 

Procedure 

To install the server tools for SAP Business One, do the following: 

 Navigate to the product root folder again and double-click the Autorun.exe file. 

If you are using Windows Server 2008 or Windows 7, right-click the Autorun.exe file and choose Run as 

administrator. 

 In the installation window, select the Server radio button, and choose the Next button. 

 

 In the Server Components window, do one of the following:  

o To automatically install all required server components in one batch, on the same computer, select the 

Full radio button. 

o To install server components individually, select the Custom radio button and select the components that 

you want to install. 

 Recommendation  

Select the custom option as this option lets you view all available server components. You can then select 

the components that you want to install on different machines.  
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To run the InstallShield wizard, choose the Install button. 

 Caution 

It may take some time for the InstallShield wizard to appear. While you are waiting for the wizard to load, 

do not activate any other window. 

 In the Welcome window, choose the Next button. 

 In the Setup Type window, select one of the following options: 

o Typical — Installs the most common components. 

o Custom — Installs the components you select. 
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 In the Select Destination Folder window, specify the location where you want to install the server components. 

 Caution  

To install the server components and all additional components, use the standard directory 

(...\SAP\SAP Business One Server). If you change the path, do not change the directory names. 

This rule also applies to the installation of the server components and the client components. 
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 In the Select Features window, select the corresponding checkboxes for the components you want to install.  

 Note 

SAP Business One Service Manager is required to access all server tools. The Service Manager checkbox 

is automatically selected and you cannot deselect it.  
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 In the Site User Password window, enter and confirm the password for the SAP Business One site user 

account. 

The site user ID serves as site-level authentication for performing the following activities: 

o Configuring database credentials 

o Creating companies 

o Configuring services 

o Registering add-ons 

o Updating read-only user passwords 

A site user password is required for authentication against the SLD service during the following situations: 

o Configuring services via SAP Business One Service Manager 

o Installing SAP Business One servers 

o Creating new companies on SAP Business One clients  

 

 Note  

To configure any service in the service manager after installation, you must specify the site user 

password only on the first logon. 

 Recommendation 

For security reasons, you should set a strong site user password, at least as strong as that defined in your 

company’s password policy, and change it frequently. For more information, see Managing Security in 

SAP Business One. 
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 In the System Landscape Directory Security Certificate window, enter a valid PKCS12 certificate store and 

password or select the Use Self-Signed Certificate radio button. 

Communication between the SLD and SAP Business One clients or DI API is encrypted using the HTTPS 

protocol, so a certificate is required for authentication. You can obtain a certificate using the following 

methods: 

o Third-party certificate authority – You can purchase certificates from a third-party global Certificate 

Authority that Microsoft Windows trusts by default. If you use this method, select the Specify PKCS12 

Certificate Store and Password radio button and enter the required information. 

o Certificate authority server – You can configure a Certificate Authority (CA) server in the SAP Business 

One landscape to issue certificates. You must configure all servers in the landscape to trust the CA’s root 

certificate. If you use this method, select the Specify PKCS12 Certificate Store and Password radio button 

and enter the required information. 

o Generate a self-signed certificate – You can let the installer generate a self-signed certificate; however, 

your browser will display a certificate exception when you access the SLD server as the browser does not 

trust this certificate. To use this method, select the Use Self-Signed Certificate radio button. 
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 In the System Landscape Directory Database Configuration window, specify the following: 

o Database Server — Enter the name of the database server on which you want to install the SLD database. 

 Caution 

Ensure you install the SLD service on the same machine as the license service.  

o Database Name — Enter a name for the SLD database. 

 Note  

Ensure that the server name does not contain underlined text '_'. Otherwise, you will not able to add the 

server to the SLD. 

o Authentication Mode — Select the type of authentication you want to use. If you select SQL Server 

authentication, enter the user name and password of the sa account. 

 Recommendation 

Select SQL Server authentication, as Windows authentication has the following limitations: 

o Windows authentication in SAP Business One is a server level configuration. All users on the same 

SAP Business One server can use Windows authentication to connect to Microsoft SQL Server. 

o Windows authentication requires you to maintain each computer added to the domain, while SQL 

Server authentication shares database users (such as sa) on the same SAP Business One server. 

o Windows authentication requires the Microsoft Windows account on which the SLD service runs to 

have administrative permissions on the database. 
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o To install the selected components, choose the Next button.  

o To change the settings, choose the Back button to return to the previous steps.  

 In the Complete window, choose the Finish button. 

Note: 

If you later change the password of the database user used to install the System Landscape Directory 

(SLD), the SLD will stop working.  Additionally, you cannot change the certificate for secure connection to 

the SLD. For more information, see the sections Cannot change database user password for System 

Landscape Directory and Cannot change certificate for System Landscape Directory in Troubleshooting 

Security. 

3.2.1.4 Installing the SAP Business One Server  

Prerequisites 

 You have your computer’s name or IP address available.  

o To check your computer’s full name, do the following: 

1. In Windows, choose Start → Control Panel → System. 

The name of your computer appears in the System Properties window, on the Computer Name tab, 

next to the Full computer name field. 

2. Keep a record of the displayed computer name. 

file:///C:/Users/i071138/Documents/Assignments/Admin%20Guides/Admin_Guide/9.1/PL02/AdministratorGuide_SQL.docx%23_Troubleshooting_Security
file:///C:/Users/i071138/Documents/Assignments/Admin%20Guides/Admin_Guide/9.1/PL02/AdministratorGuide_SQL.docx%23_Troubleshooting_Security
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o To check your computer’s IP address, do the following: 

1. In Windows, choose Start  Run. 

2. In the Open field of the Run window, enter cmd and press Enter . 

3. In the cmd.exe window, enter ipconfig and press Enter . 

4. Keep a record of the displayed IP address. 

 If the SAP Business One license server is installed on a different computer, ensure that the license server is 

running when you are installing the SAP Business One server. For information about starting the license 

server, see Configuring the License Manager. 

Procedure 

 In the Server Components window, you can see that the installed Server Tools option is marked as installed 

now. To continue with the SAP Business One server installation, select the SAP Business One Server 

checkbox, and then choose the Install button. 

  

 In the Welcome window, to continue, choose the Next button. 

 In the Customer Information window, specify your user ID and company name, and then choose the Next 

button. 
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 If your license server is installed on a different machine, the License Authentication window appears.  

In the License Authentication window, specify the license server information you defined in the server tools 

installation. 

Choose the Next button. 

If you have problems specifying the license server address, use the IP address of the license server. 

 Caution 

Use standard ports. Changing the ports can affect the installation of the components that follows this 

installation. This rule applies to the installation of all the server and client components. 
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Note: 

The license service uses the Common Object Request Broker Architecture (CORBA). To ensure that the 

license service works properly, ensure the following: 

o Only install one network interface card (NIC) on the CORBA license server. 

o Only assign one IP address to the CORBA license server. 

o Do not use a dial-up or VPN interface-configured server. 

 

To solve this issue, perform the following (if applicable): 

1. Change the registry entry and add the IP address of the license server computer as follows:  

2. For 32-bit operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\ACE\TAO       

3. For 64-bit operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ACE\TAO 

4. For example: -ORBEndPoint iiop://10.59.39.60:30000  -ORBDottedDecimalAddresses 

1  

5. Use the IP address instead of the computer name for the license server address where required, 

such as for the SAP Business One client, DI API, B1i, and so on. 

OR 

6. Disable additional network cards in the Control Panel according to your system instructions. Ensure 

there is no dial-up interface or VPN interface configured and restart the server. Note that you can re-

enable the additional network card after restart. This will resolve the issue until the next restart.  

o For more information, see SAP Note 1135705. 

 

 In the Setup Type window, select one of the following options: 

https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui/main.do
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o Typical — Installs all components (recommended). 

o Custom —Allows you view the installation options so you can choose the components you want to install.  

 

 In the Select Destination Folder window, specify the location where you want to install the server. 
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 In the Database Server Type window, from the Server Type dropdown list, select the database type installed 

on the server computer. 

 

 In the Database Server Logon window, specify the following database server connection settings: 

o Server Name — Enter the name or IP address of the server.  

 Caution 

To specify a local machine, enter localhost. Do not enter local. 

 Caution 

Ensure that the name of the server on which you installed Microsoft SQL Server does not contain any 

special characters, such as: &, <, >, ”, or ’. 

o Database User ID — Enter the user ID for the Microsoft SQL server. 

o Database Password — Enter the password for the Microsoft SQL server. 

 Note  

If you use the SAP Business One installer to perform a silent installation of Microsoft SQL Server, then the 

default user ID and password are: sa and SAPB1Admin (case sensitive). 

 Recommendation  

After installing SAP Business One, change the default password or create a new database administrator. 

For more information, see Changing the sa Logon Password and Creating an Alternative User. 

If you selected the Typical installation option in step 5, proceed to step 10. 
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 In the Select Features window, select the features you want to install from the following: 

 Note  

The features you select here depend on your system environment. Therefore, some features may not be 

available to you. 

o System Databases — Installs the SAP Business One common database (SBO-COMMON). This database 

is visible only at the Microsoft SQL Server level, and does not appear in the list of companies in the SAP 

Business One application. When you install a new patch or perform an upgrade to SAP Business One, the 

installer upgrades the common database. The default values in the common database are available for 

every new database that you create. 

o Demo Databases — Installs demonstration databases in the selected localizations. 

o Help — Installs help files in the selected languages. 

o Server Components — Installs shared network objects. 

o SAP Add-ons — Registers the SAP add-ons on the server. 

 Note  

If you want to install SAP add-ons, you must select the SAP Add-ons checkbox in the Select Features 

window. For information, see Assigning SAP Business One Add-Ons. 

o Remote support platform — Installs remote support platform for SAP Business One on the server. 

 Note  

By default, the remote support platform is preselected to install.  

The installation is performed by the installation wizard of remote support platform for SAP Business One 

at a later stage. For more information, see Administrator’s Guide to Remote Support Platform for SAP 
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Business One.  You can find the guide (RSP_AdministratorGuide.pdf) under ...\Documentation\Remote 

Support Platform\System Setup\ on the SAP Business One product DVD, or search for related 

information on sappartneredge.com. 

 Note  

If the installation of remote support platform for SAP Business One fails, this does not affect the 

successful installation SAP Business One. 

The installation of remote support platform for SAP Business One does not impact SAP Business One 

business processes. There is no technical dependency between SAP Business One and remote support 

platform for SAP Business One. 

 

 In the Review Settings window, do one of the following: 

o To confirm the settings and proceed with the installation, choose the Next button. 

o To change any settings, choose the Back button to return to previous windows. 

 In the Setup Status window, the setup wizard begins copying files, which may take several minutes, 

depending on the number of demonstration databases you selected. 

 In the Setup Complete window, choose the Finish button. 

3.2.1.5 Installing Microsoft Outlook Integration Server 

This setup installs Microsoft Office templates required for the Microsoft Outlook integration server add-on.  

http://sappartneredge.com/
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Procedure 

 In the Server Components window, ensure that the Server Tools (Installed) and the SAP Business One Server 

(Installed) checkboxes are inactive. To continue with the Microsoft Outlook integration add-on server 

installation, select the Microsoft Outlook Integration Server Add-On checkbox, and then choose the Install 

button. 

 

 In the Welcome window, choose the Next button. 

 In the Select Destination Folder window, specify the location where you want to install the Microsoft Outlook 

Integration Server files. 

 In the Review Settings window, review the settings you have made, and then do the following: 

o To perform the installation, choose the Next button. 

o To change the settings, choose the Back button to return to the previous steps. 

The Setup Status window displays the installation program performing the required actions.  

 In the Complete window, choose the Finish button to exit the wizard.  

 In the Server Components installation summary window, choose the Finish button. 

 Performing Client Installations 

You can install the client application on every workstation on which you want to run SAP Business One. 

As part of the client installation, the SAP Business One Client Agent is installed by default. SAP Business One 

Client Agent is a Microsoft Windows service that runs in the background with administrator rights and provides 

the following functionality: 

 Saves the configuration parameters that you provide during client installations, for example, the license 

server address, for future use in possible version updates. 
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 Facilitates silent updates of the SAP Business One client, add-ons, and third-party add-ons. 

Depending on the required configuration, you can decide which optional components to install on each 

workstation. 

The client components include: 

 SAP Business One client application and DI API 

 Mail and fax services — Installs messaging services that enable sending fax and e-mail messages from SAP 

Business One.  

 Software Development Kit — Installs documentation and samples for the SAP Business One SDK. 

 Data Transfer Workbench — Installs a tool for migrating legacy data to SAP Business One. 

 Microsoft Outlook integration add-on standalone version — Installs a version of Outlook integration that lets 

you use this add-on without the SAP Business One client application. 

For more information, see Installing the Microsoft Outlook Integration Component (Standalone Version) and 

Installing the Integration Framework. 

 Note 

Both 32-bit and 64-bit versions are available for all client components except for the SDK. While it is 

possible to install and run both versions on the same machine running a 64-bit operating system, in order 

to reduce complexity and avoid potential problems during future upgrades, we strongly recommend that 

you install only one version of SAP Business One client on the same machine. 

Prerequisites 

 The installation computer complies with all hardware and software requirements. For information on 

hardware and software requirements, search for relevant information on sappartneredge.com. 

 You have installed Microsoft .NET Framework 4.0. During the installation of the SAP Business One Client, the 

system checks whether Microsoft .NET Framework 4.0 is installed. If it is not installed yet, you can install it 

during the client installation process. 

 You have installed Microsoft Visual C++ 2005 SP1 Redistributable Package. If it is not installed yet, you can 

install it during client installation.  

 You have installed Microsoft Excel. 

 You have installed the SAP Crystal Reports, version for the SAP Business One application so as to be able to 

use the SAP Business One data source on the client computer. This data source provides SAP Business One 

tables in a hierarchical tree organized according to the SAP Business One modules. 

For information about installing the Crystal Reports version for SAP Business One, see Installing SAP Crystal 

Reports, version for the SAP Business One Application. 

3.2.2.1 Installing the SAP Business One Client  

 Note 

32-bit and 64-bit versions of the SAP Business One client are available. You must install each version 

separately. You can install and run both versions on the same machine.  

http://sappartneredge.com/
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Procedure 

 Insert the SAP Business One product DVD into the DVD drive. If the DVD does not launch the installation 

program, navigate to the DVD root folder, right-click the Autorun.exe file, and choose Run as administrator. 

Alternatively, you can install the client application from ...\SAP\SAP Business One 

Server\B1_SHR\Clients\setup.exe. 

 Note 

You can install the 64-bit versions of the SAP Business One client and DI API from the Client.x64 and 

B1DIAPI.x64 folders in the B1_SHR folder, respectively. 

 In the installation window, select the Client radio button. 

 Caution 

To continue with the client installation, ensure that the license server is running. For information about 

starting the license server, see Configuring the License Manager. 

 

 In the Client Components window, select the SAP Business One Client checkbox and the optional components 

you want to install. 

Choose the Install button. 
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The installation procedure checks whether you have installed Microsoft .NET Framework 4.0 and Microsoft 

Visual C++ 2005 SP1 Redistributable Package. If these are not installed yet, you can install them by choosing 

Install on the relevant screens. 

 For more information about installing the Crystal Reports software on the client computer, see Installing SAP 

Crystal Reports, version for the SAP Business One Application. 

The SAP Business One data sources and Add-ins menu for Crystal Reports are installed after Crystal Reports 

Viewer or the Crystal Reports version for SAP Business One is installed.  

 In the Welcome window, choose the Next button. 

 In the Customer Information window, specify the user ID and company name. 
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 In the Select Destination Folder window, specify the location where you want to install the client. 

 

 In the Select Program Folder window, ensure the installer displays SAP Business One in both fields.  
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 In the License Server Details window, specify the name and port of the license server. 

 

o To install the client, choose the Next button. 
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o To change the settings, choose the Back button to return to the previous steps. 

 In the Setup Status window, the installation wizard performs the required system actions.  

 In the Complete window, choose the Finish button. 

3.2.2.2 Installing SAP Business One Software Development Kit 

 Note  

It may take a few minutes until the SDK setup wizard appears. 

 

Procedure 

 In the Welcome window, choose the Next button. 

 In the Customer Information window, specify the user ID and company name. 
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 In the Setup Type window, select one of the following options: 

o Typical — Installs all components (recommended). 

o Custom —Allows you view the installation options so you can choose the components you want to install.  
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 In the Select Destination Folder window, specify the location where you want to install the SDK. 

 

 In the Select Components window, select the SDK components you want to install. 
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o To install the SDK, choose the Next button. 

o To change the settings, choose the Back button to return to the previous steps. 

 In the Setup Status window, wait for the system to perform the required actions. 

 In the Complete window, choose the Finish button. 

3.2.2.3 Installing Data Transfer Workbench 

 Note  

It may take a few minutes until the Data Transfer Workbench setup wizard appears. 

 

Procedure 

 In the Welcome window, choose the Next button. 

 In the Select Destination Folder window, specify the location where you want to install Data Transfer 

Workbench. 

 In the Select Program Folder window, specify the program folder you want to install for Data Transfer 

Workbench. 

 In the Review Settings window, review the settings you have made. 

o To install DTW, choose the Next button. 

o To change the settings, choose the Back button to return to the previous steps. 

 In the Complete window, choose the Finish button. 

3.2.2.4 Installing the Microsoft Outlook Integration Add-On 

 Note 

It may take a few minutes for the setup wizard to launch the installation wizard for the Microsoft Outlook 

integration add-on. 
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Procedure 

 In the Welcome window, choose the Next button. 

 In the Select Destination Folder window, specify the location where  you want to install the Microsoft Outlook 

integration add-on.  

 In the Review Settings window, review the settings you have made. 

o To perform the installation, choose the Next button. 

o To change the settings, choose the Back button to return to the previous steps. 

 In the Complete window, choose the Finish button. 

After you have finished installing all the client components, a summary window displays a list of the installed 

components. 

 

3.2.2.5 Installing Interactive Analysis 

If you have installed SAP Business One analytics powered by SAP HANA, you can use Interactive Analysis, which 

enables you to create reports in Microsoft Excel based on deployed semantic layers. 

Prerequisites 

 You have installed SAP Business One analytics 1.2 powered by SAP HANA and initialized your company 

database. 

For more information, see the Administrator's Guide for SAP Business One analytics powered by SAP HANA. 

 You have installed the following on the client workstation: 

o Microsoft Excel 2010 or 2013 
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o Microsoft .Net Framework 4.5.2 

If it is not installed yet, you can install it during the installation process. However, a restart may be 

required. 

o Microsoft Visual Studio 2010 Tools for Office Runtime 

Procedure 

 In the product package, navigate to \Packages\Interactive Analysis and run the setup.exe file. 

The installation wizard for SAP Business One Interactive Analysis is launched. 

 In the welcome window, choose Next. 

 In the Customer Information window, enter your information and choose Next. 

 In the Setup Type window, do either of the following: 

o To use the default settings, select the Complete radio button and choose Next. 

You proceed directly to the Ready to Install the Program window, as described in step 7. 

o To review the default settings and customize some settings, select the Custom radio button and choose 

Next. 

 

 If you selected the Custom radio button, in the Choose Destination Location window, you can choose to set a 

different installation folder. Choose Next to continue. 
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 In the Select Features window, you can review the features to be installed and whether or not there is 

sufficient disk space for installation. Choose Next to continue. 

 

 In the Ready to Install the Program window, choose Install to start the installation process. 
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 In the Setup Status window, wait for the installation to finish. 

 

 In the Installation Wizard Complete window, choose Finish to exit the wizard. 

Post-requisites 

To use Interactive Analysis, you must do the following after the installation: 

 In Microsoft Excel, enable all macros and select to trust access to the VBA project object model. 

For instructions, see the Microsoft online help. 
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 If the user who installs Interactive Analysis (user A) is different from the user who uses Interactive Analysis 

(user B), user B must start Interactive Analysis from the Windows menu for the first time. After having done 

so, user B can start Interactive Analysis directly from within the SAP Business One client or from the Windows 

menu. 

 If you have installed Interactive Analysis to a folder that is not in the %ProgramFiles% directory (default 

installation folder), you must perform some additional steps before using the function. For instructions, see 

Troubleshooting Interactive Analysis Installation. 

 

3.2.2.5.1 Troubleshooting Interactive Analysis Installation 

Prerequisite: 

You have installed Interactive Analysis to a folder that is not in the %ProgramFiles% directory. 

Problem: 

After installing Interactive Analysis, you cannot use Interactive Analysis: the add-in cannot be loaded in Microsoft 

Excel. 

Cause: 

The Interactive Analysis add-in was only partly installed. 

Solution: 

 Make the Interactive Analysis add-in available in Microsoft Excel 

1. In the Windows menu, choose SAP Business One Interactive Analysis. 

2. An error message is displayed and informs of a failed installation. 

Ignore the error message by clicking OK. 

 

 In Microsoft Excel, activate the Interactive Analysis COM add-in. 

For instructions on how to manage add-ins, see the Microsoft online help. 

 In the Windows menu, choose SAP Business One Interactive Analysis again. 

This time the installation is successful. 

You can now launch Interactive Analysis from within the SAP Business One client or from the Windows menu. 
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3.3 Installing SAP Business One in Standalone Mode 

In this scenario, you can install the SAP Business One server and client on one machine, as shown in the following 

figure. 

 

Standalone Mode 

 Performing Single Machine Installations 

To install the SAP Business One server and client components on one computer, do the following: 

 Perform the installation of the server tools and server components as described in Installing SAP Business 

One in Server–Client Mode. 

 Perform the installation of the client application and components as described in Installing SAP Business One 

in Server–Client Mode.  

 Perform the installation of integration framework of SAP Business One as described in Installing the 

Integration Framework. 

3.4 Installing SAP Business One in Remote Mode 

In this scenario, you can perform the SAP Business One server and client installation on a remote machine, as 

shown in the following figure. 
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Microsoft Windows Server Terminal Landscape 

 Performing Remote Server Installations 

The following example describes the setup of Microsoft Windows Server 2003 Terminal Service for the hosted 

environment setup. 

Prerequisite 

 The installation complies with all hardware and software requirements. For information on hardware and 

software requirements, search for relevant information on sappartneredge.com. 

Procedure 

To perform the installation of SAP Business One on a remote machine, do the following: 

 Install Microsoft Windows Server Terminal Services: 

1. On the server, in Windows, choose Start → Control Panel → Add/Remove Programs. 

2. In the Add/Remove Programs window, to run the windows components wizard, choose Add/Remove 

Windows Components. 

3. In the list of optional components, select Terminal Services and Terminal Services Licensing. 

4. To install terminal service components, choose the Next button. 

The wizard verifies whether you want to install the terminal services in Remote Administration mode or in 

Application Server mode. 

file:///C:/Users/i071138/Documents/Assignments/Admin%20Guides/Admin_Guide/9.1/Admin%20Guide/sappartneredge.com
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 Recommendation  

Select Application Server mode as it supports an unlimited number of connections. In addition, you 

should keep the default installation values. 

5. In Application Server mode, install the software in Windows by choosing Start → Control Panel → 

Add/Remove Programs  Add New Programs. 

6. The setup wizard prompts you to insert Microsoft Windows Server 2003 installation media. 

After copying files, the wizard informs you that the terminal services have been installed and that you 

need to reboot the server. 

 Install the following in sequence, as described in the section Installing SAP Business One in Server–Client 

Mode. 

1. SAP Business One server tools 

2. SAP Business One server components  

3. SAP Business One client 

4. The integration framework of SAP Business One 

 Change the sa logon password and create an alternative user. 

For security reasons, you should change the sa logon password right after installing SAP Business One, or 

create a user to substitute for the sa user, which is the safest option. For more information, see Database 

Authentication. 

 Performing Client Installations  

You can create the client setup disks from the Terminal Server-Client menu on the terminal server. 

Procedure 

To install the terminal services client, do the following: 

 Run the setup program on your workstation. 

 In Windows, choose Start  All Programs  Terminal Server Client and select Client Connection Wizard. 

 When the wizard appears, specify the name of the terminal server and a description for the connection. 

 Note 

If you experience problems entering an actual server name in the Server Name field, specify the server IP 

address. 

 Recommendation 

If you manage multiple servers on one workstation, specifying the server name in the Description field 

makes it easy to identify each connection. 
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3.5 Installing the Microsoft Outlook Integration Component 
(Standalone Version) 

The Microsoft Outlook integration component enables you to exchange and share data between SAP Business 

One and Microsoft Outlook. This component is a standalone version that does not require the SAP Business One 

client to be installed on the same computer. 

If you want to use the Outlook integration features on the machine on which you have installed the SAP Business 

One client you do not need to install the Microsoft Outlook integration component. Instead, you can choose to 

install the Outlook integration add-on. For more information, see Assigning SAP Business One Add-Ons. 

 Note 

Both 32-bit and 64-bit versions of the Microsoft Outlook integration component are available. You can 

install and run both versions on the same machine, but you must install each version separately. 

Prerequisites 

 You have installed the SAP Business One DI API with the same system type as that of the Outlook integration 

component. For example, install the 32-bit Outlook integration component for the 32-bit Microsoft Outlook. 

 You have installed Microsoft Outlook with the same operating system type as that of the Outlook integration 

component. For example, install the 32-bit Outlook integration component for the 32-bit Microsoft Outlook. 

 You have assigned the following to the SAP Business One user account which is used for the connection: 

o The Microsoft Outlook integration add-on in the SAP Business One client 

o The SAP AddOns license 

 You have started the Microsoft Outlook integration add-on in the company at least once. This ensures the 

necessary user-defined tables are added to the company database. 

Procedure 

 Insert the SAP Business One product DVD in the DVD drive. 

The installation program appears automatically. If the DVD does not launch the installation program, navigate 

to the DVD root folder, right-click the Autorun.exe file, and choose Run as administrator. 

 In the installation window, select the Integration Component radio button and choose the Next button. 

 In the Integration Component window, select the Outlook Integration Standalone Version checkbox and 

choose the Install button. 

 In the welcome window, choose the Next button. 

 In the Select Destination Folder window, specify the folder in which you want to install the Microsoft Outlook 

integration component and choose the Next button. 

 In the Review Settings window, review your settings and proceed as follows: 

o To continue, choose the Next button. 

o To change the settings, choose the Back button. 

 In the Setup Status window, wait for the system to perform the required actions. 

 In the Complete window, choose the Finish button. 
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3.6 Installing the Integration Framework  

 Note 

As of PL01, you can optionally run the integration framework message log using a database table for 

indexed access. The installation creates the MSGLOG table in the IFSERV database.  To access the 

database table, the installation creates the IFDBUSR user. The IFDBUSR has the permission to 

select, update, insert, and delete records in the MSGLOG database table. The installation creates the 

initial yyyyMMMdd password. yyyy is the current year, MMM, the current month (Jan, Feb, Mar, Apr, 

May, Jun, Jul, Aug, Sep, Oct, Nov, Dec), and dd the current day of the month. 

We recommend changing the password after installation. To change the password, in the integration 

framework choose SLD and open the B1i Server entry. In the Connectivity List (Active) section, 

change the value of the password field. 

The integration framework of SAP Business One includes the following components: 

 Integration Framework Server 

 SAP Business One EventSender 

 SAP Business One DI-Proxy 

 [Optional] Integration packages: 

o Mobile Solution 

For more information about mobile scenarios, search for the user guide for the SAP Business Mobile app 

on sappartneredge.com. Note that there are different user guides for the iOS and the Android versions. 

o DATEV HR (Germany only) 

For more information about DATEV HR, see Leitfaden zur Personalabrechnung mit DATEV HR (German 

only) in the …\Documentation\B1 Integration Component folder of the product DVD. 

o Electronic Invoices (Mexico only) 

For more information, see SAP Note 1580236. 

o Support for Document Approval (Portuguese only) 

For more information, see SAP Note 1886319. 

o Support for SAP Customer Checkout 

For more information, see the Integration with SAP Customer Checkout guide. To display the guide in the 

integration framework, choose Scenarios  Control and for sap.CustomerCheckout, choose the Docu 

button. 

Installing the integration framework of SAP Business One is not mandatory, except if you want to use SAP 

Business One with the integration packages, for example, to use the Mobile solution.  

3.6.1.1 Enabling the TCP/IP Protocol for Database Servers 

If you are using the Microsoft SQL Server, enable the TCP/IP protocol. By default, it is disabled. 

https://sappartneredge.com/
https://service.sap.com/sap/support/notes/1580236
https://service.sap.com/sap/support/notes/1886319
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Procedure 

Enable the TCP/IP protocol in the Microsoft SQL Server: 

 In Windows, choose Start  All Programs  Microsoft SQL Server  Configuration Tools  SQL Server 

Configuration Manager. 

 In the SQL Server Configuration Manager window, expand SQL Server Network Configuration, and then 

choose Protocols for MSSQLSERVER.  

 Right-click TCP/IP, and then choose Enable. 

 Go to SQL Server Services, right-click SQL Server (MSSQLSERVER), and then choose Restart. 

MSSQLSERVER is the default instance of MSSQL. Note that named instances have different names.  

Set the IP port in Microsoft SQL Server: 

 In Windows, choose Start  All Programs  Microsoft SQL Server  Configuration Tools  SQL Server 

Configuration Manager. 

 In the SQL Server Configuration Manager window, expand SQL Server Network Configuration, and then 

choose Protocols for <instance_name>.  

 To open TCP/IP Properties, double-click TCP/IP, or right-click TCP/IP, and then select Properties. 

 On the IP Addresses tab, in the IPALL area, leave the TCP Dynamics Ports field blank and enter, for example, 

1442, in the TCP Port field. 

 Note 

If you are using SQL Server named instances, ensure that each instance uses a different TCP/IP port and 

during the installation of the integration framework, enter the server name as <server name> rather 

than the <server name>\instance name. 

3.6.1.2 Performing Installations 

Prerequisites 

 The installation complies with all hardware and software requirements for SAP Business One and the 

integration framework. For more information, search for the relevant information on sappartneredge.com.  

 You have installed the corresponding version of SAP Business One DI API. Depending on your system type 

this is either the 32-bit or 64-bit version. The integration framework supports both versions.  

 You have not yet configured a default Tomcat installation on your machine; otherwise, you cannot proceed 

with the installation. During the installation process, the setup checks for the following registry entries, and if 

they are found, the setup terminates: 

o 32-bit systems 

HKEY_LOCAL_MACHINE\SOFTWARE\Apache Software Foundation\Procrun 2.0\Tomcat6 

o 64-bit systems 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software 

Foundation\Procrun2.0\Tomcat6 

 To use dashboards, you have installed Adobe Flash Player 10.0 or later on the client workstations.  

http://sappartneredge.com/
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Procedure 

 Insert the SAP Business One product DVD in the DVD drive.  

The installation program appears automatically. If the DVD does not launch the installation program, navigate 

to the DVD root folder and double-click the Autorun.exe file. If you are using Windows 7 or Windows Server 

2008, right-click the setup.exe file and choose Run as administrator. 

 In the installation window, select the Integration Component radio button and choose the Next button. 

 In the Integration Component window, select the Integration Solution Components checkbox and choose the 

Install button. 

 In the InstallShield wizard introduction window, read the instructions and choose the Next button. 

 In the Choose Installation Folder window, specify the folder where you want to install the integration 

framework and choose the Next button. 

 In the Choose Installation Components window, choose the typical installation option.  

To run the integration framework together with SAP Business One, you need all components. 

 In the Change Admin Password window, enter and confirm a new password for the integration server 

administrator account (B1iadmin).  

The new password must contain at least eight characters. 

 In the Enter Database Information window, specify the following data, and then choose the Next button: 

o The On Premise option is selected. Do not change it. 

o Database Type – From the dropdown list, select Microsoft SQL Server version. 

o Database Server – Enter the name of the database server. To specify a Microsoft SQL Server 

instance, enter <host name\<instance name> and leave the Database Port field empty.  

o Database Port – Enter the port number. The default port is 1433. Named Microsoft SQL Server 

instances support both static and dynamic ports. 

o Database Name – Enter the name of the integration framework database. The default database name 

is IFSERV. 

o Database User Name – Enter the user name of a database administrator account.  

o Database Password – Enter the password for the database administrator account.  

Setup checks the database connection and displays the following additional fields: 

o B1i User Name – Enter the user name of an SAP Business One account to use with the integration 

framework. The default account is the B1i account, which is the technical user that is reserved for use 

with SAP Business One integration solutions.  

 Recommendation 

Use the default B1i account, otherwise extra configuration effort is required. 

o B1i Password – Enter the password for the SAP Business One account to use with the integration 

framework. 

 Note 

A B1i account is created for every new company database, but you must ensure that the password 

of this user is properly initialized. To do this, you must set the password in SAP Business One, if you 

have not done so already. 
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o B1DI API – Click the checkbox of the DI API version you want to use for the integration framework. The 

program enables checkboxes for the versions installed on your machine. If both versions have been 

installed, we recommend using the 64-bit version. 

o B1DI JCO Path – The program displays the location of the SAP Business One DI API program file. 

 After you have set the company database information, do the following: 

o By default, the On Premise option is selected. Do not change it.  

o To activate support for the SAP Business One mobile solution, select the Activate support for SAP 

Business One Mobile solution checkbox. 

o To activate payroll support (DATEV/HR package, Germany only), select the Activate payroll support 

(Germany only) checkbox, and then set the destination folder for incoming files and outgoing files. 

o To activate support for electronic invoices (Mexico only), select the Activate support for electronic 

invoices (Mexico only) checkbox. 

o To activate support for document approval (Portuguese only), select the Activate support for Document 

Approval (Portuguese only) checkbox. 

o To activate support for SAP Customer Checkout, select the Activate Support for SAP Customer Checkout 

checkbox.  

o To activate integration with SAP Anywhere, select the Activate Support for SAP Anywhere checkbox. 

The integration requires a database. Enter another name or use the default name. 

 The Pre-Installation Summary window displays an overview of the installation settings. 

o To perform the installation, choose the Next button. 

o To change the settings, choose the Back button to return to the previous steps. 

 In the Installation Complete window, choose the Done button. 

Result 

You can display installation log files in the …\_SAP Business One Integration Installation\Log folder. 

 Note 

If any issues or errors arose during installation, you can start the setup again; however, this causes the 

setup to run in repair mode. Repair mode repairs the components, but leaves the packages, system 

settings and the B1iadmin user password unchanged. 

After the installation process is complete, the application automatically starts the following services: 

 SAP Business One Integration Service 

 SAP Business One EventSender Service 

 SAP Business One DI Proxy Service 

 SAP Business One DI Proxy Service Monitor 

 



 

60 

CUSTOMER  

©  2016 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Installing SAP Crystal Reports, version for the SAP Business One Application 

 

4 Installing SAP Crystal Reports, version for 
the SAP Business One Application 

SAP Crystal Reports, version for the SAP Business One application provides integration with the SAP Crystal 

Reports software, which allows you to create, view, and manage reports and layouts.  

SAP Business One 9.1 supports the following versions of SAP Crystal Reports, version for the SAP Business One 

application: 

 2011 

 2013 

The 2013 version is the recommended version, which contains more advanced features and is compatible with 

more advanced platforms, for example, Microsoft Windows Server 2012 and Microsoft Windows 8. If you already 

have SAP Crystal Reports 2011 or 2013 installed on your computer, first uninstall the software and then perform 

the installation operations below. 

 Note 

The operating system of the computer on which you want to install SAP Crystal Reports for SAP Business 

One must be Windows 7 SP1 or higher. 

To use SAP Crystal Reports, version for the SAP Business One application, perform the following operations: 

1. Install SAP Crystal Reports 2013, version for the SAP Business One application 

2. Run the SAP Crystal Reports integration script 

This step ensures that SAP Business One data sources are available in the application. 

For more information about working with SAP Crystal Reports, version for the SAP Business One application, see 

How to Work with SAP Crystal Reports in SAP Business One in the documentation area of SAP Business One 

Customer Portal at http://service.sap.com/smb/sbocustomer/documentation. 

4.1 Installing SAP Crystal Reports, version for the SAP Business 
One application 

 Note 

If you have SAP Crystal Reports 2011 or 2013 installed on the computer where you want to install SAP 

Crystal Reports, version for the SAP Business One application, you are prompted to uninstall it during the 

installation procedure. 

Prerequisite 

 

http://service.sap.com/smb/sbocustomer/documentation
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You have downloaded the installation package of SAP Crystal Reports 2011 or 2013, version for the SAP Business 

One application from the SAP Business One Software Download Center on SAP Support Portal at 

https://support.sap.com/b1software. 

Procedure 

 In the installation package, double-click the setup.exe file. If you are using Windows 7, Windows Server 

2008, or Windows 8, right-click the setup.exe file and choose Run as administrator. 

 In the SAP Crystal Reports for SAP Business One setup window, select a setup language and choose the OK 

button. 

 The Prerequisites check window appears. If you have fulfilled all critical prerequisites, you can continue with 

the installation; otherwise, follow the instructions in the wizard to resolve any issues before proceeding. 

 In the welcome window, choose the Next button. 

 In the License Agreement window, read the software license agreement, select the radio button I accept the 

License Agreement, and then choose the Next button. 

 In the Specify the Destination Folder window, specify a folder where you want to install the software. 

 In the Choose Language Packs window, select the checkboxes of the languages you want to install and choose 

the Next button. 

 In the Choose Install Type window, select one of the following installation types and choose the Next button: 

o Typical 

Installs all application features. For a typical installation, proceed to step 9. 

o Custom 

Allows you to do the following: 

o Select features that you want to install. 

 Note 

If you have installed SAP Crystal Reports, version for the SAP Business One application, you can select 

the Custom install type to add or remove features. 

o Select whether or not you want to receive the web update service 

o Check the disk cost of the installation 

 

 

 

 

 

 

 

 

 

 

https://support.sap.com/b1software
https://support.sap.com/b1software
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 Note 

If you have done one of the following, the Browse button is inactive because a destination folder already 

exists: 

o You have already installed SAP Business One; that is, before installing SAP Crystal Reports, version 

for the SAP Business One application. 

o You have already installed the SAP Crystal Reports viewer. For example, this may be installed 

automatically when you install the SAP Business One client application. 

 In the Select Features window, select the features you would like to install and choose the Next button. 

The icons in the feature tree indicate whether the feature and its sub-features will be installed, as follows: 

o A white icon means that the feature and all its sub-features will be installed. 

o A shaded icon means that the feature and some of its sub-features will be installed. 

o A yellow 1 means that the feature will be installed when required (installed on demand). 

o A red X means that the feature or sub-feature is either unavailable or will not be installed. 

SAP Crystal Reports, version for the SAP Business One application uses an "install on-demand" technology 

for some of its features. As a result, the first time a particular feature is used after being installed, there may 

be an extra wait for the "install on-demand" to complete. This behavior will affect new installations only once 

and will not occur when features are restarted. 

To check how much disk space is required for the installation of selected features, choose the Disk Cost 

button. 

 In the Web Update Service Option window, you can disable the web update service by selecting the Disable 

Web Update Service checkbox. We recommend, however, that you enable the update service to stay aware of 

updates that can help you enhance your SAP Crystal Reports. 

Choose the Next button to proceed. 

 In the Start Installation window, choose the Next button. 

The Crystal Reports for SAP Business One Setup window appears. 
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 When the installation is complete, the Success window appears. To exit the installation wizard, choose the 

Finish button. 

 

4.2 Running the Integration Package Script 

To make the SAP Business One data sources and the Add-ins menu available in the SAP Crystal Reports designer, 

run the SAP Business One Crystal Reports integration script. The SAP Business One tables are organized 

according to the modules in the SAP Business One Main Menu. 

Procedure 

 In the SAP Business One product or upgrade package, locate the …Packages\SAP CRAddin 

Installation folder and double-click the SAP Business One Crystal Report Integration 

Package.exe file. If you are using Windows 7 or Windows Server 2008, right-click the setup.exe file and 

choose Run as administrator. 

 The integration package has been installed successfully. To exit the wizard, choose the Finish button. 

4.3 Updates and Patches for SAP Crystal Reports, version for 
the SAP Business One application 

 Caution 

Since you are using SAP Business One 9.0 together with an Original Equipment Manufacturer (OEM) 

version of SAP Crystal Reports, do not apply standard SAP Crystal Reports file or product updates 

(including Hot Fixes and Service Packs) as they are not designed to work with OEM versions of SAP 

Crystal Reports. 

File or product updates are provided in the following ways: 

 Integrated runtime version: distributed together with SAP Business One 

 Designer: provided separately via a dedicated folder location in the SAP Business One Software Download 

Center on SAP Support Portal at https://support.sap.com/b1software. 

 Note 

If you are using both the integrated runtime version and the designer, make sure that they are either on 

the same patch or Service Pack level or that the Report Designer is on an earlier patch or Service Pack 

level than the Runtime version. If not, inconsistencies may occur. 

To find out if you are using an OEM version of SAP Crystal Reports, start the designer and look for either of these 

two indicators: 

 The title bar of the designer indicates SAP Crystal Reports for a certain product (such as SAP Crystal Reports 

for SAP Business One). 

https://support.sap.com/b1software
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 In the Help menu, choose About (for example, About Crystal Reports). The technical support phone number in 

the About Crystal Reports box is not listed as (604) 669 8379. 

If either of these indicators exists in your product, you are using an OEM version of SAP Crystal Reports. 



 

 SAP Business One Administrator's Guide 

Uninstalling SAP Business One 

 CUSTOMER  

 ©  2016 SAP SE or an SAP affiliate company. All rights reserved. 65 

 

5 Uninstalling SAP Business One  

When you uninstall SAP Business One, you remove the application and all its components. 

 Note  

You must uninstall all SAP Business One add-ons before uninstalling the SAP Business One server and 

client components. 

 Note 

To only upgrade the integration framework, run the setup.exe file under \Packages\B1 Integration 

Component\Technology\ in the product package. 

Procedure 

 Uninstall SAP Business One add-ons:  

1. From the SAP Business One Main Menu, choose Administration → Add-Ons → Add-On Administration. 

The Add-On Administration window appears. 

2. On the Company Preferences tab, under Company Assigned Add-Ons, select the add-ons you want to 

remove. 

3. Choose the arrow button between the two panels. This removes the add-ons from the list. 

4. In the Available Add-Ons list, select the add-ons you want to remove. 

5. Choose the Remove Add-On button, and then choose the Update button. 

SAP Business One automatically removes the add-ons that you have uninstalled the next time you start the 

SAP Business One application from any workstation that is connected to the server. 

 Note  

You can move XL Reporter to the Available Add-Ons panel but you cannot remove XL Reporter in the Add-

On Administration window. The Remove Add-On button is disabled for XL Reporter. 

 Uninstall the server and client components: 

1. In Windows, choose Start → Control Panel → Programs and Features. 

2. In the Programs and Features window, select the following items one at a time, and choose the 

Uninstall/Change button after each selection: 

o SAP Business One Server Tools 

o SAP Business One Client 

o SAP Business One Server  

o Data Transfer Workbench 

o SAP Business One SDK 

 Remove DI API: 

o If you installed DI API as part of the SAP Business One client installation, the system removes the DI API 

when you uninstall the SAP Business One client. 
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o If you installed DI API using the manual setup program in the …\B1_SHR\B1DIAPI folder, you must 

remove it by selecting SAP Business One DI API in the Programs and Features window, and then choosing 

the Uninstall/Change button. 

Result 

SAP Business One entries no longer appear in the Programs menu and any shortcuts that you may have on the 

Microsoft Windows desktop are removed. 

You can now do the following: 

 Manually delete the SAP Business One folders in Microsoft Windows Explorer. 

 Remove SAP Business One databases using your database management application. 

5.1 Uninstalling SAP Business One Client Agent 

To uninstall SAP Business One Client Agent, in the Programs and Features window, select SAP Business One 

Client Agent and choose the Uninstall/Change button. 

5.2 Uninstalling the Integration Framework of SAP Business One 

To uninstall the integration framework, use the Change SAP Business One Integration program. With this program 

you can add or remove features, repair the installation or uninstall the integration framework. 

Prerequisites 

 To disable further event creation for the company databases in SAP Business One, run the event sender setup 

and in step 4, deselect the company databases.  

 You have administrative rights on the PC where you uninstall the integration framework. 

 You have made a backup of the database of the integration framework. 

 You have made a backup of the B1iXcellerator folder. 

To find the folder select IntegrationServer  Tomcat  webapps  B1iXcellerator. 

Procedure 

 Choose Start  All programs  Integration solution for SAP Business One  Change SAP Business One 

Integration. 

The SAP Business One Integration Wizard Introduction window opens. 

 In the Maintenance Mode window select Uninstall Product and choose Next. 

The system notifies you that it uninstalls the integration framework. 
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 Choose Uninstall. 

The system uninstalls your installation. 

 To finish the procedure, choose the Done button. 

Result 

The program uninstalls the integration framework, but it does not remove the database. Remove it separately. 
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6 Upgrading SAP Business One 

To upgrade your SAP Business One application to version 9.1 and run it successfully, you must do the following: 

 Upgrade your SAP Business One successfully to 9.1 

 Update the system information in the system data maintenance area: 

o Partners: On the SAP Business One Support area on sappartneredge.com, in the Quick Links area, choose 

System Data Maintenance. 

o Customers: On the SAP Business One Customer Portal at http://service.sap.com/smb/sbocustomer, in 

the left-hand navigation bar, choose System Data Maintenance. 

 Import the 9.1 license file 

For the latest information about upgrade issues that may not appear in this guide, see SAP Note 2004987. 

If you are using the intercompany integration solution for SAP Business One, make sure the intercompany version 

is compatible with this SAP Business One patch level as specified in SAP note 1844555. You may need to upgrade 

the intercompany version as well. 

 Note 

If your SAP Business One is of a hotfix version, we strongly recommend that you upgrade to the next 

regular patch once it is available, as hotfixes are intended only as temporary solutions. 

To upgrade to a new minor or major release, you must upgrade to a regular patch first, and then you can 

proceed with the upgrade to the new release. 

6.1 Upgrade Methods 

You can use either of the following upgrade methods to upgrade a previous SAP Business One version: 

 Using the SAP Business One upgrade wizard 

You can use the upgrade wizard to guide you through the process of upgrading SAP Business One to a higher 

major version, a higher minor version, a support package, or a new patch above the SAP Business One 9.1 

release.  

 If any of the upgrade steps fail, you can use the restoration mechanism to reverse all the database changes 

made to your SAP Business One landscape by the wizard, and return to the SAP Business One version before 

the upgrade. 

 Caution  

To detect any errors or warnings that may arise in the SAP Business One upgrade process, it is 

mandatory that you perform a trial run of the SAP Business One upgrade wizard up to and including step 

12 as described in the procedure below. The results of the pre-upgrade tests in the upgrade wizard 

indicate where you may need to correct any errors before performing the actual upgrade. If no issues are 

found, you may continue with the upgrade procedure. 

 Silent upgrade 

 You can upgrade SAP Business One in a silent mode using command line arguments. 

https://sappartneredge.com/
http://service.sap.com/smb/sbocustomer
https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303331343639303030303033373633363230313426
https://service.sap.com/sap/support/notes/1844555
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 Directly from the upgrade package folders 

You can use the upgrade files in the upgrade package to upgrade the individual SAP Business One 

components, although this method is not recommended and only for advanced users. 

 Caution  

If you want to upgrade the SAP Business One server or company database, you can run the upgrade 

wizard ONLY on the SAP Business One server. 

 Caution  

The upgrade files listed in the upgrade package do not constitute a complete set of the required upgrade 

files. They are provided for advanced users only.  

For more information, see the Administrator’s Guide of previous versions in SAP Business One Customer 

Portal at http://service.sap.com/smb/sbocustomer/documentation. 

 Note  

When you upgrade SAP Business One, your previous SBO Mailer e-mail signature settings are 

automatically copied to the common database and appear on the Common E-Mail Signature tab of the E-

Mail Settings window. 

To access these settings, from the SAP Business One Main Menu, choose Administration → System 

Initialization → E-Mail Settings. 

6.2 Supported Releases 

The following major or minor releases are currently supported for upgrade to 9.1: 

 SAP Business One 8.8 

 SAP Business One 8.81 

 SAP Business One 8.82 

 SAP Business One 9.0 

For more information about upgrading from specific patches of supported releases, see the Patch Readme for the 

respective SAP Business One patch. 

 Note 

To upgrade an SAP Business One version that is lower than 8.8 to 9.1, first upgrade your current version 

to 8.82, and then perform the upgrade to 9.1. 

Prerequisites 

 You have downloaded the upgrade package from the SAP Support Portal. For more information, see 

Downloading the Upgrade Package. 

 You have ensured that company databases are not connected to any SAP Business One clients, SQL Server 

clients, or other applications.  

http://service.sap.com/smb/sbocustomer/documentation
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 You have the SAP Business One 9.1 license file available. You need this license file for connecting your 

company after the upgrade process is finished. If you do not import a valid license file after the upgrade 

process, you cannot work with your company. 

 You have administrator rights on the computer that runs the SAP Business One upgrade wizard.  

 You have added the System Landscape Directory server to the list of proxy exceptions on the computer on 

which you want to run the upgrade wizard. 

 The SBO-COMMON database that you have installed on your computer is not a later release than the upgrade 

package. 

 If any components of SAP Business One integration for SAP NetWeaver (B1iSN) were previously installed on 

your server, you have uninstalled them manually before installing any integration solutions delivered with SAP 

Business One. This step is required due to compatibility reasons. For more information about uninstalling 

components of B1iSN, see the SAP Business One integration for SAP NetWeaver Installation and Upgrade 

Guide. 

 You have installed the SAP Crystal Reports software. 

 Note  

If you want to install the SAP Crystal Reports software after upgrading the SAP Business One client, you 

may need to run the SAP Crystal Reports integration package script. For more information, see Running 

the Integration Package Script. 

For more installation information about installing the Crystal Reports software, see Installing Crystal Reports 

for SAP Business One, version for the SAP Business One Application. 

 During the upgrade of SAP Business One, you have the option of installing remote support platform for SAP 

Business One. For more information about installing remote support platform for SAP Business One, see 

Administrator’s Guide to Remote Support Platform for SAP Business One. You can find the guide 

(RSP_AdministratorGuide.pdf) under ...\Documentation\Remote Support Platform\System Setup\ 

on the SAP Business One product DVD, or on sappartneredge.com. 

 If the machines on which the SAP Business One client and DI API run use an HTTP proxy for network access, 

you have added the System Landscape Directory server to the list of proxy exceptions. 

6.3 Upgrade Process 

Upgrading SAP Business One consists of several steps. Each of these steps is explained in more detail in the 

following subsections. The configuration parameters you enter during the upgrade process, such as the license 

server address, are saved for subsequent use, for example future upgrades. 

To perform a correct and complete upgrade of SAP Business One, do the following: 

  Run the SAP Business One upgrade wizard to perform the following operations: 

1. Validate the license server 

2. Select components for upgrade 

 Recommendation  

Upgrade all the server components at one time, and not separately. Otherwise you may have problems 

fixing certain errors in the pre-upgrade test. 

3. Select a database for upgrade 

file:///C:/Users/i071138/Documents/Assignments/Admin%20Guides/Admin_Guide/9.1/Admin%20Guide/sappartneredge.com
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4. Perform pre-upgrade tests 

5. Specify a backup location (only occurs when database components are selected for upgrade) 

6. Run the upgrade process: 

1. Upgrade the System Landscape Directory and license service.  

2. Upgrade the common database and B1_SHR 

3. Upgrade chosen company databases 

4. Upgrade chosen server software components 

7. Restore (only occurs when upgrade fails) 

 Upgrade SAP Business One client workstations, which includes the following tasks: 

1. Upgrading the SAP Business One client 

2. Upgrading SAP Business One add-ons 

 Downloading the Upgrade Package 

Download the SAP Business One upgrade package from the SAP Support Portal, as follows: 

 Go to the SAP Business One Software Download Center on the SAP Support Portal at 

https://support.sap.com/b1software. 

 To download an upgrade, click Updates. 

 Navigate to and select the relevant download objects. 

Note: 

The upgrade may be divided into several download objects. In this case, select and download all objects 

under the same patch level designation. 

 Before starting the download, read the Info file for the selected download object. 

 Extract the downloaded file to your computer. 

 Before you start an upgrade, read the section Running the SAP Business One Upgrade Wizard. 

 

If you experience problems when downloading software, send a message to SAP as follows: 

 Go to the SAP Business One support center on sappartneredge.com. 

 In the left navigation panel, click Partner Support Dashboard. 

 Use SAP Message Wizard to write the message and assign it to component SBO-CRO-SUP. 

Note: 

If your download fails due to an unstable internet connection, try using the SAP Download Manager, which 

supports resumable downloads. In the SAP Business One Software Center, first move your objects into 

Download Basket and then download them with the SAP Download Manager. To install the SAP Download 

Manager, click the Get the SAP Download Manager link in the left navigation pane. 

https://support.sap.com/b1software
http://sappartneredge.com/
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 Running the SAP Business One Upgrade Wizard 

The upgrade wizard includes the following setup types: 

 Pre-Upgrade Test Only – The wizard performs a series of version-specific verification checks on selected 

databases to see if they are ready for upgrade. The existing installation and data are not changed. If the tests 

are completed successfully, you can generate passcodes that allow you to bypass the pre-upgrade tests 

during the upgrade process. 

 Pre-upgrade Test and Upgrade – The wizard performs pre-upgrade tests and upgrades the selected 

components and databases. If you previously performed pre-upgrade tests for a database and generated 

passcodes, you can enter the passcodes to bypass the automatic testing for this database. 

6.3.2.1 Performing Pre-Upgrade Tests Only 

Procedure 

To perform pre-upgrade tests only, do the following: 

 In the upgrade root folder, double-click the Upgrade.exe file. 

If you are using Windows Server 2008 or Windows 7, right-click the Upgrade.exe file and choose Run as 

administrator. 

 To start the upgrade, in the Welcome window, select your language, and then choose the Next button. 

 In the Setup Type window, select the Perform Pre-Upgrade Test Only checkbox, and then choose the Next 

button. 
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 In the Pre-Upgrade Test Configuration window, select either of the following options: 

o Clean Start – Select this radio button to manually enter all the required settings. 

o Use Settings from the Last Wizard Run – Select this radio button to use the settings from the last wizard 

run, which are stored in the configuration file generated during that run. 

o Load Settings from File – Select this radio button to use the settings stored in a configuration file 

generated during a previous wizard run, and then specify the location of the file you want to use. 

 Note 

To obtain the required Config.XML file, first run the upgrade wizard and select the Clean Start option. 

After generating this file, you can make a copy and use a text editor to modify the values for future use as 

required. 

 

 In the Database Server Connection window, from the Connection Type dropdown list, select how the wizard 

connects to the database server. The available options are: 

o License Server – The wizard connects to an SAP Business One license server and retrieves a list of 

available database server instances. License server authentication uses the SAP Business One site user 

credentials, and you do not require database server credentials. If you select this option, specify the 

following: 

o License Server Name – Enter the host name of the server. 

o Port – Enter the port number. The default port is 30000. 

o Password – Enter the site user password. 

o Database Server – The wizard connects directly to a specified database server instance, for which you 

require the database administrator account credentials for authentication. If you select this option, 

specify the following: 

o Database Server Type – Select the version of Microsoft SQL Server that you are using. 
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o Server Name – Enter the host name of the server. 

o Use Trusted Connection – Select this checkbox to use Windows Authentication to validate access to 

the Microsoft SQL server instance. 

o User Name – Enter the user name of a database administrator account. 

o Password – Enter the password of the database administrator account. 

 Note  

If you have problems setting the server, ensure that the name format of your computer is the same as the 

name format of your license server.  

 

 In the Database Server Connection window, do either of the following: 

o To use an existing database server instance, select the server type and name from the corresponding 

dropdown lists, and then choose the Next button. 
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o To register a new database server instance, choose the Register New DB at SLD button, and then specify 

the following information in the Database Server Registration window: 

o Database Server Type – Select the version of Microsoft SQL Server that you are using. 

o Server Name – Enter the host name of the server. 

o Use Trusted Connection – Select this checkbox to use Windows Authentication to validate access to 

the Microsoft SQL server instance. 

o User Name – Enter the user name of a database administrator account. 

o Password – Enter the password of the database administrator account. 

 Note  

If you have problems setting the server, ensure that the name format of your computer is the same as the 

name format of your license server.  
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 In the Database Selection window, select the corresponding checkboxes for the databases on the specified 

server for which you want to perform pre-upgrade testing. 
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 The Review Settings window provides an overview of the settings that you have configured for the pre-

upgrade tests. To modify any of the settings, choose the Back button; otherwise choose Next to proceed with 

the pre-upgrade testing. 

 

 The Pre-Upgrade Test window provides an overview of the pre-upgrade testing process. 

o To perform pre-upgrade tests on the selected databases, choose the Start button. 

o To change the settings, choose the Back button to return to the previous steps. 

 The Pre-Upgrade Test Results window provides a detailed overview of the results of the pre-upgrade tests. 

You can view information about individual checks, possible solutions to errors, and recommendations for 

dealing with warnings by clicking the links to the corresponding notes in the SAP Note column. 

 If the wizard detects any warnings. do either of the following: 

o To ignore a warning, select the corresponding checkbox in the Confirmation column. 

o To fix an issue, click the corresponding hyperlink in the SAP Note column and follow the 

recommendations. After fixing the issue, select the checkbox in the Confirmation column. 

After confirming all warnings, choose the Back button to return to the upgrade wizard. 
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 In the Pre-Upgrade Test: Warnings Confirmed window, to generate passcodes that allow you to bypass the 

pre-upgrade tests during the upgrade process, choose the Generate Passcodes button. 

 Note 

The wizard generates individual passcodes for each database, which are valid for three days. After three 

days, or if you make any changes to the company configuration, passcodes become invalid. Passcodes 

are saved in an XML file, which also contains information about the tested databases. 
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 In the Generate Passcodes window, choose the Generate button, and then specify a folder where you want to 

save the XML file containing the passcodes. 

 Recommendation 

Keep a record of the full path to the folder, as you are required to enter this during the upgrade process if 

you want to skip the pre-upgrade tests.  

 In the Test Finished window, do either of the following: 

o To complete the pre-upgrade testing and exit the wizard, choose the Finish button. 

o To upgrade SAP Business One components and databases using the settings you have already entered, 

without having to re-enter passwords, choose the Go to Setup button. 
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 Note 

For more information about the pre-upgrade testing, in the Test Finished window, you can choose the 

following:  

o Test Results Summary – Provides a summary of the pre-upgrade tests. 

o Upgrade Log – Opens a log file that provides a high-level overview of the pre-upgrade test results for 

each component and database. This log file also contains links to detailed technical logs for any 

components or databases for which the testing process failed. 

o Upgrade Folder with Log Files – Opens a folder containing all the log files for the current pre-upgrade 

tests. 

6.3.2.2 Performing Pre-Upgrade Tests and Upgrades 

Procedure 

To perform pre-upgrade tests and upgrade the selected components and databases, do the following: 

 In the upgrade root folder, double-click the Upgrade.exe file. 

If you are using Windows Server 2008 or Windows 7, right-click the Upgrade.exe file and choose Run as 

administrator. 

 To start the upgrade, in the Welcome window, select your language, and then choose the Next button. 

 In the Setup Type window, select the Pre-Upgrade Test and Upgrade checkbox, and then choose the Next 

button. 
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 In the Upgrade Configuration window, select either of the following options: 

o Clean Start – Select this radio button to manually enter all the required settings. 

o Use Settings from the Last Wizard Run – Select this radio button to use the settings from the last wizard 

run, which are stored in the configuration file generated during that run. 

o Load Settings from File – Select this radio button to use the settings stored in a configuration file 

generated during a previous wizard run, and then specify the location of the file you want to use. 

 Note 

To obtain the required Config.XML file, first run the upgrade wizard and select the Clean Start option. 

After generating this file, you can make a copy and use a text editor to modify the values for future use as 

required. 
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 If you select to use the settings from the previous wizard run or a file, the Review Settings window appears. 

This window provides an overview of the settings that you have configured for the upgrade process. To 

modify any of the settings, edit the values in the table. Otherwise, choose Next to proceed with the upgrade. 

 Note 

If you are sure that all the settings are correct, you can select the Skip Remaining Steps and Automatically 

Start Pre-Upgrade Test and Upgrade checkbox to bypass the remaining wizard steps and begin the 

process immediately. 
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 In the Database Server Connection window, enter the name and port of the license server that you want to use 

for authentication, and then enter the site user password. 

If you specify the local machine, for example by entering localhost, and do not already have a license server 

installed locally, the wizard automatically performs a clean install of the license server and System Landscape 

Directory. 

 Caution  

If you are choosing a remote license server, ensure it is the 9.1 release; otherwise, the upgrade cannot 

proceed. 
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 Note 

If the wizard detects a license server, but has problems communicating with that license server, the 

following reasons may be causing the communication problems: 

o License server is not launched 

o License server cannot be connected 

To continue with the wizard, you must fix the connection problems. 

 The license server retrieves a list of available database server instances. In the Database Server Connection 

window, do either of the following: 

o To use an existing database server instance, select the server type and name from the corresponding 

dropdown lists, and then choose the Next button. 
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o To register a new database server instance, choose the Register New DB at SLD button, and then specify 

the following information in the Database Server Registration window: 

o Database Server Type – Select the version of Microsoft SQL Server that you are using. 

o Server Name – Enter the host name of the server. 

o Use Trusted Connection – Select this checkbox to use Windows Authentication to validate access to 

the Microsoft SQL Server instance. 

o User Name – Enter the user name of a database administrator account. 

o Password – Enter the password of the database administrator account. 

 Note  

If you have problems setting the server, ensure that the name format of your computer is the same as the 

name format of your license server.  

 In the Component Selections window, select the corresponding checkboxes of the components that you want 

to upgrade. 

If a component has already been upgraded to the current version or release, its checkbox is enabled and not 

selected. If you select the checkbox of an already upgraded component, the wizard overwrites all instances of 

installed components. 

 Recommendation 

We recommend that you upgrade all the server components at one time, and not separately. Otherwise, 

you may have problems fixing certain errors in the pre-upgrade test. 
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 Note 

To upgrade all SAP add-ons, select the Add-Ons checkbox. Then all the new releases of add-ons, including 

the Microsoft Outlook integration server installer add-on, are automatically registered on the SAP 

Business One server and new installers are uploaded to the server.  

The wizard also lists all third-party add-ons present in the …\Packages\Add-Ons Autoreg or 

…\Packages.x64\Add-Ons Autoreg folders, which you can select to upgrade. 

For more information about upgrading add-ons, see Upgrading SAP Add-ons. 

 Note  

If the common database does not already exist, the wizard automatically creates it. Otherwise, you 

cannot proceed with the upgrade. 

 Note  

The license server must be upgraded first. If your license server has not been upgraded to 9.1, the wizard 

automatically selects the corresponding checkbox.  

 Note  

The upgrade wizard upgrades client components, but it does not upgrade client workstations. For more 

information about upgrading SAP Business One clients, see Upgrading Client Workstations. 

 

 In the Database Selection window, select the checkboxes of the databases that you want to upgrade. 
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 Note  

If you previously selected the Common Database checkbox in the Component Selection window and it is 

not the latest version, the checkbox is selected by default and you cannot deselect it. 

 

The wizard checks the version and the localization of the databases. In each of the following cases, the status 

of the database is Not Ready, and you cannot select the database for upgrade: 

o The wizard does not support the version of the company database. 

o The company database is already of the latest version. 

o The wizard does not find the localization of the company database from the locale list in the common 

database. 

o The wizard finds more than one connection to the database. 

o Superuser is locked or no superuser is provided. 

 To view additional options and information, select the Advanced Settings checkbox, and then specify the 

following: 

o Backup – From the dropdown lists in the Backup column, select whether to backup each database before 

the upgrade. 

 Caution 

If you select not to back up a database before upgrade, you cannot restore the database should the 

upgrade fail. SAP does not provide support for such databases in the case of an upgrade failure; a backup 

of the pre-upgrade database is required to qualify for SAP support.  

o Upgrade By – From the dropdown list, select the SAP Business One user that you want to use to perform 

the upgrade. By default, the wizard uses the manager account. 



 

88 

CUSTOMER  

©  2016 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Upgrading SAP Business One 

 

o Stop on Test Error – Select this checkbox to force the wizard to stop the entire upgrade process if it 

encounters an error during a pre-upgrade test. 

o Stop on Upgrade Error – Select this checkbox to force the wizard to stop the entire upgrade process if it 

encounters an error while upgrading a component. 

 

 If all the selected databases have the status Ready, choose the Next button. 

 Note  

If any of the selected databases has the status Not Ready, the wizard disables the Next button.  

Choose the Not Ready link to see the details. You cannot proceed to the next step until you have fixed the 

problem. 

To proceed with the upgrade while ignoring the Not Ready databases, deselect these databases and 

choose the Next button. 

 In the Upgrade  - Backup Settings window, specify the location where you want to store the backup files 

created before upgrading the selected components. 

o To use the default backup path configured in SQL Server, choose Use the Default SQL Server Backup 

Location. 

o To use another location on the database server, choose Browse directories on database server and click 

the Browse button to choose a directory.  

o To use a network drive, choose Enter a network path and specify the path.  

After you specify a location for the backup, the wizard displays the amount of space required for database 

backups and the available space on the corresponding drives. 
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 If you previously selected the integration solution in the Component Selections window, the Integration 

Solution - B1i Database Connection Settings window appears.  

To enable the wizard to upgrade the integration solution database, enter the database password. 

  

 In the Integration Solution - Scenario Packages window, do the following: 
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o To activate support for the SAP Business One mobile solution, select the Activate support for SAP 

Business One Mobile solution checkbox.  

For more information, see Setting Up the Mobile Scenario in Integration Component in the 

…\Documentation\B1 Integration Component folder of the product DVD. 

o To activate payroll support (DATEV/HR package, Germany only), select the Activate payroll support 

(Germany only) checkbox, and then set the destination folder for incoming files and outgoing files.  

For more information about activating payroll support later, see Leitfaden zur Personalabrechnung mit 

DATEV HR (German only) in the …\Documentation\B1 Integration Component folder of the 

product DVD.  

o To activate support for electronic invoices (Mexico only), select the Activate support for electronic 

invoices (Mexico only) checkbox. 

 

 In the next Integration Solution - Scenario Packages window, to activate integration with SAP Anywhere, 

select the Activate Support for SAP Anywhere checkbox. 

The integration requires a database. Enter another name or use the default name. 
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 If you selected to upgrade the integration framework and no integration framework already exists, the wizard 

displays some additional windows that guide you through the installation process of the integration 

framework, as follows: 

1. In the Integration Solution - Change Administration Password, enter and confirm a new password for the 

integration framework administration account. 
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2. In the Integration Solution - Additional Information window, do either of the following: 

o If you selected to use a Trusted Connection (Windows Authentication) for connections to the 

database server instance, enter both the user name and password of the SAP Business One database 

server administrator account and the user ID and password of the SAP Business One account used 

for DI calls. 

 

o If you did not select to use a Trusted Connection (Windows Authentication) for connections to the 

database server instance, enter only the user ID and password of the SAP Business One account used 

for DI calls. 
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Note 

When using the upgrade wizard of SAP Business One, in addition to the 32-bit version of the SAP 

Business One DI API, the 64-bit version is also available. We recommend using the 64-bit SAP Business 

One DI API. For more information, see SAP Note 2066060. 

 The Review Settings window provides an overview of the settings that you have configured for the pre-

upgrade tests. To modify any of the settings, choose the Back button; otherwise choose Next to proceed with 

the pre-upgrade testing. 

https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303331343639303030303038363632373230313426
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 In the Pre-Upgrade Test window, do the following: 

o To bypass the tests for a database, choose the Enter Passcodes button and upload one or more passcode 

files you saved earlier.  

o Choose the Next button, and then proceed to step 23. 

o To perform pre-upgrade tests on each database to ensure its readiness for the upgrade and to reduce the 

possibility of upgrade failure, choose the Start button. 

 Note  

For the latest information about pre-upgrade tests, see SAP Note 1357462. 

http://service.sap.com/sap/bc/bsp/spn/smb_searchnotes/display2.htm?note_langu=E&note_numm=1357462
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 In the Pre-Upgrade Testing In Progress window, the wizard first checks the common database and then 

checks each of the remaining databases one by one.  

 Note  

If the common database does not pass the checks, the wizard does not continue with the rest of the 

checks. 

 The Pre-Upgrade Test window provides a detailed overview of the results of the pre-upgrade tests. You can 

view information about individual checks, possible solutions to errors, and recommendations for dealing with 

warnings by clicking the links to the corresponding notes in the SAP Note column. 

Depending on the results of the pre-upgrade tests, one of the following windows appears: 

o Pre-Upgrade Test: Passed – All components and databases successfully passed the pre-upgrade tests. 

Proceed to step the next step. 

o Pre-Upgrade Test: Errors Detected – One or more components or databases contain errors. You cannot 

continue upgrading. You must fix the reported errors or contact SAP for support, and then start the 

upgrade wizard again. 

o Pre-Upgrade Test: Warnings Detected – One or more components or databases contain warnings. You 

can still continue upgrading; however, first you must confirm all warnings, as follows: 

1. For each component or database that contains warnings, click the corresponding link in the Details 

column. 

2. The Pre-Upgrade Test Result window appears. 
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3. In the Pre-Upgrade Test Result window, do the following: 

o To ignore a warning, select the corresponding checkbox in the Confirmation column. 

o To fix an issue, click the corresponding hyperlink in the SAP Note column and follow the 

recommendations. After fixing the issue, select the checkbox in the Confirmation column. 

4. After confirming all the warnings, choose the Back button to return to the Pre-Upgrade Test window. 

5. After you have confirmed all warnings for all components and databases, choose the Next button to 

open the Pre-Upgrade Test: Warnings Confirmed window, and then proceed to the next step. 
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 To generate passcodes that allow you to bypass the pre-upgrade tests during the upgrade process, choose 

the Generate Passcodes button. 

 Note 

The wizard generates individual passcodes for each database, which are valid for three days. After three 

days, or if you make any changes to the company configuration, passcodes become invalid. Passcodes 

are saved in an XML file, which also contains information about the tested databases.  

 In the Generating Passcodes window, choose the Generate button, and then specify a folder where you want 

to save the XML file containing the passcodes. 
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After the wizard has finished generating the passcodes, choose the Back button to return to the Pre-Upgrade 

Test window, and then choose Next. 

 The Upgrade Summary window displays an overview of the components and databases that you have 

selected to upgrade. 

o To begin the upgrade process, choose the Upgrade button. 

o To change the settings, choose the Back button to return to the previous steps. 
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The Upgrade in Process window displays the upgrade progress of each component and database. 

 According to the upgrade results, one of the following windows appears: 

o Upgrade Result: Upgraded window — If the upgrades of all components and databases succeed, this 

window appears. To view detailed information about the upgraded components, click the corresponding 

Details link. 

o Upgrade Result: Failed window — If the upgrade of any component or database fails, this window appears. 

o To view detailed information about the components that the wizard failed to upgrade, click the 

corresponding Details link.  

o To continue restoring the failed components and databases, choose the Next button, and then 

proceed to the Restoring Components and Databases section. 

 In the Congratulations window, choose the Finish button close the wizard. 

To view a detailed report about the various steps of the upgrade process, for example, databases, software 

components, and pre-upgrade test results, click the Upgrade Summary link. 

 Restoring Components and Databases 

If the upgrade process fails, the SAP Business One upgrade wizard restores the databases. Software components 

must be restored manually. 

 Note  

The procedure below continues from penultimate step in the previous section, Performing Pre-Upgrade 

Tests and Upgrades. It is relevant for situations only where the upgrade has failed. 
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 Note  

The upgrade wizard can restore only the following components: 

o Common database 

o Company databases (you can select which databases to restore) 

o Add-ons 

The upgrade wizard cannot restore the following components: 

o DI Server 

o System Landscape Directory, license manager, and Extension Manager  

o Data Transfer Workbench 

o DI API 

o Mailer 

o Microsoft Outlook integration server 

o The remote support platform for SAP Business One 

o Software Development Kit help and samples 

o Workflow 

o SAP Business One Studio Suite 

o The integration framework of SAP Business One 

Procedure 

To restore components and databases, do the following: 

 In the Restoration window, select the checkboxes of the components that you want to restore, and then 

choose the Restore button.  
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 Depending on the results of the restoration process, either of the following windows appears: 

o The Restoration Result: Restored window appears if the restoration is successful. To complete the 

restoration, do the following: 

1. In the Restoration Result: Restored window, choose the Next button.  
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2. In the Congratulations window, choose the Finish button to complete the restoration process. 

o If the restoration fails, the Restoration Result: Failed window appears. To complete the restoration, do the 

following: 

1. In the Restoration Result: Failed window, choose the Next button. 

 

2. In the displayed window, choose the Finish button to exit. 

 

 Note  

If the restoration fails, to roll back SAP Business One to the version before the upgrade, you have to do a 

manual restoration.  

 Upgrading Client Workstations 

After running the SAP Business One upgrade wizard, to complete the SAP Business One upgrade, you must 

manually upgrade your SAP Business One client workstations.  

When upgrading to SAP Business One 9.1 for the first time from the 9.0 versions, you cannot directly upgrade the 

SAP Business One client. Instead, do the following: 

1. Uninstall the previous 9.0 client from all workstations. 

For more information, see Uninstalling SAP Business One. 

2. Manually install the SAP Business One 9.1 client on all workstations. 

For more information, see Installing the SAP Business One Client. 
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After installing the SAP Business One 9.1 client, you can perform a client upgrade to later versions from either of 

the following: 

 From the client workstation 

 From the B1_SHR folder 

Prerequisites 

For the first-time upgrade to SAP Business One 9.1, you must have Administrator rights on the computer. For 

subsequent updates to higher patch levels, this is no longer required, because the SAP Business One Client Agent, 

which is installed automatically with SAP Business One, performs upgrades of the client and add-ons. 

 Note  

For the SAP Business One Client Agent to upgrade third-party add-ons in a silent mode, you must 

recreate the add-on’s ARD file using the latest version of the Add-On Registration Data Generator. For 

more information, see Enabling Silent Upgrades for Third-Party Add-Ons. 

 Recommendation 

If you have installed both 32-bit and 64-bit SAP Business One clients on a client workstation, we 

recommend uninstalling one client and keeping only the one of your choice. Otherwise, errors might occur 

during the upgrade. 

6.3.4.1 Upgrading from the Client Workstations 

After you open your SAP Business One client following a server upgrade using the upgrade wizard, you need to 

perform an upgrade of the client. 

Procedure 

 To upgrade the SAP Business One client, in Windows, choose Start → All Programs → SAP Business One → 

SAP Business One. 

 In the logon screen, enter your user ID and password. 

 In the System Message window shown below, do one of the following: 

 

o To start the upgrade of the client workstation, choose the OK button. 
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After several minutes, the following windows appear: 

 

 

o To exit SAP Business One without performing an upgrade, choose the Cancel button. 

 Caution  

If you choose the Cancel button, you cannot log on to your SAP Business One client. 

 Note 

It may take a few minutes to finish the upgrade process. 

 Note  

For more information about installing the SAP Crystal Reports software on the client computer, see 

Installing Crystal Reports, Version for the SAP Business One Application. 

When the upgrade finishes, the upgraded SAP Business One client opens. 

 Note 

If you want to install or upgrade the SAP Business One client manually in silent mode, you can use the 

following command line parameters: 

setup.exe /S /z"c:\Program Files (x86)\SAP\SAP Business One 

Client\*127.0.0.1:30000" 

Where: 

/S means "silent mode“ 
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/z is followed by installation parameters (full installation path*license server address:port) 

6.3.4.2 Upgrading from the B1_SHR Folder 

After performing a server upgrade with the upgrade wizard, you can upgrade each client workstation from the 

B1_SHR folder. This folder is usually located at the following directory path: 

…\SAP\SAP Business One Server\B1_SHR 

Procedure 

To search your computer for the B1_SHR folder: 

 In Windows, choose Start → Run. 

 In the Run window, in the Open field, enter: 

\\<computer name>\B1_SHR 

 Choose the OK button. The B1_SHR folder is displayed. 

 Note  

The client upgrade procedure from the B1_SHR is the same as the client installation procedure. For full 

instructions, see Installing the SAP Business One Client. 

 Upgrading SAP Add-Ons 

When you select the Add-On checkbox in the Component Selections window of the upgrade wizard, the following 

occurs: 

 New releases of all SAP add-ons, including the Microsoft Outlook integration server installer add-on, are 

automatically registered on the SAP Business One server. 

 New installers are uploaded to the server during the upgrade of the SBO-COMMON database. 

Add-ons that were already installed and assigned to a company are reregistered with new releases and assigned 

to the same company. 

On a client computer, upon the next logon to a company assigned with add-ons, installers for the new add-on 

releases run automatically. 

 Upgrading the Online Help 

The SAP Business One upgrade wizard automatically upgrades the online help for SAP Business One when you 

upgrade the common database. 

The next time users access the online help on their client workstation, the SAP Business One client downloads the 

new version from the server. 
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 Troubleshooting Upgrades 

 The root user that runs the upgrade wizard has read, write, and execute permissions to the shared folder 

B1_SHR on the SAP Business One server computer. 

 If you cannot connect to the license server using the server name, use the IP address of the server computer.  

 When you upgrade SAP Business One, your previous SBO Mailer e-mail signature settings are automatically 

copied to the common database and appear in the E-Mail Settings window, on the Common E-Mail Signature 

tab. 

To access these settings, from the SAP Business One Main Menu, choose Administration → System 

Initialization → E-Mail Settings. 

 If you install the SAP Crystal Reports software after upgrading the SAP Business One client, execute the SAP 

Business One Crystal Reports Integration Package.exe file in …\SAP\SAP Business 

One\Crystal. 

 Note  

The folder path shown above may be different on your computer, depending on where you have installed 

SAP Business One and the Crystal Reports software. You can use the Microsoft Windows search facility 

on your computer to locate the folder and the file. 

 To have SBO Mailer’s signature copied after upgrade, do the following: 

1. To open the SAP Business One Service Manager window, in Windows, choose Start → All Programs → SAP 

Business One → Server Tools → Service Manager. 

2. In the SAP Business One Manager window, from the Service dropdown list, select SBO Mailer, and then 

choose the Connection button. 

3. In the Connection Settings window, specify values in the DB Type and DB Server fields, and then choose 

the OK button. 

4. Log off SAP Business One and log on to SAP Business One again. You will find that the signature was 

copied. 

 Troubleshooting Add-On Upgrades 

When upgrading add-ons in an upgraded company for which the server name was previously something like 

(local), you may encounter a message about installation failure. 

SAP Business One has introduced a license security mechanism, and we do not recommend that you specify a 

server name such as (local). In this case, during an upgrade, the user defines the server name as an IP address 

or a computer name. The application does not find the previous, (local), name of the upgraded company, which 

prevents the previous add-ons from being upgraded. 

To solve this problem, do the following: 

 Go to the …\SAP Business One\ folder and locate the AddonsLocalRegistration.sbo file. 

 Change the server name of each related add-on to the new name specified in the license server.  

 Example  

o Old name: <Common ID="1" Name="(local)"/> 

o New name: <Common ID=”1” Name=”MyServerName”/> 
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6.3.8.1 Enabling Silent Upgrades for Third-Party Add-Ons  

To enable the SAP Business One client agent to upgrade a third-party add-on in silent mode, do either of the 

following: 

 If your add-on needs to be installed, you must recreate the add-on’s ARD file using the latest version of the 

Add-On Registration Data Generator to enable silent upgrades (and installations). 

 If your add-on does not need to be installed, you can use the Extension Manager to manage its upgrade. For 

more information, see the guide How to Package and Deploy Lightweight Extensions for SAP Business One on 

sappartneredge.com. 

Procedure 

To enable silent upgrades using the Add-On Registration Data Generator, do the following: 

 To start the Add-On Registration Data Generator, run the AddOnRegDataGen.exe file, which is typically 

located in the...\SAP Business One SDK\Tools\AddOnRegDataGen folder. 

 Load an existing file, or enter the mandatory information.  

 For more information, see the Online Help for the SAP Business One Software Development Kit. 

 Select the Silent Mode checkbox. 

 If necessary, in the Installer/Uninstaller/Upgrade Command Line field, enter any required command line 

arguments. 

 Choose the Generate File button. 

 Note 

You may be required to rebuild the installation package of the add-on and redesign the installation and 

configuration process. For example, if the add-on uses an installation wizard that requires the user to 

specify some information, then you can perform the configuration steps in the SAP Business One client 

after installing the add-on instead. Alternatively, you can provide the required information as command 

line arguments in the ARD file. 

6.4 Performing Silent Upgrades 

You can upgrade SAP Business One using a silent mode by calling …\Wizard\Upgrade.exe from the upgrade 

package. 

 Caution 

You can use the silent mode to upgrade only the server and the integration framework. Silent upgrade of 

implementation tools is not supported. 

To upgrade SAP Business One, provide the following argument:  

Upgrade.exe <Config.XML> <parameter> <value> 

file:///C:/D/Work/Projects/B1H/9.1H/PL00/Documentation/sappartneredge.com
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 Note 

To obtain the required Config.XML file, first run the upgrade wizard in the interactive mode. After 

generating this file, you can make a copy and use a text editor to modify the values for future use as 

required.  

You can find the configuration file in the …\%USERPROFILE%>\Local Settings\Application 

Data\SAP\SAP Business One\UpgradeWizard folder. 

You can provide several different parameters, or multiple parameters, as shown in the following table. 

Type Parameter Value 

Database Server and License 

Server authentication 

-DbPassword Database server password 

-SitePassword  Site user password 

SLD configuration -SLDCertPassword  SLD certificate password 

-SLDDomainPassword SLD domain user password 

B1i configuration -B1iDBPassword  B1i database server password 

-B1iAdminPassword  B1i Tomcat server administrator 

password 

-B1iDIPassword  Company password for DI calls 

 

 Example 

Upgrade.exe "C:\my_config\Config.XML" -DbPassword x1Y3s -SitePassword pO3kAnk3 

6.5 Upgrading Directly from Upgrade Folders 

You can upgrade the individual SAP Business One components manually by running the following files from the 

upgrade folder. For information about the upgrade package, see Downloading the Upgrade Package. 

 Caution 

This option is not recommended and only for advanced users.  

 Server components 

o Server Tools – …\Packages\Server Tools\Setup.exe 

o Common Upgrade –  …\Packages\Upgrader Common\Upgrade.exe 

 Client components 

o Mail and Fax Service –  …\Packages\Server Tools\Setup.exe 

o SDK – Manually uninstall and then upgrade using the SDK InstallShield installer under 

…\Packages\SDK\Setup.exe 

o Data Transfer Workbench – Manually uninstall and then upgrade by using the Data Transfer Workbench 

InstallShield installer under …\Packages\Data Transfer Workbench\Setup.exe 
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o Microsoft Outlook integration add-on – Manually uninstall and then upgrade using the DTW InstallShield 

installer under …\Packages\Outlook Integration standalone\Setup_OIS.exe 
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7 Performing Post-Installation Activities 

Immediately after installing SAP Business One, you are required to perform the following activities: 

 Configuring services  

 Installing the license key 

 Configuring SAP Business One clients 

 Assigning SAP Business One add-ons 

 Installing the Outlook integration standalone version 

 Performing post-installation activities for the integration framework 

 Recommendation 

We also recommend you configure a backup strategy for databases and application folders. For more 

information, see Backing Up Databases. 

You can use the remote support platform for SAP Business One to automatically backup data according 

to a defined strategy. For more information, see the Online Help for the remote support platform. 

7.1 Configuring Services  

You must configure the services you have installed if they are to operate properly. 

 Note  

The first time you configure any service in the service manager, you must enter the site user password. 

This is not for authentication purposes, but to obtain the database password. After entering the site user 

password once, you do not have to enter it again when configuring other services.  

The subsections below introduce how to configure the following SAP Business One services: 

 SBO DI Server 

 License Manager 

 SBO Mailer 

 Fax service 

 SBO DI Server 

This optional service enables multiple clients to access and manipulate the SAP Business One company database. 

To use it, you are required to have a special license. 

For more information, see the SDK Help Center. 
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 Configuring the License Manager 

Configuring the license manager is essential for the successful operation of SAP Business One. This service 

manages license requests and lets you install a license key, which is required to run SAP Business One, according 

to your contract. 

For new installations, you can use the application for a period of 31 days without a license key. After that period, 

the SAP Business One application needs a license key to run. 

We strongly recommend that you request a license key immediately after installing the application. 

Procedure 

 To open the SAP Business One Service Manager window, in the Microsoft Windows task bar, double-click 

(SAP Business One Service Manager).  

Alternatively, in Windows, choose Start → All Programs → SAP Business One → Server Tools → Service 

Manager.  

 From the Service dropdown list, select License Manager and choose the Settings button. 

 

 The General Settings window displays information about the license service.  

Choose the Connect button. 
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 Note  

If you installed the license service on the SAP Business One server, SAP Business One sets localhost by 

default. Otherwise, you must enter a name or IP address of the server. We recommend that do you not 

change the default port number. 

 Caution  

If you have installed a firewall on the machine running the license service, ensure that the firewall does not 

block ports 30000–30010; otherwise, the license service and SLD cannot work. 

If you are using Port X, ensure that you open ports from Port X to Port (X+10) in the firewall. For example, 

if you are using port 10000, ensure to also open ports 10001, 10002, 10003 … 10010. 

 To save your settings and close the General Settings window, choose the OK button.  

If you already have a license key file, you can continue to Installing License Key. 

 Choose    (Play) and select the Start when operating system starts checkbox. 
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 Configuring SBO Mailer 

The process of configuring SBO Mailer comprises of the following steps: 

 Starting SBO Mailer 

 Defining the mail settings 

 Connecting to the database 

 Selecting company databases 

 Setting the mail processing schedules 

Prerequisites 

You have installed the SBO Mailer service. 

For information, see Installing the SAP Business One Server. 

Procedure 

Start SBO Mailer: 

 To open the SAP Business One Service Manager window, in the Microsoft Windows task bar, double-click 

(SAP Business One Service Manager).  

Alternatively, in Windows, choose Start → All Programs → SAP Business One → Server Tools → Service 

Manager.  

 From the Service dropdown list, select SBO Mailer. 
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 Choose      (Play) and select the Start when operating system starts checkbox. 

 Define mail settings: 

1. In the SAP Business One Service Manager window, choose the Settings button. 

The General Settings window appears. 
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2. In the General Settings window, specify the following: 

o SMTP Server — Enter the name or IP address of your outgoing mail server. To make changes in this 

field later, you must stop the Mailer service. 

o SMTP Port — Specify the port number for mail services.  

o Encoding — Select the language for e-mail text. 

o HTML direction right-to-left — Select this checkbox if you are using a right-to-left language to define 

the direction of the e-mail text. 

o Include Subject in Message Body — Select this checkbox to include the subject line in the body of the 

message. 

o Fax Settings — Select the required fax service. For more information, see Configuring Fax Services. 

Scheduled Report Settings - Specify the required information for configuring SBO Mailer for report scheduling and 

mailing. For more information, see Configuring Report Scheduling. 

 Connect to the database: 

1. In the SAP Business One Service Manager window, from the Service dropdown list, select SBO Mailer, and 

then choose the Connection button. 

 

2. In the Connection Settings window, do the following: 

1. To connect to a database, specify a valid user name and password. 

2. To use Windows authentication, select the Use Trusted Connection checkbox. 

3. Choose the OK button. 

 Select a database: 

1. In the SAP Business One Service Manager window, from the Service dropdown list, select SBO Mailer, and 

then choose the Database button.  
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2. In the Select databases to use window, select the databases for which you want to enable mailing services, 

and then choose the OK button. 

 

3. In the SAP Business One Service Manager window, from the Service dropdown list, select SBO Mailer, and 

then choose the Settings button. 
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4. In the General Settings window, in the Mail Settings area, select components according to your network 

definitions, and then choose the OK button. 

 Note  

As of the SAP Business One 2007 A SP01 release, the SAP Business One Service Manager window does 

not provide access to SBO Mailer e-mail signature settings. 

To access these settings, from the SAP Business One Main Menu, choose Administration → System 

Initialization → E-Mail Settings. 

  

 Set the mail processing schedules: 

1. In the SAP Business One Service Manager window, from the Service dropdown list, select SBO Mailer, and 

then choose the Schedule button.  
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2. In the Scheduler – SBO Mailer window, select one of the following options: 

o By Intervals — Sets mail and fax processing to start regularly every x hours and y minutes. 

o On Specific Date — Defines mail and fax processing for a specific date and time. 

o Daily — Sets mail and fax processing for a fixed hour of each day. 

o Weekly — Sets mail and fax processing for a fixed hour on a fixed day of each week. 

o Monthly — Sets mail and fax processing for a fixed hour on a fixed day of each month. 

 Choose the OK button to return to the SAP Business One Service Manager window. 

 

 In the SAP Business One Service Manager window, choose  (Play), and select the Start when operating 

system starts checkbox. 

 To close the SAP Business One Service Manager window, choose the OK button. 

 Configuring Fax Services 

SAP Business One offers fax services through Microsoft Fax Services. For more information, see How To Install 

and Configure Microsoft Fax Services on sappartneredge.com. 

file:///C:/Users/i071138/Documents/Assignments/Admin%20Guides/Admin_Guide/9.1/Admin%20Guide/sappartneredge.com
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This service can send several attachments as separate fax messages, added to a fax message. For supported file 

types, see the Microsoft documentation at www.msdn.microsoft.com. 

 Configuring Report Scheduling 

The report scheduling function of SAP Business One allows you to schedule report execution and send generated 

reports via e-mail. To do so, you must first define the mail settings and scheduled report settings. For more 

information, see How to Schedule Report Execution and Mailing on sappartneredge.com. 

 Troubleshooting 

The following troubleshooting information may be helpful when configuring the mail services: 

 Ensure that you have already set up an e-mail account for the SAP Business One users on your mail server.  

 To verify the connection with the mail server, choose the Test Connection button. 

The mail service checks the connection with the specified mail server and e-mail account and displays an 

appropriate message. 

 If the SMTP server requires authentication, for example, if the SMTP server is configured to accept only 

logon-authenticated mails, you must not select the Anonymous Access option in the Mail Settings area. 

 To check whether the connection to the SMTP server works, send a test e-mail. If the connection fails, ensure 

that you have done the following: 

o Entered the correct name of your mail server 

o Entered the correct user ID and password 

o Restarted the SBO-Mailer service after changing any of the settings 

 SAP Business One Workflow 

The workflow service enables you to standardize your business operations to increase overall efficiency. With 

predefined conditions, the system automatically executes various tasks, liberating labor resources for more 

creative activities. 

For more information, see How to Configure the Workflow Service and Design the Workflow Process Templates at 

http://service.sap.com/smb/sbocustomer/documentation. The guide includes samples and additional reference 

materials. 

7.2 Configuring the SAP Business One Client 

After you have installed SAP Business One and logged on to the application for the first time, you must provide the 

license server address and port number in the License Server Selection window. 

http://www.msdn.microsoft.com/
file:///C:/Users/i071138/Documents/Assignments/Admin%20Guides/Admin_Guide/9.1/Admin%20Guide/sappartneredge.com
http://service.sap.com/smb/sbocustomer/documentation
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To start the SAP Business One client, choose Start  All Programs  SAP Business One  SAP Business One 

Client. To start the SAP Business One Client using the command line, enter the following command: 

“SAP Business One.exe" -DbServerType <Microsoft SQL Server version> -Server <Microsoft 

SQL Server instance name> -CompanyDB <Company Database> -UserName <User ID> -Password 

<Password> -LicenseServer <License Server address:port> 

For the DbServerType parameter, depending on version of Microsoft SQL Server you are using, enter one of the 

following: 

 For Microsoft SQL Server 2014, enter 8. 

 For Microsoft SQL Server 2012, enter 7. 

 For Microsoft SQL Server 2008, enter 6. 

 For Microsoft SQL Server 2005, enter 4. 

 Note  

Command line parameters are case-sensitive. 

 Caution  

For security reasons, do not start the SAP Business One client using the command line in productive 

environments. You should use this method only for testing.  

In the SAP Business One toolbar, you can check the log configurations by choosing Help  Support Desk  

Logger Setting. You can see the relevant configuration log file under …\SAP\SAP Business 

One\Conf\B1logconfig.xml. 

7.3 Installing License Keys 

To use your SAP Business One application according to your contract, you are required to install a license key 

assigned by SAP. 

You also must install a new license key when: 

 You add additional users or components. 

 The hardware key changes. 

 The current license key expires. 

 You have a new installation of SAP Business One. 

 

To avoid changing the hardware key accidentally, do not perform the following actions on the machine running the 

license server: 

 Formatting the computer and reinstalling Microsoft Windows using another product key 

 Changing the computer name 

 Changing the domain (hardware key does not change back when you return to the previous domain) 

 

The following actions are safe and do not change the hardware key: 

 Adding a new user logon 

 Changing the computer date or time 
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Procedure 

 To open the SAP Business One Service Manager window, in the Microsoft Windows task bar, double-click 

(SAP Business One Service Manager).  

Alternatively, in Windows, choose Start → All Programs → SAP Business One → Server Tools → Service 

Manager. 

In the SAP Business One Service Manager window, from the Service dropdown list, select License Manager 

and choose the Settings button. 

 

 In the General Settings window, do the following: 

1. Enter the name or IP address of the machine on which the server tools are installed.  

 Note  

Use localhost only in standalone installations. 

2. To install the license key file, choose the Browse button and select the txt file you received from SAP. 
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 Choose the Import License File button. 

 To save your settings and close the General Settings window, choose the OK button.  

 To complete the process and close the SAP Business One Service Manager window, choose the OK button. 

7.4 Assigning SAP Business One Add-Ons 

Add-ons are additional components or extensions for SAP Business One. Installing the server and client 

applications automatically registers the SAP add-ons and makes them available for installation from the SAP 

Business One application. The application automatically registers the following add-ons: 

 32-bit add-ons: 

o DATEV FI Interface 

o Electronic File Manager 

o Microsoft Outlook integration 

o Payment Engine 

o Screen Painter 

 64-bit add-ons: 

o Electronic File Manager 
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o Microsoft Outlook integration 

o Payment Engine 

o Screen Painter 

Note 

As of SAP Business One 9.1 PL03, the ELSTER Electronic Tax Return add-on is available for download in 

the SAP Business One Software Download Center and is no longer included in the SAP Business One 

download package. For more information, see SAP Note 2064562.   

Prerequisites 

 You have a Professional license from SAP. 

 You have installed Microsoft XML 3.0 Service Pack 4 on your workstation. To ensure that this software is 

installed on the hard drive of the workstation, check that the msxml3.dll file is saved in the system32 directory 

in the main Windows directory. 

 If you chose Custom for the installation of server components, ensure that SAP Add-ons is selected in the 

Select Features window. 

 You must have Power User or Administrator rights, especially in the terminal server environment. 

The following table displays the SAP Business One add-ons and their prerequisites.  

Add-On Prerequisites 

Payment Engine Inbound Functionality is activated only when the Bank Statement Processing 

checkbox is deselected. 

Screen Painter You have installed Microsoft .NET Framework 2.0 on the SAP Business One 

workstation intended to run Screen Painter. 

Microsoft Outlook 

integration 

 You have installed Microsoft Outlook on your workstation. 

Supported versions: 2000 SR1 and higher, 2002, 2003, 2007, 2010, 2013, 

2016 

 Caution 

32-bit and 64-bit versions of Microsoft Office are available. If you are 

using the 32-bit version of Microsoft Office, install the 32-bit versions of 

SAP Business One and Microsoft Outlook integration add-on. If you are 

using the 64-bit version of Microsoft Office, install the 64-bit version of 

SAP Business One and Microsoft Outlook integration add-on. 

It is possible to run the 32-bit version of Microsoft Office with the 64-bit 

version of SAP Business One, however, in this scenario, Microsoft Outlook 

integration is not possible. 

Note 

After installing the Microsoft Outlook integration add-on, the SAP 

Business One entry appears in the Add-Ins menu of the following 

Microsoft Office applications: 

o Microsoft Outlook 

https://support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui/main.do
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Add-On Prerequisites 

o Microsoft Word 

o Microsoft Excel 

 After installing Microsoft Outlook, you created an e-mail account for sending 

and receiving e-mails. 

 Microsoft Outlook is set as your default mail client. To check your default mail 

client, open the Control Panel window, and choose Internet Options. On the 

Programs tab, ensure that in the E-mail field, Microsoft Outlook is selected. 

For more information about how to use the feature, see the Microsoft Outlook 

integration online help. The help is available in the Add-Ins menu of the above 

Microsoft Office applications and from within the relevant windows in the SAP 

Business One client application (by pressing F1  in the windows). 

Datev FI Interface You have created a new company to work with the DATEV add-on and deselected 

the checkboxes: Copy User-Defined Fields and Tables and Copy User-Defined 

Objects. 

The DATEV add-on may not work with demo databases. 

 Constraints 

When you run SAP Business One, you can use only SAP Business One add-ons valid for the version of the 

application you are running. 

If you are using the 32-bit version of the SAP Business One client, you can install and run only 32-bit add-ons. If 

you are using the 64-bit version of the SAP Business One client, you can install and run only 64-bit add-ons.  

The add-ons run under the SAP Add-Ons license, which is included in the Professional User license. 

Procedure 

For information about how to assign SAP add-ons, see the Assigning Add-Ons online help document.  

You can find the online help document at the following locations: 

 Partners — SAP Channel Partner Portal on sappartneredge.com 

 Customers — SAP Business One Customer Portal at 

http://service.sap.com/smb/sbocustomer/documentation 

7.5 Performing Post-Installation Activities for the Integration 
Framework 

After installation is complete, you can begin using the integration framework. No mandatory post-installation 

activities are necessary.  

http://sappartneredge.com/
http://service.sap.com/smb/sbocustomer/documentation
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However, for certain use cases, you need additional settings in the integration framework. The following sections 

provide information about additional configuration options and settings you can check to ensure a correct setup. 

 Note 

The integration framework is implemented as a Microsoft Windows service with the SAP Business One 

Integration Service identifier. The service starts automatically after successful installation.  

If you cannot start the integration framework, stop and restart the service.  

You can locate the service by choosing Start → Control Panel → Administrative Tools → Services. 

 Maintaining Technical Settings in the Integration 
Framework 

Procedure 

 In Microsoft Windows, choose Start  All Programs  Integration solution for SAP Business One  

Integration Framework. 

The Administrative Logon user interface opens. 

 In the B1i User field, enter B1iadmin and in the Password field, enter the password that has been provided 

during installation. 

Note that entries in the B1i User field are case-sensitive. 

 To add or change integration framework technical settings, in the integration framework, choose 

Maintenance. 

o To define proxy settings for your network and provide connection information for your e-mail server, 

choose Cfg Connectivity. 

o To get an overview about configuration information for message exchange between SAP Business One 

and the integration framework and about integration packages setup, choose Tools  Troubleshooting, 

and in the Functional Group field, choose B1 Setup.  

For more information about maintenance functions, in the integration framework choose Help  Documents 

 Operations Part 2, section System Administration.  

 Maintenance, Monitoring and Security 

Monitoring 

For technical monitoring purposes, choose Start  All programs  Integration solution for SAP Business One  

Integration Framework, and in the integration framework, choose Monitoring.  

You can use the message log, access the error inbox, display SAP Business One (B1) events and use other 

monitoring functions.  

By default, the message log is active after installation. We recommend deactivating the message log in a 

productive environment. 
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For additional documentation, choose Start  All programs  Integration solution for SAP Business One  

Integration Framework, and then choose Help  Documents  Operations Part 1 and Operations Part 2. 

System Landscape Directory (SLD) 

To maintain systems connecting to the integration framework, choose Start  All programs  Integration solution 

for SAP Business One  Integration Framework, and then choose SLD. 

For all integration packages, SAP delivers the necessary system entries in SLD.  

In SLD, make sure that you keep the entry in the b1Server field for the SAP Business One system in sync with the 

entry in the associatedSrvIP field for the WSforMobile system. 

Integration with SAP Business One integration for SAP NetWeaver 

If your SAP Business One is connected as a subsidiary to the SAP Business One integration for SAP NetWeaver 

server, it is necessary to add entries to the event subscriber manually.  

To configure the SAP Business One event subscriber to send events to a remote integration framework server, 

choose Start  All programs  Integration solution for SAP Business One  Integration Framework, and then 

choose Maintenance  Cfg B1 Event Subscriber. 

For more information, click the documentation (Book) icon in the function. 

Security Information 

The integration framework security guide gives you information that explains how to implement a security policy 

and provides recommendations for meeting security demands for the integration framework.  

For more information, choose Start  All programs  Integration solution for SAP Business One  Integration 

Framework, and then choose Help  Documents  Operations Part 2, section Integration Framework Security 

Guide. 

 Technical B1i User 

SAP Business One creates a user with the B1i user code for each company database. The default process 

requires that you set the same password for each company database. The integration framework uses the B1i 

user to connect to SAP Business One (for example, to check authentication when using the mobile solution). 

Ensure that the password that you provided during installation of the integration framework is the same you set in 

SAP Business One. 

 Licensing 

Ensure that the SAP Business One B1i user has been assigned with the following two free licenses:  
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 B1iINDIRECT_MSS 

 B1i 

No additional licenses are required for the B1i user.  

Mobile users must be licensed to access the SAP Business One system through the mobile channel. License 

administration is integrated with the SAP Business One user and license.  

 Assigning More Random-Access Memory 

We recommend checking the performance aspects in the related documentation. 

Choose Start  All programs  Integration solution for SAP Business One  Integration Framework, and then 

choose Help  Documents  Operations Part 2, section 2. 

If you expect your system to run under very high load and to process a high amount of messages, you can assign 

more random-access memory (RAM) to the integration framework server to improve performance.  

Procedure 

 On your local drive C:\Program Files\SAP\SAP Business One 

Integration\IntegrationServer\tomcat\bin\ double-click tomcat6w.exe.  

If the system denies access, select tomcat6w.exe, open the context menu and select the Run as Administrator 

option. 

 Select the Java tab, and increase the maximum memory pool amount as follows: 

o In a 32-bit operating system, Tomcat supports a maximum memory pool of 1024 MB.  

o In a 64-bit operating system, the default is 2048 MB for the maximum memory pool amount for Tomcat, 

you can assign more RAM. 

 Changing Integration Framework Server Ports 

By default, the integration framework server uses port 8080 for http and 8443 for https. If another application is 

already using one of these ports, change the integration framework ports. 

Procedure 

 If SAP Business One Event Sender Service is already running, stop the service. 

 In the …\Program Files (x86)\SAP\ Integration Solution for SAP Business 

One\IntegrationServer\Tomcat\conf folder, double-click the server.xml Tomcat file and in the 

connector port tag, change the settings as necessary. Do not change any other settings in the file. 

 Log on to the integration framework, choose Maintenance  Cfg Runtime and change the port or ports. 

The integration framework also updates the setting in the SLSPP table in SAP Business One. 

 Restart the SAP Business One Integration Service. 
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 Choose Start  All Programs  Integration solution for SAP Business One  EventSender  Setup, follow the 

steps of the wizard and in the Configure B1i Parameters section, change the B1i Server Port entry, and then 

test the connection. 

 Restart the SAP Business One EventSender Service. 

 To change the properties for the menu entry, choose Start  All programs  Integration solution for SAP 

Business One  Integration Framework. Be sure ti use the correct port number. 

 Changing Event Sender Settings 

SAP Business One writes events for new data, changes and deletions to the SEVT table. Based on filter settings, 

the event sender accesses the table, retrieves data and hands over the events to the integration framework for 

further processing.  

The installation program installs and sets up the event sender on the SAP Business One server. The following 

section describes event sender settings, although usually no further changes are required. 

 Note 

Only call the event sender setup in the following cases: 

o You must change the password for database access. 

o You have changed the B1iadmin password for the runtime user. 

o You have moved to another server. 

o To reduce the message load, you want to include or exclude some objects. 

o You want to exclude users. 

To check the settings for the event sender, use the integration framework troubleshooting function. In the 

integration framework, choose Tools → Troubleshooting, and in the Functional Group field, choose Event Sender. 

Procedure 

 To call the event sender setup, choose Start → All Programs → Integration Solution for SAP Business One → 

EventSender → Setup. 

 In step 1, in the Choose a DB Type field, select the SAP Business One database type. 

 In the DB Connection Settings section, you can set the following: 

o In the DB Server Name field, enter the computer name or IP address of the machine, where the database 

of the SAP Business One server is installed. Do not use localhost. 

 Recommendation 

Use the hostname of the server. Only if you have problems specifying the hostname, use the IP address 

instead. 

 Caution 

In the SAP Business One integration for SAP NetWeaver installation, this setting must be identical with 

the value in the b1Server field. If the values are not identical, they appear in the Filtered section. 
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o In the Port field, enter the port number of the database server, where the SAP Business One server is 

installed. 

o In the Setup DB Account and Password fields, the installation has set the database user name and 

password for database access during setup.  

This user must have access rights to create tables and store procedures. 

o In the Running DB Account and Password fields the installation has set the database user name and 

password for database access at runtime.  

This user must have access rights to the event log and event lock tables. 

o If you want to use the Microsoft Windows authentication mechanism to connect to the database, select 

the Trusted Connection option. 

If you select this option, you do not have to specify the Setup DB Account, Running DB Account and 

Password fields. 

 In step 2, the following settings are available in the Monitor Settings section. 

o In the Idle Time (millisecond) field, you can change the time period the event sender waits until it polls 

events from SAP Business One.  

The default is 3000 milliseconds.  

o In the Batch Count field, you can set the number of events the event sender polls each time.  

The default is 10. 

 In step 3, you can change general settings for the integration framework. 

By default, the installation program sets the Sending Method to Direct. 

o If you select the Direct method, the event sender directly sends events to a dedicated server address. 

This can either be an integration framework server or the SAP Business One integration for SAP 

NetWeaver server. 

o If you select the Distributed method, the event sender sends all events to the local server address and 

the event dispatcher takes over the task of distributing the events to other systems. Before selecting this 

method, make sure that you have configured the event subscriber. 

For more information, see the Operations Guide Part 2, section Configuring the B1 Event Subscriber 

 In the General B1i Settings, you can configure the following: 

o In the Protocol Type field, select the protocol for the connection between the event sender and the 

integration framework. To enable https, make settings in the Tomcat administration. 

o In the Authentication field, always use the Basic option. This is the default. 

o In the B1i Server field, enter the name or IP address of your integration framework or the SAP Business 

One integration for SAP NetWeaver server. 

o In the B1i Server Port field, enter the port number of your integration framework or the SAP Business One 

integration for SAP NetWeaver server. 

o If you work in a network with a proxy, in the Proxy Host field, enter the name or IP address of your network 

proxy. 

o If you work in a network with a proxy, in the Proxy Port field, enter the port number of your network proxy. 

o In the User Name field, enter the user name for accessing the integration framework or SAP Business One 

integration for SAP NetWeaver server. The default is B1iadmin. 

o In the Password field, enter the password for accessing the integration framework or SAP Business One 

integration for SAP NetWeaver server. 

o To test the connection, choose the Test Connect… button. 

 In step 4, choose the company databases. 
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The setup program displays the company databases in your SAP Business One system. For each company 

database, you can set up the following: 

1. Deselect the checkbox in front of the SAP Business One company database, if the company does not use 

the integration framework. If you deselect the checkbox, SAP Business One does not create events for the 

company database in the SEVT table. 

2. To define for which SAP Business One objects the event sender sends events, chose the Event Filter 

button. 

o In the Include List B1 Object(s) field, enter the object identifier of the SAP Business One object or 

objects. Separate entries by comma.  

If you enter, for example 22,17, the event sender sends events for purchase orders and orders to the 

integration framework or the SAP Business One integration for SAP NetWeaver server.  

If you leave the field empty, the event sender sends events for all SAP Business One objects to the 

integration framework or the SAP Business One integration for SAP NetWeaver server. 

o In the Exclude List B1 Object(s) field, enter the object identifier of the SAP Business One object or 

objects. Separate entries by comma.  

If you enter for example 85 the event sender excludes events for special prices for groups.  

If you leave the field empty, the event sender sends events for all SAP Business One objects to the 

integration framework or the SAP Business One integration for SAP NetWeaver server. 

 Note 

Use either the Include B1 Object(s) or the Exclude List B1 Object(s) function. Do not use the functions 

together. 

o In the Exclude List B1 User field, enter SAP Business One users for which the event sender does not 

send events to the integration framework. Enter the SAP Business One user name, not the user code. 

Separate entries by comma. 

o If you want the company database to create events based on indirect journal entries, select the 

Create Complete Journal Entry Events checkbox. Standard SAP Business One processing does not 

create events for indirect journal entries. 

3. To define the receiver of events, choose the Default Inbound button. You have the following options: 

o Default Inbound 

This is the default. The event sender hands over events to B1iP. The event dispatcher hands over the 

events to the event subscriber that distributes the events to the target application or applications. 

o SAP Business One integration for SAP NetWeaver 2005 

This option is available for SAP Business One integration for SAP NetWeaver 2005 to be backwards 

compatible.  

If you select this option, choose the Receiver button and enter the B1i application URI. To test the 

connection, choose the Test connection button. 

o OTR (Other) 

If you select this option, choose the Receiver button and enter the B1i application URI. To test the 

connection, choose the Test connection button. 

4. To test the connection to the receiver of SAP Business One events, choose the Receiver and then on the 

Test Connection button. 

 Step 5 gives you a summary of the event sender settings. 

 To save the settings, choose the Finish button. 
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 Restart the SAP Business One EventSender service. 

Result 

The setup program stores the settings in the datasource.properties and 

eventsenderconfig.properties configuration files. 

 Changing SAP Business One DI Proxy Settings 

SAP Business One DI Proxy is the SAP Business One-related component that enables data exchange with SAP 

Business One using the DI API. No additional steps are required to set up the SAP Business One DI Proxy service. 

To influence the behavior of the SAP Business One DI Proxy service, parameters are available in the 

diproxyserver.properties file. 

Procedure 

 To change parameters, access the diproxyserver.properties file in the …SAP\SAP Business One 

Integration\DIProxy path. 

Property Description 

RMI_PORT The parameter is obsolete. 

HTTPS_PORT DI Proxy TCP port for HTTPS. 

MAXDIERRORS If this property exists and has a value greater than 0, the value defines 

the number of DI errors that may occur before the DI Proxy restarts. The 

default is 50.  

RESTARTPERIOD If this property exists and has a value greater than 0, the value 

determines the time in minutes after which the DI Proxy restarts. The 

default is 60.  

ORPHANED This property defines the value in minutes after which the system 

defines a pending and not yet completed DI transaction as orphaned. 

The DI Proxy removes the transaction from the internal transaction list. 

If this property does not exist or does not have a positive value, the 

default is 10. If it exists, the default is 30.  

JCOPATH If this property exists and is not empty, it defines the path the DI Proxy 

uses to search for the JCo installation. In this case the system ignores 

any value coming from B1iP requested by an adapter.  

If the property does not exist, the system uses any value coming from 

B1iP requested by an adapter. In this case the setting is probably not 

definite.  

SAP recommends setting the JCo path in the 

diproxyserver.properties file. 
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Property Description 

If you want to change a JCo path that someone has already maintained 

and that the system has used for connection, you can apply this change 

only after you have restarted the SAP Business One DI Proxy Service.  

Use / or \\ instead of \ as a separator in the JCOPATH value. Use for 

example C:\\Program Files\\SAP\\SAP Business One DI 

API\\JCO\\LIB 

JCOVERSION If this property exists and is not empty, it defines the version the DI 

Proxy uses to search for the JCo installation.  

restartAttemptDelay As of DI Proxy version 30002211, you can overlay the default for a 

restart delay (500 milliseconds).  

Provide a value in milliseconds. 

The parameter is not part of the default diproxyserver.properties 

file. If you want to use it, add it manually. 

restartAttemptCap As of DI Proxy version 30002211, you can overlay the default number of 

restart attempts (10). 

The parameter is not part of the default diproxyserver.properties 

file. If you want to use it, add it manually. 

 If you change any settings, restart the SAP Business One DI Proxy Service. 

 Integration Framework-Related Information About 
Dashboard Widgets for the Cockpit 

 If the B1i user password is not correct or licenses are not properly assigned to the user, Dashboard widgets 

display the 401 not authorized error. 

In the integration framework, adjust the B1i user password in SLD. Ensure that licenses are correctly 

assigned. 

For more information, see the Licensing section. 

 If Dashboards have been activated, but not properly deployed in the integration framework, the 404 file 

not found error mentioning DASHBOARD is displayed. 

Check that all services for the integration framework are running. 

Deactivate the Dashboard widgets, log off and logon again, and activate the Dashboard widgets. 

 To support the display of dashboards, ensure that Adobe Flash Player 10.0 is installed on the client 

workstation. 

 For information about creating dashboards, see How to Develop Your Own Dashboards for SAP Business One 

on sappartneredge.com. Customers can find the document in the documentation area of SAP Business One 

Customer Portal at http://service.sap.com/smb/sbocustomer/documentation. 

 

 

file:///C:/D/Work/Projects/B1H/9.1H/PL00/Documentation/sappartneredge.com
http://service.sap.com/smb/sbocustomer/documentation
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8 Maintaining Databases 

This section provides information about checking and maintaining your database system. Database activities 

depend on the nature of your organization's day-to-day work. There are many factors influencing system 

performance, such as disk space availability, the number of transactions occurring each day, and so on. It is 

essential to perform daily and regular checks to ensure the efficient operation of SAP Business One. System 

performance depends on the correct administration of the database. 

This section also lists all the stored procedures quoted in the SAP Business One application. 

8.1 Database Server Administration 

This section provides basic information about the SQL Server environment, the way a database management 

system stores and accesses the data, and the database administration tool. The information comprises the 

following topics: 

 Starting and stopping database services 

 Performing weekly tasks 

 Performing regular tasks 

 Performing backups 

 Performing restoration 

 Starting and Stopping Database Services 

Occasionally, it is necessary to stop and start database services manually, for example, when you perform a 

complete backup of the database. 

Procedure 

 To stop database services: 

1. Verify that no clients are logged on to SAP Business One. 

2. To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL 

Server 2008 → SQL Server Management Studio. 

3. In the Object Explorer window, right-click the database server on which your SAP Business One database 

is installed and choose Stop. 

 To start database services: 

1. To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL 

Server 2008 → SQL Server Management Studio. 
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2. In the Object Explorer window, right-click the database server on which your SAP Business One database 

is installed and choose Start. 

 Note  

If you are not able to log on to SAP Business One, and the dialog box for choosing a company contains an 

empty list, check whether Microsoft SQL Server is running. 

If you log off the Microsoft SQL Server services, all user processes are terminated, but the database 

services keep running. 

 Weekly Tasks 

Perform the following tasks on at least a weekly basis: 

 Checking database consistency 

 Running the Update Statistics command  

If the size of the SAP Business One database is large or your company has a large volume of daily or weekly 

transactions in SAP Business One, perform the previous tasks more often. 

8.1.2.1 Checking Database Consistency 

A database consistency check performs a thorough check of the entire database. It examines all tables in the 

database to ensure that index and data pages are linked correctly and that indexes are in the correctly sorted 

order. A database consistency check also ensures that all pointers are consistent and that the data information on 

each page and page offset is reasonable.  

Performing database consistency checks enables you to recognize problems early, and prevent escalations and 

the possible loss of data. 

When performing database consistency checks, ensure the following: 

 Schedule consistency checks with the planning calendar.  

 Run consistency checks outside of normal business hours, for example on the weekends.  

 Do not schedule any other tasks at the same time as you run the consistency check. 

 Note  

On the Microsoft SQL Server level, the SAP Business One database consistency check executes the DBCC 

CHECKDB command, which locks user tables, indexes, and system tables throughout the run. 

In addition, a database consistency check is an I/O intensive process. Therefore, you should not run 

checks during normal business operations, but at times when the system load is low. 

You can use the remote support platform for SAP Business One to automatically perform database consistency 

checks as part of a defined backup strategy. For more information, see the online help for the remote support 

platform. 
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8.1.2.2 Running the UPDATE STATISTICS Statement 

The UPDATE STATISTICS statement defines the storage requirements of tables and indexes as well as the value 

distribution of columns, and stores this information in the database catalog. 

The Optimizer uses these values to determine the best strategy for executing SQL statements. Use the 

sp_updatestats procedure on all user-defined tables in the required database. 

When the UPDATE STATISTICS statement is executed, the following information about the table is stored in the 

database catalog: 

 Number of rows 

 Number of pages used 

 Size of indexes 

 Value distribution within columns or indexes 

You can use the remote support platform for SAP Business One to execute the UPDATE STATISTICS statement 

manually or as part of a scheduled task. You can also configure the remote support platform to create a job in the 

Microsoft SQL Server Agent, which updates statistics according to schedule. 

 Regular Tasks 

Performing scheduled tasks is essential for ensuring database availability and minimizing the risk of data loss. 

Perform the following tasks on a regular basis, as determined by your database size and transaction volumes: 

 Verify that the database server is running 

 Verify that the backups run successfully 

 Check the database 

 Shrink the transaction log 

 Monitor disk space 

8.1.3.1 Verifying Database Servers Are Running 

You must complete this task every morning. SAP Business One clients cannot work if the database server is not 

running. 

Procedure 

Run the SAP Business One client and log on to your database server. If you can log on, the database server is 

running. 

Alternatively, you can use the System Status Report of the remote support platform for SAP Business One to 

automate the database verification process. 
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8.1.3.2 Verifying Backups 

Backups of your database are essential for recovering the SAP Business One system in case of failure. Use this 

procedure to verify that previous backups ran successfully. 

Alternatively, you can use the remote support platform for SAP Business One to automate the backup verification 

process as part of a defined backup strategy. 

Procedure 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL Server 

2008 → SQL Server Management Studio.  

 Select the Management folder and check the SQL server logs. 

 Search for the last backup message.  

 Verify that the backup ran successfully and that the date fits the scheduled settings. 

The following is an example of a successful backup message: 

" Database backed up. Database: myDB, creation date(time): 2005/12/21(10:57:16), 

pages dumped: 502701, first LSN: 37211:18:108, last LSN: 37211:91:1, number of dump 

devices: 1, device information: (FILE=1, TYPE=DISK: {'E:\temp\bck\myDB'}). This is 

an informational message only. No user action is required." 

8.1.3.3 Checking Databases 

The SQL Server database uses disk space to store the database data files and the daily transaction log files. If you 

do not establish a schedule for the backup of the transaction log, the log file can grow too large, causing a decline 

in system performance. Ultimately, this can stop the database system. 

The transaction log should not occupy more than 60–70% of the total available disk size. If it regularly exceeds 

this level between subsequent backups, you must save the transaction log more frequently. In SQL Server 

Management Studio, you can determine whether the data file and transaction log file are set to grow 

automatically. 

In addition, check the utilization of table space and the content of error logs on a regular basis. 

Procedure 

 To check the size of the data file and the transaction log file, do the following: 

1. To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL 

Server 2008 → SQL Server Management Studio.  

2. Select the database for which you want to check the transaction log size. 

3. Right-click the selected database and choose Reports → Standard Reports → Disk Usage. In the right 

pane, you can see the report. 

4. Verify that there is enough free space, based on your organization’s needs, for both the data file and the 

transaction log. 
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 To set grow options for database files, do the following: 

1. Open SQL Server Management Studio and select a database. 

2. Right-click the selected database and choose Properties.  

3. In the Properties window, from the menu on the left, choose Files. 

4. The database files appear in the right pane. 

5. In the Autogrowth field, set a value according to your organization’s needs. 

 To check error logs, do the following:  

1. Open SQL Server Management Studio.  

2. Select the Management folder and check the SQL Server Logs folder. 

3. Check for error messages and verify that no problems have occurred. 

8.1.3.4 Shrinking Transaction Logs 

Shrinking the transaction log file frees up disk space and minimizes the risk of data loss. Shrinking the transaction 

log does not reduce the size of a physical log file. It removes enough inactive virtual logs to reduce the log file to 

the requested size. Use this procedure to shrink the transaction first virtually and then physically. 

In addition, you can use the remote support platform for SAP Business One to shrink the transaction log manually 

or as part of a scheduled task. You can also configure the remote support platform to create a job in the Microsoft 

SQL Server Agent, which shrinks the transaction log according to schedule. 

Procedure  

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL Server 

2008 → SQL Server Management Studio.  

 Select the required system database. 

 Right-click the selected database and choose New Query. 

The right pane displays the Query window. 

 In the Query window, enter the following command: 

BACKUP LOG <sid> WITH NO_LOG 

Where: 

<sid> is name of the database, for example sbodemo_us 

Right-click anywhere on the query tab and choose Execute. 

This statement reduces the size of the logical log. It removes the inactive part of the log, without making a 

backup copy, and truncates the log.  

Specifying a backup device is unnecessary because the log backup is not saved. 

After you back up the log using NO_LOG, the changes recorded in the log are not recoverable. For recovery 

purposes, execute a manual backup of your database. For more information, see SAP Note 557412. 

 To reduce the size of the physical log file, enter the following command: 

DBCC SHRINKFILE (<name_logfile>, <size>) 

 

http://service.sap.com/sap/bc/bsp/spn/smb_searchnotes/display2.htm?note_langu=E&note_numm=557412


 

138 

CUSTOMER  

©  2016 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Maintaining Databases 

 

Where: 

<name_logfile> is the logical name of the shrunk file, for example sbodemo_us_log 

<size> is the required size for the file, in megabytes, expressed as an integer. If the size is not specified, DBCC 

SHRINKFILE reduces the size to the default file size, for example 10 MB. 

Right-click anywhere on the query tab and choose Execute. 

 Note  

In SQL Server, a DBCC SHRINKDATABASE or DBCCSHRINKFILE operation attempts to shrink the physical 

log file to the requested size (subject to rounding). 

8.1.3.5 Monitoring Disk Space 

We recommend that you regularly check the amount of free space available on the disk. You can use the System 

Status Report of the remote support platform for SAP Business One to automate the process of monitoring the 

amount of free disk space. 

 Backing Up Databases 

This section provides an introduction to backups and information about the necessity of a backup strategy. 

Databases are always at risk of damage and it is vital to implement a security strategy. 

To keep the risk of data loss low, ensure that you develop a backup strategy that suits your business and the 

requirements of your customers. An important factor to consider is the volume of data that you process each day. 

In case of data loss, you are required to retrieve this data manually, back to the time of your last backup. 

With SAP Business One, we recommend backing up your application database regularly. 

 Caution  

SAP Business One can save the configuration data only when you have write and read access to the user 

profile folder. 

8.1.4.1 Backup Strategies 

To choose the appropriate backup-and-restore strategy, you need to identify the requirements for the availability 

of your data. Your overall backup strategy should define the type and frequency of backups and the nature and 

speed of the hardware. 

Consider the complexity of each strategy. Full backups are easy to implement. If you are considering backing up 

your transaction log as well, test all backup-and-restore procedures intensively. 

When choosing your backup strategy, you can use the following methods: 

 Full Backup 
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In Microsoft SQL Server, a full backup is a consistent copy of your database at a certain time. Since only used 

objects are saved, normally the copy is smaller than the original database. Full backups should be scheduled 

for a time when there is a low load on the database server. 

 Differential Backup 

A differential backup is a backup of all data that has changed since the last full backup was performed. 

Compared with full backups, differential backups consume less time and disk space, but can result in a longer 

amount of time required to restore data. 

 Transaction Log Backup 

The Transaction Log is a serial record of all the transactions that have been performed on the database since 

the transaction log was last backed up. With transaction log backups, you can recover the database to a 

specific point in time or to the point of failure. 

The transaction log grows over time. If the transaction log exceeds a certain size, it can cause problems in 

Microsoft SQL Server. To prevent those problems, we recommend doing regular backups of the transaction 

log, which truncates the transaction log. 

 Backup of SAP Business One Subdirectories 

To avoid data loss, you must back up regularly the following subdirectories of SAP Business One: 

o ...\Program Files\SAP\SAP Business One\Attachments\ 

o ...\Program Files\SAP\SAP Business One\Bitmaps\ 

o ...\Program Files\SAP\SAP Business One\ExclDocs\ 

o ...\Program Files\SAP\SAP Business One\WordDocs\ 

These directories contain Microsoft Word and Microsoft Excel documents and bitmaps. To store the backed 

up directories, you can use a file archiving application. 

 Recommendation  

Test your backup and recovery procedures thoroughly. Testing helps to ensure that you have the 

required backups to recover from various failures, and that your procedures can be executed smoothly 

and quickly if a failure occurs. 

The frequency of the backups depends on the following factors: 

o Processed data volume 

o Customer requirements 

o Number of users 

Consider how much time you would need to invest in retrieving your data manually after a data loss. After 

installing or upgrading SAP Business One, perform a full backup of the SBO_DB database. 

8.1.4.2 Backup Types 

You can back up your data using the backup functionality of remote support platform for SAP Business One or 

SQL Server Management Studio, using one of the backup types described below: 

 Full Backup and Differential Backup and/or Transaction Log Backup Using the Remote Support Platform for 

SAP Business One 

This backup type saves backup data to a network folder. The setup is relatively simple, and you can configure 

the remote support platform to automatically perform scheduled backups according to a defined strategy. 

The remote support platform can also backup SAP Business One subdirectories. 
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 Full Backup Using Microsoft SQL Server Management Studio 

This backup type can save the backup data directly to tape. If you save the backups on disk, ensure the 

backup is copied to another medium, such as another hard disc, DVD, or tape. 

Do a manual backup of the files and directories of your hard disk. 

 Full Backup and Transaction Log Backup Using Microsoft SQL Server Management Studio 

 Note  

To use SQL Server Management Studio to perform transaction log backups, you should have already 

selected the Full recovery model option. 

The advantage of this type of backup is that the monitoring is partly automated and you can save the backups 

directly to a tape. You can also add alerts. Disadvantages include a relatively complicated setup and the need 

to manually back up the subdirectories of SAP Business One. However, SAP Business One does not fully 

support all of the features available with SQL Server Management Studio; therefore, if you require support 

from SAP in the future, your database backup may not be fully compatible. 

 Note  

o Full Recovery — You can perform accumulated backups and move back to a specific point in time. 

o Simple Recovery — You can back up only the whole database; after the restoration, the database 

goes back to exactly the same point at which it was backed up. 

 Example  

The following table summarizes the main options for each backup type: 

Backup Type Full Backup and 

Differential Backup 

and/or Transaction Log 

Backup 

Full Backup Full Backup and Transaction 

Log Backup 

Tool Remote support 

platform for SAP 

Business One 

Microsoft SQL Server 

Management Studio 

Microsoft SQL Server 

Management Studio 

Recovery model Full Simple Full 

Installation effort Low Medium High 

Monitoring effort Low Medium Medium 

Backup 

destination 

Disk or network share Disk or tape Disk or tape 

Automatic file 

backup 

Yes Yes No 

Complexity Low Medium High 
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 Note  

SAP Business One Product Support only accepts backups on destination disks. If you back up on tape, 

you must first restore it from there, and back it up again, using a destination disk, prior to sending it to 

SAP Support. 

8.1.4.3 Troubleshooting Backups 

To ensure that your database backups are successful, check your server at regular intervals. Ensure that you have 

enough disk space on the server on which your database is stored. If you store your backup on another server, 

check that there is enough free space. 

The basic checks include: 

 Drive space 

 Disk subsystem errors 

 Tape drive errors 

 Event Viewer 

 Regular evaluation of your recovery and restore process 

Procedure 

 To check the disk space, do the following:  

1. In the Microsoft Windows My Computer window, right-click Hard Disk Drives and choose Properties.  

The Properties window appears. 

2. Check the free space on your hard disk. 

The free space you need on your hard disk depends on the volume of data you process each day. 

Depending on the disk system and the tape drive, scan for disk errors at regular intervals. For more 

information, see your tape drive documentation. 

 To check whether errors occurred in the operating system or on the database server, do the following:  

1. In Windows, choose Start → Control Panel → Administrative Tools → Event Viewer. 

o Events that occur in the system are stored in three different logs. Within these logs, events are 

classified as Information, Warning, or Error. 

o Events that occur within the database server are stored in the Application folder. In the Source 

column of the application log, you can see the source application for a specific event. 

2. Double-click an event to display more information. 

3. In the Application Log, look for error events that may indicate backup failures. 

If you perform network backups, look for network errors in the System and Application logs. 
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 Restoring Databases 

If a failure damages the system, restoring the database restores the integrity of the data in most cases. Ideally, 

the downtime of the system will be minimal and no data should be lost. Develop a restore strategy that considers 

the maximum downtime allowed for your system, and estimate how much time you need to react to a system 

failure. Analyze the problem and take appropriate measures. 

You may be required to change hardware or reinstall the operating system before restoring your database. 

Ensure that an employee familiar with the restore procedures is available at all times. Testing of the restore 

procedures improves the chances of a successful and fast recovery of your data. We recommend doing test 

backups and test restores at regular intervals. 

Restore the database in the following situations: 

 Hardware failure 

 Migration to a new hardware 

 Logical errors 

 Virus 

 Testing 

8.1.5.1 Restore Checklist 

The steps below comprise a general procedure for restoring data. You may find that you do not need to perform 

each step for your particular case. 

 Analyze the problem. 

 If possible, save the current active transaction log. 

 Note  

If the database fails, but Microsoft SQL Server is still available, the transaction log contains data that has 

not been saved yet. You can save it only if the following are not damaged:  

o Hard disk on which the transaction log is saved 

o Hard disk on which the executable files are located 

If you cannot save the transaction log, you can only restore the changes that occurred after the backup of the 

last transaction log. 

 Use the necessary hardware. 

 Configure your database server. 

 Restore your last full backup. 

 Restore the transaction log. 

 Test all executed measures. 

 Release to productive operation. 
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8.1.5.2 Saving Current Transaction Logs 

 Caution  

Before you start the restore process, verify that the installed service pack has not changed since the time 

of the backup. 

Procedure 

 Insert a new tape and, to open SQL Server Management Studio, in Windows, choose Start → All Programs → 

Microsoft SQL Server 2008 → SQL Server Management Studio. 

 Select the relevant database, right-click it, and choose the New Query menu. 

 In the Query window, run the following command: 

BACKUP LOG <sid> TO <tape> WITH NO_TRUNCATE, FORMAT 

Where: 

<sid> is name of the database, for example, sbodemo_us 

<tape> is your backup tape name (case sensitive) 

 After saving the transaction log file, you can change any damaged hardware and, if necessary, reinstall your 

operating system and your Microsoft SQL Server database, as described in Installing SAP Business One. 

 Restore your last full database backup. 

The database is now in the same condition as it was when the backup was carried out. After you restore the 

transaction logs, finished transactions are applied to the database again. 

 Perform a rollforward until the end of the transaction log. 

The database is now in the same condition as it was at the time of the last transaction log backup. Since this 

condition is not consistent, perform a rollback for all unfinished transactions. 

The <msdb> database stores the history of backups and of restore operations in the backup set and backup 

file of the tables. If the msdb database is available, the recovery is based on the saved history in msdb. For 

more information, see Restoring Data When msdb Is Available. 

If the system database msdb is not available, you have to restore it and reconstruct the history. For more 

information, see Restoring Data When msdb Is Unavailable. 

 Recommendation  

To ensure a successful restore operation, you can test the restore process against a test database. If you 

use the transaction log file, we recommend testing all procedures thoroughly. 

8.1.5.3 Restoring Backup Files and Application Folders 

To restore backup files and application folders, perform the following procedures: 

 Extract the files from the backup archive, including: 

o Database backup .zip file 

o Application folder backup archive files 
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 Extract the application folder backup archive files to separate folders. 

 Manually copy the extracted files back to the original shared folders. 

8.1.5.4 Restoring Data When msdb Is Available 

This procedure provides instructions for restoring your database when the database msdb is available. When you 

use the history function, the last backups are selected automatically. 

Procedure 

 To enable the system to restore the database, close SAP Business One. 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL Server 

2008 → SQL Server Management Studio. 

 Right-click the required database and choose Tasks → Restore → Database. 

A list of performed backups appears. The last full backup and the subsequent transaction log backups are 

selected automatically. 

 In the Restore Database window, on the Options tab, select the following options: 

o Overwrite over existing database — To overwrite the existing database, select this option. 

o Preserve the replication settings 

o Prompt before restoring each backup — Prompt the user before restoring each backup to prevent a user 

from inadvertently restoring a backup. 

o Restrict access to the restored database 

o Restore database file as — In the Restore As column, change the path name if you are restoring the 

database on a different server. 

 Note  

To specify the .bu file, do the following: 

1. In the Microsoft SQL Server Management Studio window, on the General tab, select the From Device 

radio button and choose the Browse button. 

2. In the Specify Backup window, choose the Add button. 

3. In the Locate Backup File <computer_name> window, from the Files of Type dropdown list, select All 

Files. 

4. In the hierarchy tree, specify the .bu file that you want to restore. 

5. Choose the OK button. 

 To confirm, choose the OK button. 

The system starts the database restore process. 

 Wait until the following message is displayed: 

Restore of Database <databasename> completed successfully. 

SQL Server copies the data from the backups, restoring the database and creating all dependent files. 
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8.1.5.5 Restoring Data When msdb Is Unavailable 

This section provides instructions for restoring your database when the history in the database <msdb> is not 

available, for example, after you reinstall SQL Server. For this procedure, you need your last full backup and all 

subsequent backups of the transaction log. 

Procedure 

 To enable the system to restore the database, close SAP Business One. 

 To open SQL Server Management Studio, in Windows, choose Start → All Programs → Microsoft SQL Server 

2008 → SQL Server Management Studio. 

 Create a new database as follows: 

1. Right-click the Databases folder and choose Tasks → Restore → Database. 

The Restore Database window appears. 

2. Specify a name for your new database (the name of your company in SAP Business One). 

 Right-click the new database and choose Tasks → Restore → Database. 

 Select the Restore: From Device option and choose the Browse button. 

 In the Specify Backup window, choose the Add button. 

 In the Locate Backup File window, locate and select the file containing your last full backup. 

Choose the OK button. 

 In the Specify Backup window that opens, locate and select the file containing your last full backup.  

Choose the OK button. 

 In the Restore Database window, select the required back sets and on the Options tab make the following 

settings: 

o Select the Overwrite the existing database checkbox. 

o Under the Restore As column, change the path, if necessary, for example, if you are restoring the 

database on a different server where the path name does not exist. 

o In the Recovery completion state area, select the Leave database non-operational but able to restore 

additional transaction logs option. 

Choose the OK button.  

The system starts restoring the database. 

 Wait for the following message: 

Restore of Database <sid> completed successfully. 

Continue to the procedure for restoring transaction logs. 

8.1.5.5.1 Restoring Transaction Logs 

Procedure 

 Right-click the database you want to restore and choose Task → Restore → Transaction Log. 
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 Select the Restore: From Device option and choose the Browse button. 

 In the Specify Backup window, choose the Add button. 

 In the Locate Backup File window that appears, locate and select the file containing your last full backup. 

Choose the OK button, and do the same in the Specify Backup window that appears. 

 In the Restore Database window, on the Options tab, make the following settings: 

o Select Overwrite the existing database. 

o In the Recovery completion state area, select the Leave database not operational but able to restore 

additional transaction logs option. 

o Choose the OK button. 

The system starts to restore the database. 

 Repeat this procedure for all transaction logs. 

When you reach the last transaction log, in the Recovery Completion State pane, select the Leave database 

operational option. No additional transaction logs can be restored. 

8.1.5.6 Troubleshooting Restore 

The only way to verify that you can do so is to regularly restore backups using the same medium that you would 

use in disaster recovery. 

 Recommendation  

At regular intervals, perform the procedures that would take place in case of a disaster, including the 

restore process of full and transaction log backups. 

8.2 Data Transfer Workbench for SAP Business One 

SAP Business One implementations require you to move data from legacy systems to the new SAP Business One 

system. Business data (such as customers, vendors, and products) must be available in the new system before it 

goes live. 

Data Transfer Workbench provides a wizard that imports new data into SAP Business One and updates existing 

data. To simplify the preparation of data for the import, SAP provides predefined data file templates. Data 

Transfer Workbench records import activities so you can track the data migration process. 

For more information, see the Data Transfer Workbench online help file in the document resource center at 

http://service.sap.com/smb/sbocustomer/documentation. 

The data migration process consists of the following tasks: 

 Extracting data files from your legacy system 

 Cleaning data 

 Mapping data and converting data 

 Importing data into SAP Business One 

 Checking the results of the import 

http://service.sap.com/smb/sbocustomer/documentation
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8.3 Stored Procedures 

The stored procedures listed below are all used in the SAP Business One application. The first table is for the SBO-

COMMON database and the second one is for the company database. 

 Caution  

You must not rename or remove any of the items in the list; otherwise, errors may occur when running 

SAP Business One. 

SBO-COMMON Database Procedures 

SBO- COMMON Procedures  

ClearEnumValues 

DeleteAllEnumsAndClasses 

DeleteAllObjects 

DeleteAllPropertyDefs 

DeleteClassDef 

DeleteDependentProperties 

DeleteEnumType 

DeleteMetaObject 

DeleteMetaProperty 

DeleteMetaRelation 

DeletePropertyDef 

InsertClassDef 

InsertClassDefId 

InsertEnumType 

InsertEnumTypeId 

InsertEnumValue 

InsertMetaObject 

InsertMetaProperty 

InsertMetaRelation 

InsertPropertyDef 

InsertPropertyDefId 

NumberPropertyDefs 
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SBO- COMMON Procedures  

NumberRelations 

OBSSp_GetNextExecFromSchedule 

OBSSp_GetServiceRecord 

OBSSp_UpdateScheduleRecord 

OBSSp_UpdateServiceExec 

RGSp_UpdateInstance 

RGSp_UpdateLicense 

TmSp_AliasUpdate 

TmSP_CheckDiskSpace 

TmSp_CopyCompany 

TmSp_GetCompList 

TmSP_GetDbSizeByDrives 

TmSp_GetServerTime 

TmSp_GetUsers 

TmSp_Installer_CreateTmSp 

TmSp_Installer_SetFieldValue 

TmSp_RefreshCompList 

TmSp_RestoreCompany 

UpdateClassDef 

UpdateEnumType 

UpdateMetaObject 

UpdateMetaProperty 

UpdateMetaRelationSeqNo 

UpdatePropertyDef 

UpdatePropertyDefSeqNo 

ClearEnumValues 

DeleteAllEnumsAndClasses 

DeleteAllObjects 

DeleteAllPropertyDefs 

DeleteClassDef 

DeleteDependentProperties 
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SBO- COMMON Procedures  

DeleteEnumType 

DeleteMetaObject 

DeleteMetaProperty 

DeleteMetaRelation 

DeletePropertyDef 

InsertClassDef 

 

Company Database Procedures 

Company Database Procedures  

_TmSp_AliasUpdate_OUSR 

_TmSp_AliasUpdateAfter 

_TmSp_AliasUpdateBefore 

_TmSp_ControlAccountUpgrade_OCRD 

_TmSp_ConvertGrpLine_OACT 

_TmSp_ExpnsUpdateOnDocs 

_TmSp_FormattedSearchUpdate 

_TmSp_MthDate_Update_JDT1 

_TmSp_RestoreIsCommited_OIBT 

_TmSp_SetCategoryAtOFPR 

_TmSp_SetLineNumAtADO3 

_TmSp_SetLineNumAtDOC3 

_TmSp_SetLineNumAtDOC5 

_TmSp_SetLineSeqAtDOC4 

_TmSp_SetLineSeqAtPMN5 

_TmSp_SetUniqueDocEntryAtOCRD 

_TmSp_ShekelUpdate 

_TmSp_UpdateCreateDateOnOINM 

_TmSp_UpdateDoubleName 

_TmSp_VariableUpdate_OUQR 
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9 Managing Security in SAP Business One 

Your security requirements are not limited to SAP Business One, but apply to your entire system landscape. 

Therefore, we recommend establishing a security policy that addresses the security issues of the entire company. 

This section offers several recommendations to help you meet the security demands of SAP Business One. 

Your security policy should cover the following aspects: 

 Technical Landscape — Provides an overview of the technical components and communication paths that 

SAP Business One uses. 

 User Management and Authentication — Provides system access to only legitimate users and prevents 

identity impersonation. 

 Database Authentication — Introduces a strong password definition mechanism to restrict unauthorized 

database access. 

 Data Integrity — Allows specified SAP Business One users to run read-only queries on the company database 

using query editors to improve data integrity in the database. 

 SAP Business One Authentication and Authorization — Describes how to restrict access to the SAP Business 

One database. 

 Network Security — Supports your communication needs without allowing unauthorized access to your 

network. 

 Application Security — Restricts access to users with the necessary permissions. 

 Security Solutions for Microsoft SQL Server and Database Tips — Provides recommendations for ensuring 

the security of Microsoft SQL Server. 

 Data Storage Security — Provides recommendations for secure data storage in SAP Business One. 

After establishing a security policy, we recommend that you dedicate sufficient time and resources to implement 

and maintain the required level of security. 

9.1 Technical Landscape 

In SAP Business One, the System Landscape Directory serves as the security server, which saves database 

credentials in the SLD database. 

Database credentials are obtained by supplying SAP Business One logon credentials for authentication against 

the SLD service. Upon successful authentication, connections to common and company databases are 

established using database credentials from the SLD service.  

The following figure provides an overview of the security workflow for SAP Business One. 
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Security Landscape of SAP Business One 

This section provides an overview of how SAP Business One supports an integrated approach to user 

administration and authentication. 

9.2 User Management 

This section provides an overview of the various types of users and user administration within SAP Business One. 

 User Types 

It is necessary to specify different security policies for different types of users. For example, your policy may 

specify that individual users who perform tasks interactively must change their passwords on a regular basis, but 

not users who process job runs. Therefore, SAP classifies the types of users in the application as follows: 

Site User: 

This user is automatically defined in SAP Business One. It is not a company user type that can log on to the SAP 

Business One client application, but serves as site-level authentication for performing the following activities: 

o Creating new companies 

o Installing or upgrading the SAP Business One server 
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o Importing or exporting the license configuration file 

o Assigning read-only users 

o Configuring security settings in the SLD service 

o Registering databases in the SLD service 

 

 B1SiteUser 

The super site user, whose account information should only be known to a few selected system 

administrators, is BiSiteUser. You can update the password of the BiSiteUser in the System Landscape 

Directory, on the Security Settings tab, by choosing the Change B1SiteUser Password button. You will need to 

provide the old password to make the change. The B1SiteUser account cannot be removed. 

 

 Domain Users as Less-Privileged Site Users 

You can assign appropriate domain users as site users to perform administrative tasks that require fewer 

privileges in the System Landscape Directory. To do so, follow the steps below: 

 Note 

Before you can assign domain users as site users, ensure you have entered Windows domain user 

authentication information during the installation of the System Landscape Directory. 

To assign a Windows domain user as a less-privileged site user, do the following: 

1. In a Web browser, log on to the System Landscape Directory. 

2. On the Security Settings tab, choose the Manage Site Users button. 

3. In the Manage Site Users window, in the edit box on the top, enter a domain user account in the 

format of Domain\User. 

4. To assign the domain user as a site user, choose the Add button. 

 Note 

You can delete domain-user site users at any time. Additionally, a domain user can even remove itself as a 

site user. After the removal, the domain user can no longer log on to the System Landscape Directory. 

SAP Business One Company Superusers 

When you create a company, a predefined user named manager exists in the system. Due to the password policy, 

you must change the password of the manager user at the first logon. 

The responsibilities of a superuser include: 

o Defining users in companies and setting user permissions 

o Configuring password policies at the company level 

o Upgrade companies 

SAP Business One Company Regular Users 

You can define company regular users according to different business role requirements. 
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The responsibilities of a regular user are to perform the relevant business work in the SAP Business One 

application. 

 User Administration 

This section describes how to add, remove, or lock an SAP Business One user in the application. 

Locking a user prevents this user from logging on to SAP Business One. By default, all users are unlocked. 

However, if the user fails to log on to the system the number of times defined in Administration → Setup → 

General → Security → Password Administration → Authentications Before User Account is Locked, the user is 

locked automatically. 

 Note 

Only a superuser can add, remove, lock, or unlock an SAP Business One user. 

To add a user in SAP Business One, do the following: 

1. In the SAP Business One Main Menu, choose Administration  Setup  General   Users. 

2. In the Users - Setup window, specify the required user-specific data. 

 

3. Choose the Add button. 

 

To remove a user in SAP Business One, proceed as follows: 



 

 SAP Business One Administrator's Guide 

Managing Security in SAP Business One 

 CUSTOMER  

 ©  2016 SAP SE or an SAP affiliate company. All rights reserved. 159 

 

1. In the SAP Business One Main Menu, choose Administration  Setup  General  Users. 

2. In the Users - Setup window, in the User Code field, specify the user that you want to delete. 

3. Right-click anywhere in the window and choose the Remove button. 

4. Choose the Continue button. 

To lock or unlock a user in SAP Business One, proceed as follows: 

1. In the SAP Business One Main Menu, choose Administration  Setup  General  Users. 

2. In the Users - Setup window, in the User Code field, specify the user you want to lock or unlock. 

 

3. In the Users –Setup window, do the following: 

o To lock a user, select the Locked checkbox. 

o To unlock a user, deselect the Locked checkbox. 

4. Choose the Update button. 

9.2.2.1 Binding SAP Business One Users to Microsoft Windows 
Accounts 

After binding SAP Business One users to Microsoft Windows domain accounts, the users can log on to SAP 

Business One without specifying the user credentials. 
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Prerequisite 

You have enabled SSO functionality in the SLD. For more information, see Enabling Single Sign-On. 

Manual Binding 

The following procedure describes how to bind SAP Business One users one by one: 

 In the SAP Business One Main Menu, choose Administration  Setup  General   Users. 

 In the Users - Setup window, in the User Code field, specify the user that you want to bind. 

 

 In the Bind with Windows Account field, enter the domain and user name of the Microsoft Windows domain 

user account to which you want to bind the user. 

 Choose the Update button. 

Copy User Mappings Between Companies 

You can copy user mappings between two companies provided that the same user exists in both companies. Each 

user is identified by the user code (not the user name). 

Typical scenarios for this function are as follows: 

 You have moved your company database from a test system to a productive system. 
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 You have moved your company database to another server. 

 You have imported and renamed your company database (the old database also exists on the same server). 

To copy user mappings, do the following: 

 Log on to the System Landscape Directory in a Web browser. 

 On the Security Settings tab, in the Authentication section, choose the Copy User Mappings button. 

 In the Copy User Mappings Between Companies window, specify the source and target companies. 

 Note 

To be available for selection, the servers must be registered in the System Landscape Directory. 

However, the company database versions do not matter. 

 To display SAP Business One users whose mappings can be copied, choose the Check button. 

If a user exists only in the source company but is bound to a domain account, the user is displayed as missing 

in the target company. However, if a user exists only in the target company, the user is not displayed. 

 To copy user mappings to the target company, choose the Copy button. 

9.2.2.2 Enabling Single Sign-On 

SAP Business One supports single sign-on (SSO) functionality. You can bind an SAP Business One user account 

to a Microsoft Windows domain account. After starting SAP Business One, users are able to bypass the Choose 

Company window and start using the application without being prompted to enter their SAP Business One logon 

credentials. 

 Note 

After enabling SSO, the Choose Company window displays only the companies to which your Windows 

account is bound. 

 Caution 

Enabling SSO in the SLD activates this functionality for all company databases in the landscape.  

 Caution 

Before enabling SSO, ensure that the machine on which you have installed the server tools for SAP 

Business One is a member of the same Microsoft Windows domain as the machines on which SAP 

Business One clients are installed.  

Procedure 

To enable single sign-on functionality for all users, do the following: 

 To open SAP Business One Service Manager, in Windows, choose Start  All Programs  SAP Business One 

 Server Tools  Service Manager. 

o In the SAP Business One Service Manager window, from the Service dropdown list, select License 

Manager. 

o Choose the Settings button. 
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 To access the SLD service, in the General Settings window, choose the Configure Security button. 

 

 Note 

You can also access the SLD service in a Web browser on the machine on which the SLD service is 

running using the following URL: 
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https://<hostname>:30010/ControlCenter 

 A Web browser opens and displays the logon page for the SLD service. 

 To log on, enter the site user name and password, and then choose the Log On button.  

 On the Security Settings tab, select the Enable Single Sign On (Log On Using Windows Domain 

Account) checkbox. 

 If you want to prevent logons using SAP Business One user accounts and enforce single sign-on using domain 

accounts, select the Disable logons with SAP Business One User Accounts checkbox. 

If you keep this checkbox deselected, users can log on using both SAP Business One user accounts and 

Windows domain accounts. 

 Choose the Update button. 

Result 

Each user must confirm the binding upon first logon. After confirmation, the user can log on to SAP Business One, 

using the bound Windows account. 

If the system administrator has not disabled logons using SAP Business One user accounts, you can still log on 

with an SAP Business One user account (which does not have to be bound to a Windows account), as below: 

  In the logon window, deselect the Logon with Windows Account checkbox (or in the Choose Company 

window, deselect the Log on with Current Domain User checkbox). 

 Manually enter the company database name. 

 Enter your SAP Business One user name and password. 

 Choose the OK button. 

 Caution 

If the system administrator has disabled logons using SAP Business One user accounts, you must bind 

each SAP Business One user to a Windows account and each user must confirm the binding; otherwise, 

logon is not possible. 

 User Authentication 

As standard practice, SAP Business One and the database authenticate users by their user codes and passwords.  

You can change passwords at any time. In addition, the application checks the password validity of each logon 

attempt according to the selected security level. 

If you are required to change your password, the application displays the Password Expiration window. You must 

change the password to log on. 

The new password must comply with the settings of the selected security level, containing at least: 

 x characters 

 x lowercase characters 

 x uppercase characters 

 x numeric digits 

 x non-alphanumeric characters 
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The application saves passwords in the database in encrypted form. The last n passwords are also encrypted. 

When appraising a new password, the application first encrypts it and then compares it with the saved ones. 

The password policy defines global guidelines and rules for password settings, such as the following: 

 Time interval between password changes 

 Required and forbidden letters and characters 

 Minimum required number of characters 

 Number of logon attempts before the system locks the user account 

Password policies improve the security of SAP Business One and enable administrators to apply the required 

security level for their organization. 

 Note 

 Only superusers can change a security level. 

SAP Business One supports the following methods for increasing the security level of user authentication: 

 Increase the complexity of the password. 

 Increase the frequency of password changes. 

For more information about working with passwords in SAP Business One, see SAP Note 978292. 

9.3 Database Authentication 

The default user name of the database administrator is sa and it has full authorization. Therefore, you must 

assign a strong sa password, even on servers that are configured to require Microsoft Windows Authentication. 

This ensures that a blank or weak sa password is not exposed. 

 Caution 

If you change the database administrator account, you must re-install the System Landscape Directory. 

For more information, see Installing Server Tools.  

A strong password is the first step to securing your system. A password that can be easily guessed or 

compromised using a simple dictionary attack makes your system vulnerable. A strong password has the 

following characteristics: 

 Contains alphabetic, numeric, and special characters 

 Is at least seven characters in length 

 Is NOT a common word or name 

 Does NOT contain a name or user name 

 Is significantly different from previous passwords 

Procedure 

To set the password for the sa logon, do the following: 

 Log on to the server as a domain or local Windows Administrator. 

https://service.sap.com/sap/support/notes/978292
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 In Windows, choose Start  All Programs  Microsoft SQL Server 2008  SQL Server Management Studio. 

Upon first logon, in the Connect to Server window, enter the server name (if required) and under 

Authentication, select Windows Authentication. 

 Note  

We recommend that you create another superuser account with the same authorization as the sa user. 

 In the Object Explorer window, under the SQL Server instance, expand Security →Logins. Right-click sa and 

choose the Properties menu.  

 On the General page, enter and confirm the new password for the sa login. 

 Choose the OK button and close the SQL Server Management Studio window. 

 Caution  

To prevent dictionary attacks, create a substitute user for sa that can take daily responsibility for the SQL 

Server database assessment. For more information, see Setting Up an Alternative Admin User.  

9.4 Data Integrity 

To improve data integrity in the database and ensure that changes are not to the database while the application is 

running, you can allow specified SAP Business One users to run read-only queries on the company database using 

the query editors in SAP Business One. You can restrict queries to read-only statements. This means user 

permissions are read only for SQL executions, and querying the database is done using a read-only user. 

 Adding New Databases 

For databases to appear on the logon screen of the application, they must be registered with SAP Business One. 

You can add databases using only the System Landscape Directory.  

 Caution  

The machine running the SLD service and license server should not be accessible physically to any users 

except those who own the site user password. 

Locate the machine running the SLD service and license server in a place that is not easily accessible to 

unauthorized persons. 

Procedure 

To add new databases, do the following: 

 To open SAP Business One Service Manager, in Windows, choose Start  All Programs  SAP Business One 

 Server Tools  Service Manager. 

o In the SAP Business One Service Manager window, from the Service dropdown list, select License 

Manager. 

o Choose the Settings button. 
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 To access the SLD service, in the General Settings window, choose the Configure Security button. 

 

 Note 

You can also access the SLD service in a Web browser on the machine on which the SLD service is 

running using the following URL: 
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https://<hostname>:30010/ControlCenter 

A Web browser opens and displays the logon page for the SLD service. 

 To log on, enter the site user name and password and choose the Log On button.  

 On the Servers and Companies tab, in the Servers area, choose the Add button. 

 In the Add Server window, specify the following: 

o Server Name — Enter the name or IP address of the database server that you want to add. 

 Caution 

Ensure that the name of the server on which you installed Microsoft SQL Server does not contain any 

special characters, such as: &, <, >, ”, or ’. 

o Database Authentication — Select the type of database authentication you want to use. 

 Recommendation 

Select the Database Authentication option, as Windows Authentication has the following limitations: 

o Windows authentication in SAP Business One is a server level configuration. All users on the same 

SAP Business One server can use Windows authentication to connect to Microsoft SQL Server. 

o Windows authentication requires you to maintain each computer added to the domain, while SQL 

Server authentication shares database users (such as sa) on the same SAP Business One server. 

o Windows authentication requires the Microsoft Windows account on which the SLD service runs to 

have administrative permissions on the database. 

For more information about configuring trusted connections, see Troubleshooting Security. 

o Database User Name — Enter the user name of the administrator account for the database. 

o Database User Password — Enter the password of the administrator account for the database. 

  

 To add the database server, choose the OK button. 
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 Editing Existing Databases 

To edit an existing database server in the SLD, do the following: 

 Log on to the SLD service. For more information, see Adding New Databases. 

 On the Servers and Companies tab, in the Servers area, select the database server you want to edit. 

Choose the Edit button. 

 In the Edit Server window, specify the following: 

o Database Authentication — Select the type of database authentication you want to use. 

 Recommendation 

Select the Database Authentication option, as Windows Authentication has the following limitations: 

o Windows authentication in SAP Business One is a server level configuration. All users on the same 

SAP Business One server can use Windows authentication to connect to Microsoft SQL Server. 

o Windows authentication requires you to maintain each computer added to the domain, while SQL 

Server authentication shares database users (such as sa) on the same SAP Business One server. 

o Windows authentication requires the Microsoft Windows account on which the SLD service runs to 

have administrative permissions on the database. 

For more information about configuring trusted connections, see Troubleshooting Security. 

o Database User Name — Enter the user name of the administrator account for the database. 

o Database User Password — Enter the password of the administrator account for the database. 

 

 To save the new settings, choose the OK button. 

 Managing Encryption Keys 

You can encrypt data in SAP Business One company databases using a static key or dynamic key.  
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 Recommendation 

We strongly recommend you use a dynamic key to encrypt SAP Business One databases.   

Procedure 

To enable the use of dynamic keys, do the following: 

 Log on to the SLD service. For more information, see Adding New Databases. 

 On the Security Settings tab, in the Encryption Key Management area, choose the Enable Dynamic Key button. 

 Note 

After enabling the use of dynamic keys, you can generate a new dynamic key at any time. To do so, 

choose the Enable Dynamic Key button again. 

 Caution 

Enabling the use of dynamic keys is an irreversible process. 

 Open the SAP Business One client application, log on to each of your company databases in turn, and accept 

to update the company database.  

Note that this has to be done for all company databases on the servers registered in the System Landscape 

Directory. 

 

9.5 SAP Business One Authentication and Authorization 

SAP Business One has a mechanism to protect the database from easy changes through direct access. 

The advantages of restricting access to the SAP Business One database are: 

 End users are not exposed to database credentials and so cannot change the databases directly, which 

protects the databases from being changed or attacked. 

 Database credentials are stored in the license server and end users can access the database only after the 

application performs a successful site user authentication through the license server. 

 Restricting Database Access 

SAP Business One has a mechanism to protect the database from easy changes through direct access. 

The advantages of restricting access to the SAP Business One database are: 

 End users are not exposed to database credentials and so cannot change the databases directly, which 

protects the databases from being changed or attacked. 

 Database credentials are stored in the System Landscape Directory (SLD) database and end users can 

access the database only after the application performs a successful site user authentication through the 

System Landscape Directory. 
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The System Landscape Directory is the central repository for credentials information, including the database user 

ID and password (one for all SAP Business One users). 

The database credentials are stored safely in the SLD database, with additional encryption. 

The security workflow is as follows: 

 Database consumers, such as the SAP Business One client, DI-API, and Services, provide their SAP Business 

One credentials (SAP Business One user ID and password) to authenticate against the SLD. 

 Following successful authentication, the SLD supplies its credentials and SAP Business One uses them to 

connect. 

For more information, see Technical LandscapeTechnical Landscape.  

 

You can use the SLD service to create different database user accounts for each company database. After 

creating accounts, SAP Business One does not access company databases using the database administrator 

account. Instead SAP Business One uses a different read-only account supplied by the SLD service to access each 

company database.  

 Changing Security Levels 

You can apply different security levels to database access through the SLD: 

 To access the SLD service, in a Web browser, navigate to the following URL: 

https://<Server Address>:<Port>/ControlCenter 

 In the logon page, enter the site user name (B1SiteUser) and password, and then choose the Log On button. 

 Note 

The site user name is case sensitive. 

 On the Servers and Companies tab, select the appropriate server. 

The companies that are registered on the server are displayed in the Companies area. 

 In the Companies area, select the company for which you want to define the security level and choose the Edit 

button. 

 In the Edit Company window, select one of the following options and choose the OK button: 

o Use Database Admin User: SAP Business One accesses the database using an SAP administrator 

account. 

o To grant read-only authorization to non-superusers for queries (system and user-defined) in SAP 

Business One, you must manually create a read-only database user and assign it to the company 

database. For more information, see Queries. 

o Use Specified Database User: The system automatically generates a pair of database users without the 

administrator privileges. SAP Business One accesses the database using one of the database users, 

depending on the specific database transaction. 

o Use Specified Database User for Each Business One User: Most secure and recommended. The system 

automatically generates a pair of database users without the administrator privileges for each SAP 

Business One user. SAP Business One accesses the database using one of the database users, depending 

on the login SAP Business One user and the specific database transaction. 
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Whenever a new SAP Business One user is added, a pair of corresponding database users is added.  

For the second and third options, you do not have to manually create a read-only database user for queries. 

For more information, see Queries. 

 If you selected the second or third option, you can configure the SLD service to automatically change the 

password of the automatically-created database users on a regular basis, as follows: 

1. On the Security Settings tab, in the Authentication area, select the Change Database User Password Every 

<Number> Days checkbox. 

2. Enter the number of days between password resets. 

3. Choose the Update button. 

9.6 Network Security 

We strongly recommend using SAP Business One in trusted environments only (corporate LAN with firewall 

protection).  

 Communication Channels 

TCP provides the communication channels between the following: 

 SAP Business One server ⇔ SAP Business One clients 

 SAP Business One server ⇔SAP Business One license server 

 SAP Business One server ⇔ the agent of the remote support platform for SAP Business One 

 SAP Business One license server ⇔ SAP Business One clients 

 System Landscape Directory ⇔ SAP Business One clients 

The default communication port is 1433. 

The default ports of the SAP Business One license server are 30000 for license communication and 30001 for the 

license naming service. 
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The default ports of the SAP Business One license server are 30003 for SSL-encrypted license 

communication and 30002 for the SSL-encrypted license naming service. 

The default port of the SLD service is 30010. 

 SSL Encryption 

You can secure the following communication channels using SSL encryption: 

 SAP Business One server ⇔ SAP Business One clients 

 SAP Business One license server ⇔SAP Business One clients 

 Note  

Using SSL encryption may degrade network performance. SSL encryption requires certificates, which are 

time limited and require annual renewal. You can acquire the necessary certificates using either of the 

following methods: 

o Third-party Certificate Authority 

You can purchase certificates from a third-party global Certificate Authority that Microsoft Windows 

trusts by default. 

o Certificate Authority Server 

You can configure a Certificate Authority (CA) server to issue certificates. If you choose this method, 

you must configure all machines in your SAP Business One landscape to trust the CA’s root 

certificate. 

9.6.2.1 Encrypting Communication with Databases 

To secure the TCP/IP communication channel between the database server and SAP Business One clients, you 

can implement SSL encryption. This prevents SAP Business One application data, including the database 

credentials, from being exposed. 

SAP Business One fully supports SQL SSL. We recommend that you implement SSL in SAP Business One without 

making configuration changes in SAP Business One. For more information, see 

http://support.microsoft.com/kb/316898 or contact your IT administrator. 

For information about Microsoft SSL encryption guidelines, see www.msdn.microsoft.com and search for the 

following topics: 

 Net-Library Encryption 

 Client Net-Libraries 

http://support.microsoft.com/kb/316898
http://www.msdn.microsoft.com/
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9.6.2.2 Encrypting Communication with License Servers 

To secure the TCP/IP communication channel between the SAP Business One license server and SAP Business 

One clients, you can implement SSL encryption. Communication between the license server and DI API is also 

encrypted. 

Prerequisites 

 You have installed OpenSSL (32-bit) on the SAP Business One license server.  

 You have installed OpenSSL on the client machines to which you want to encrypt communication, as follows: 

o If you are using the 32-bit version of the SAP Business One client and DI API, install the 32-bit version of 

OpenSSL. 

o If you are using the 64-bit version of the SAP Business One client and DI API, install the 64-bit version of 

OpenSSL. 

Procedure 

To implement SSL encryption for communication between the SAP Business One license server, do the following: 

 Prepare the following two certificates:  

1. ClientCert.crt: a public key certificate for SAP Business One Client use. 

2. ServerCert.pfx: a PKCS12 format certificate, for license server use.  

 Note 

o Both certificates include a private key and public key. ServerCert.pfx must be signed by the private 

key of ClientCert.crt.   

  Note 

o If you choose to purchase a signed certificate from a trusted third-party global Certificate Authority 

(CA), ensure that there is a public key certificate for the CA in your Windows Certificate Store. 

o If you do not choose to purchase a signed certificate from a trusted third-party global Certificate 

Authority (CA), you can manually generate certificates for both the SAP Business One Client and 

license server. To do so, perform the following: 

1. Navigate to the directory in which OpenSSL is installed (for example, C:\,  C:\OpenSSL-Win32\bin). 

2. Enter the following command lines in OpenSSL:  

o To generate a private key for SAP Business One Client,  enter the following command:  

o openssl genrsa -des3 -out ClientKey.key 1024 

o To remove the passphrase for the SAP Business One Client certificate, enter the following command: 

openssl rsa -in ClientKey.key -out ClientKey.key 

o To generate a private key for the license server, enter the following command:  

o openssl genrsa -des3 -out ServerKey.key 1024 

o To remove the passphrase of the license server certificate, enter the following command:   

o openssl rsa -in ServerKey.key -out ServerKey.key 
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o To generate a self-signed certificate for the SAP Business One Client (also used to sign the license 

server certificate), enter the following command:  

o openssl req -new -x509 -key ClientKey.key -out ClientCert.crt -days 3650  

o To generate a certificate request from the private key of the certificate for the license server, enter 

the following command:  

o openssl req -new -key ServerKey.key -out ServerCertReq.csr                                  

o To request the SAP Business One Client certificate to sign the license server certificate, enter the 

following command: 

o openssl x509 -req -days 3650 -in ServerCertReq.csr -CA ClientCert.crt -CAkey 

ClientKey.key -CAcreateserial -out ServerCert.crt  

o To create a PKCS12 format certificate for the license server from the private key and public key, enter 

the following command: 

o certificate.openssl pkcs12 -export -inkey ServerKey.key -in ServerCert.crt -

out ServerCert.pfx      

 When the certificates for the SAP Business One Client and license server are ready, import them as follows: 

o To import the certificate for the license server, do the following: 

1. To open the Microsoft Management Console (MMC), choose Start and enter mmc in the search box. 

2. In the Console Root window, in the menu bar, choose File → Add/Remove Snap-in... 

3. In the Add or Remove Snap-ins window, select Certificates and then choose Add. 

4. In the Certificates snap-in window, choose the Computer account radio button and then choose Next. 

5. In Select Computer window, choose the Local computer: (the computer this console is running on) 

radio button, choose Finish, and then choose OK. 

6. In the Console Root window, click Certificates (Local Computer), click the Personal folder, right-

click Certificate, and select All Tasks → Import... 

7. In the Certificate Import Wizard window, choose Next. 

8. Choose the location of the license server certificate (ServerCert.pfx) and then choose Next. 

9. Enter the password of the private key (if you generate the certificate yourself, use the password you 

entered in last the step described in the Prerequisites section), then select the Mark this key as 

exportable…” checkbox and choose Next. 

10. Choose Next and Finish. 

o To import the certificate for the SAP Business One Client, do the following: 

1. To open the Microsoft Management Console (MMC), choose Start and enter  mmc in the search box. 

2. In the Console Root window, in the menu bar, choose File → Add/Remove Snap-in... 

3. In the Add or Remove Snap-ins window, select Certificates and then choose Add. 

4. In the Certificates snap-in window, choose the My user account radio button and then choose Next. 

5. In the Select Computer window, choose Local computer: (the computer this console is running on), 

choose Finish, and then choose OK. 

6. In the Console Root window, click Certificates (Local Computer), click the Personal folder, right-

click Certificate, and select All Tasks → Import... 

7. In the Certificate Import Wizard window, choose Next. 

8. Choose the location of the SAP Business One Client (ClientCert.crt), and then choose Next. 

9. Choose Next and Finish. 

 Configure the license server: 
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1. Import a valid SSL certificate to the Windows Certificate Store. 

2. In the SAP Business One Service Manager window, from the Service dropdown list, select License 

Manager. 

3. Choose the Settings button. 

4. In the General Settings window, choose the Configure SSL button. 

5. In the SSL Settings window, choose the Enable button. 

6. In the Windows Security window, select the valid SSL certificate that you imported in step 2. 

7. Choose the OK button. 

 Configure client machines: 

1. In HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAP Manage\SAP Business One, add the following 

registry key: 

o Key name – UseSSLInLicenseConnection 

o Key type – REG_DWORD 

o Key value – 0x0 (disabled) or 0x1 (enabled) 

2. Configure the client machine to trust the root certificate of your certificate authority server. 

9.7 Application Security 

SAP Business One provides features to ensure that unauthorized access to the application does not occur. 

 Password Encryption 

In SAP Business One, a strong algorithm is used for data encryption and decryption. The site user ID and 

password are encrypted and saved in the System Landscape Directory. 

 Recommendation 

Set a site user password that is at least as strong as that defined in the company password policy, and 

change it frequently. 

You can change the site user password using the SLD by providing the current password or authenticating with 

database credentials to prove you have at least a database administration level. 

To change the site user password, do the following: 

 To open SAP Business One Service Manager, in Windows, choose Start  All Programs  SAP Business One 

 Server Tools  Service Manager. 

o In the SAP Business One Service Manager window, from the Service dropdown list, select License 

Manager. 

o Choose the Settings button. 
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 To access the SLD service, in the General Settings window, choose the Configure Security button. 

 

 Note 

You can also access the SLD service in a Web browser using the following URL: 

https://<hostname>:30010/ControlCenter 
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 A Web browser opens and displays the logon page for the SLD service. 

 To log on, enter the site user name and password and choose the Log On button.  

 On the Security Settings tab, in the Site Password area, choose the Change button. 

 In the Change Site Password window, enter the current password, then enter and confirm the new password 

you want to use. 

  

 To complete the process and change the password, choose the OK button. 

 B1_SHR Folder Permissions 

The SAP Business One server installation process creates the B1_SHR folder, which contains the SAP Business 

One client setup files. 

Operating System User SBO_SHR Permission 

Microsoft Windows 2003 Server, Microsoft 

Windows 2003 R2, 

Microsoft Windows 2003 Server Small 

Business, 

Microsoft Windows XP and Microsoft 

Windows 7 

Power User Modify and Write 

User Read and execute 

List folder contents 

Read 

 Queries 

The query wizard and query generator enables you to define queries on the SAP Business One database. These 

tools are designated for SELECT sentences only and cannot be used for any kind of update operation. To protect 

your data, we recommend that you make sure users have the appropriate permissions. However, the data results 

returned are not filtered according to the user’s authorization. 
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Granting Read-Only Authorization for Query Results 

To enable an SAP Business One user to view the results of both system and user-defined queries, you can directly 

grant the user full authorization to the Execute Non-select SQL Statement permission item in the General 

Authorizations window in the SAP Business One client application. However, we recommend that you grant read-

only authorization to all non-superusers in one of the following ways: 

 Do the following: 

 Recommendation  

 Configure SAP Business One to access your company database using database users without administrator 

privileges.  

 Grant No authorization to all non-superusers in the General Authorizations window. 

This way, users with No authorization to the Execute Non-select SQL Statement permission item will 

access the database through a read-only database user while users with authorization to the permission item 

will access the database through another database user with lower database privileges. 

 If you configure SAP Business One to access your company database using a database administrator user, do 

the following: 

1. Apply No authorization to all users to the Execute Non-select SQL Statement item. 

2. Create a read-only database user in SAP Business One and define the user password. 

3. Assign the database user to the company in the Read-Only DB User window in the SAP Business One 

client application. For more information, see the online help. 

For more information about configuring the way SAP Business One accesses your company database, see 

Restricting Database Access. 

 

 Add-On Access Protection 

When you install an add-on, SAP Business One creates a unique digital signature using the MD5 technique 

(message-digest algorithm). SAP Business One identifies the add-on by validating its digital signature. 

 SAP Business One Dashboards 

Dashboards are an element of the cockpit, which is delivered as part of SAP Business One. They present an easy-

to-understand visualization, such as a bar or pie chart, of transactional data from the SAP Business One database. 

With SAP Business One, SAP delivers predefined dashboards for financials, sales, and service. In addition, SAP 

Business One partners and customers can create their own dashboards. 

 Recommendation  

When you receive dashboard content from your partner, we recommend that you copy this content to a 

computer that has a state-of-the-art virus scanning solution with the most current virus signature 

database installed and scan the file for infections before uploading the it to the server. 
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9.8 Security Solutions for Microsoft SQL Server and Database 
Tips 

We recommend that you take the following actions to ensure the security of your Microsoft SQL Server. 

 Upgrading Microsoft SQL Server 

We recommend upgrading the SQL server to the latest service pack. Furthermore, administrators should 

regularly consult the SQL Server Security Center at www.microsoft.com. 

Note 

You must upgrade SAP Business One before upgrading the Microsoft SQL Server if the existing version of 

SAP Business One does not support the newer SQL version.  

 

For information about the upgrade sequence for Microsoft SQL Server, see the following documents: 

  SAP Note 928839.  

 "Hardware and Software Requirements for Installing SQL Server 2014" as stipulated by Microsoft® Corp. 

 Securing Microsoft SQL Server  

Since SAP Business One is a two-tier application, much of the application security depends on the database 

server security and on the authorization mechanism. Be aware that users can access the database using tools 

other than SAP Business One and, therefore, can modify the logon information. To secure your database, we 

recommend adhering to Microsoft security guidelines. For more information, see the Microsoft documents at 

www.microsoft.com. 

9.8.2.1 Setting Up an Alternative Admin User  

If you are using SQL authentication, when you register a database server in the SLD (9.0 and higher) or license 

server (release family 8.8), you need to specify a database admin user for the server. This alternative admin user 

can be used for creating and upgrading companies and performing other landscape management tasks in the 

SLD.   

Procedure 

To create an alternative admin user account for maintaining administration tasks for SAP Business One, do the 

following: 

 In Windows, choose Start  All Programs  Microsoft SQL Server 2008  SQL Server Management Studio. 

http://www.microsoft.com/
https://i7p.wdf.sap.corp/sap/support/notes/928839
http://msdn.microsoft.com/en-us/library/ms143506.aspx
http://www.microsoft.com/
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 In the SQL Server Management Studio Object Explorer window, choose Security  Logins. 

 Right-click the Logins folder and choose New Login.  

The Login - New window appears. 

 On the General tab, select SQL Server authentication and enter a strong password. 

 On the Server Roles tab, select sysadmin. 

 Choose the OK button. 

 Recommendation 

When you create a company database in 9.1 or higher, we recommend that you enable the database user per 

company in SLD. To do so, perform the following: 

 Log on to the SLD service. For more information, see Adding New Databases. 

 Selecting the appropriate server and company and then choose the Edit button.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 In the Edit Company window, select the Use Specified Database User radio button.  

The SLD creates a database user for this company with the appropriate database roles, which is then used by 

the SAP Business One client to connect to the database.  

 Choose the OK button. 

 

If you are using Microsoft Windows authentication, you must grant SAP Business One admin users the sysadmin 

and public server roles. When creating or upgrade companies, you must use this admin user to launch the SAP 

Business One client or upgrade wizard. 

For normal SAP Business One users, you need to grant admin users the following roles:  

 For the common database: db_datawriter and db_datareader  

 For the company database: db_owner  
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 Note  

You cannot set up a local user which is not in the Active Directory. 

 Revoking Guest Access to the msdb Database 

 To open SQL Server Management Studio, in Windows, choose Start  All Programs  Microsoft SQL Server 

2008. 

 In the Connect to Server window, specify values in the Server name and Authentication fields, and choose the 

Connect button. 

 In the SQL Server Management Studio Object Explorer window, choose Databases  System Databases  

msdb  Security  Users. 

 In the structure, right-click the Guest user and choose Delete. 

9.9 Data Storage Security 

The security of the data saved in SAP Business One is generally the responsibility of the database provider and 

your database administrator. As with your application infrastructure, most of the measures that you should take 

depend on your strategy and priorities.  

There are a few general measures, as well as database-specific measures, that you can take to increase the 

protection of your data. Details are provided in the following sections: 

 Exporting the Configuration File 

 Importing the Configuration File 

 Configuration Logs and User Settings 

 Exporting Configuration Files 

To secure your data, we recommend that you export your security configuration file right after you finish installing 

the license server and the SAP Business One server. 

The configuration file contains the following important information: 

 Site user password 

 Database information 

 Read-only database user information 

 Algorithm information 

Procedure 

To export the security configuration file, do the following: 



 

182 

CUSTOMER  

©  2016 SAP SE or an SAP affiliate company. All rights reserved. 

 SAP Business One Administrator's Guide 

Managing Security in SAP Business One 

 

 To open SAP Business One Service Manager, choose Start  All Programs  SAP Business One  Server 

Tools  Service Manager. 

 In the SAP Business One Service Manager window, from the Service dropdown list, select License Manager 

and choose the Settings button. 

 

 To access the SLD service, in the General Settings window, choose the Configure Security button. 
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 Note 

You can also access the SLD service in a Web browser using the following URL: 

https://<hostname>:30010/ControlCenter 

 A Web browser opens and displays the logon page for the SLD service. 

 To log on, enter the site user name and password and choose the Log On button.  

 On the Security Settings tab, in the Encryption Key Management area, choose the Export Dynamic Key button. 

 Recommendation  

The site user password is required if you later import the security configuration file to restore the 

configured security settings. Thus, keep a record of the site user password when you are exporting the 

configuration file, especially if you want to change the site user password after the configuration file is 

exported. 

 Importing Configuration Files 

If your license server crashes or is corrupted, you must set up a new license server. After the new license server is 

started up, to restore all the security settings you had before, you can import the security configuration file.  

Prerequisites 

 You have a record of your old security configuration file. For more information, see Exporting Configuration 

Files. 

 You have placed the appropriate configuration file on the server under the directory: C:\Program Files 

(x86)\SAP\SAP Business One ServerTools\System Landscape Directory\incoming. 

Procedure 

 To open SAP Business One Service Manager, choose Start  All Programs  SAP Business One  Server 

Tools  Service Manager. 

 In the SAP Business One Service Manager window, from the Service dropdown list, select License Manager 

and choose the Settings button. 
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 To access the SLD service, in the General Settings window, choose the Configure Security button. 

 

 Note 

You can also access the SLD service in a Web browser using the following URL: 

https://<hostname>:30010/ControlCenter 
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 A Web browser opens and displays the logon page for the SLD service. 

 To log on, enter the site user name and password and choose the Log On button.  

 On the Security Settings tab, in the Encryption Key Management area, choose the Import Dynamic Key button. 

 In the Import Dynamic Key window, do the following: 

o Select the configuration file that you want to import. 

o In the Site User Password For Export field, specify the site user password you had when the configuration 

file was exported. 

o To import the file, choose the OK button. 

  

 Configuration Logs and User Settings 

In SAP Business One, configuration changes are logged in files formatted as xxx.pidxxxxx (xxx after pid can be the 

date, such as 20100325, so that you can find the latest log file) under %UserProfile%\Local 

Settings\Application Data\SAP\SAP Business One\Log\BusinessOne. 

The configuration changes include: 

 Adding/Removing users 

 Changing a user to a superuser / non superuser 

 Changing user passwords 

 Changing user permissions 

 Changing password policy 

 Changing company details 

 Note  

To find the logs containing changes to company details, do the following: 
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1. From the SAP Business One Main Menu, choose Administration → System Initialization → Company 

Details. 

2. In the menu bar, choose Tools → Change Logs. 

However, the following configurations cannot be logged: 

 Changing data ownership authorizations 

 Changing data ownership exceptions 

 Changing license settings 

 Setting Read-Only DB users 

If you fail to log on to SAP Business One, the log is recorded in the Event Viewer. 

As of SAP Business One 2007, any specific user settings are saved in a file named b1-current-user.xml under 

C:\Documents and Settings\XXX(user id)\Local Settings\Application Data\SAP\SAP 

Business One. In this situation, if a user changes his or her settings in SAP Business One, the changes are saved 

in this folder and do not affect other users' settings. 

9.10 Security Information for Integration Solutions 

 Security Aspects Related to the DATEV-HR Solution 

This scenario requires maximum levels of data security and sensitivity, because it exports personal data. The 

DATEV-HR scenario generates employee data for DATEV eG using SAP Business One data. The integration 

framework writes the data to a specified directory in the file system. Make sure that only authorized persons have 

access to the folder. 

Ensure that only authorized persons have access to the integration framework administration user interfaces. 

Alternatively, collect confirmations from all users who have access that they are aware that this data is sensitive, 

and that they may not distribute any data to third parties or make data accessible to non-authorized persons. 

 Security Aspects Related to the Mobile Solution 

After the mobile user enters the correct user name and password, the front-end application passes the mobile 

phone number and mobile device ID (MAC address), together with the user name and password, to integration 

framework. 

After receiving the information, the integration framework verifies the following: 

 Whether the user is enabled as a mobile user 

 Whether the necessary license is assigned to the user 

 Whether it can find the telephone number and device ID pair in the SAP Business One user administration 

 Whether the user name matches the telephone number and the device ID 

 Whether the user has been blocked by the SAP Business One system 

 Whether the provided password is correct 

Then the user is allowed to access the system. 
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The password is encrypted while it is transmitted to the integration framework, which decrypts the password after 

receiving it. 

Using HTTPS 

To make communication safer, you have the option to use HTTPS for the sessions in the integration framework. 

On the server side you can configure the communication protocol (HTTP or HTTPS). On the client side, you have 

the option to switch to the HTTPS protocol. By default, the solution runs with HTTPS, and the integration 

framework allows incoming calls through HTTPS only.  

SAP Business One mobile apps require a valid SSL certificate. For more information about obtaining and installing 

valid certificates, see SAP Note 2019275. 

License Control 

All mobile users have to be licensed before being allowed to access the SAP Business One system through the 

mobile channel. License administration is integrated with the SAP Business One user and license. 

The mobile user also needs the assignment of the B1i license. Authorization within the SAP Business One 

application depends on the user’s SAP Business One application license. 

 Security Aspects Related to the Integration with SAP 
Customer Checkout 

All connections between SAP Customer Checkout and the integration framework are http connections that can be 

secured. The system landscape directory entries related to SAP Customer Checkout are 001sap0011 and 

001sap0013 configured using basic authentication with user name and password. 

The technical connection to the SAP Customer Checkout monitor (001sap0013) is an http connection using basic 

authentication. 

 Security Aspects Related to the RFQ Scenario with Online 
Quotation 

 Note 

The configuration information for the RFQ integration solution is available in the integration framework. 

To access the documentation, logon to the integration framework, choose Scenarios  Control, and for 

the sap.B1RFQ scenario package, choose the Docu button. 

You must provide vendors included in the RFQ process access to the online purchasing document on the 

integration framework server. 

You can accomplish this by restricting access to the server to a minimum. To restrict access to the server, 

configure the network (NAT) firewall as shown below: 

https://service.sap.com/sap/support/notes/2019275
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 Only allow external access to the particular hostname / IP-address 

 Only allow external access to the configured server port. 

Default: port 8080 for HTTP, or port 8443 for HTTPS 

 If applicable and available for the particular firewall, configure the restricting URL: 

http://<hostname>:<portnumber>/B1iXcellerator/exec/ipo/vP.0010000100.in_HCSX/com.sa

p.b1i.vplatform.runtime/INB_HT_CALL_SYNC_XPT/INB_HT_CALL_SYNC_XPT.ipo/proc? 

9.11 Troubleshooting Security 

Windows Authentication support is only for SAP Business One backward 
compatibility. 

To configure Windows Authentication, you must provide Windows credentials. 

Ensure the following prerequisites: 

o The Windows user has permission to start the SAP Business One license service. 

o The Windows user is registered in Microsoft SQL Server. 

 

Ensure that your Microsoft Windows account has rights to log on to the license server, because after Windows 

Authentication is configured, the license server service runs with this Windows account. 

To check the configuration of your Microsoft Windows account on the computer where your license server is 

running, do the following:   

1. In Windows, choose Start → Control Panel → Administrative Tools → Local Security Policy. 

2. In the Local Security Policy window, choose Local Policies → User Rights Assignment. 

3. In the User Rights Assignment window, select the Log on as a service item and double-click the item. 

4. In the Log on as a service Properties window, choose the Add User or Group button. 

5. Check if your Microsoft Windows account is in the Enter the object names to select (examples) field, and if 

not, add it and try again. 
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To check or correct your computer name, which is necessary to install Microsoft SQL Server, do the following: 

1. In Windows, choose Start → Control Panel → System. 

2. In the System Properties window, select the Computer Name tab. 

3. In the Computer name field, check the computer name. 

4. To correct the computer name, choose the Change button. 

5. In the Computer Name/Domain Changes window, specify a new name for the computer and choose the 

OK button. 

 

Cannot change database user password for System Landscape Directory 

When installing the System Landscape Directory (SLD), you must fill in the account information of an SAP 

Business One database administrator user. If you change the password of the database user after the installation, 

the SLD stops working.   

To update the database user password, perform the following steps: 

 On the server, navigate to the folder <Installation Path>\System Landscape Directory\tools\.  

 Execute the batch file update_db_credential.bat.  

 In the command prompt, enter the following information step by step:  

1. Path to the server.xml file (<Installation Path>\System Landscape 

Directory\tomcat\conf\server.xml).  

2. JDBC URL: If you have not changed the hostname or IP address of the SQL server, you can directly press 

ENTER to skip this step. The format of the URL is:  

jdbc:sqlserver://<Hostname/IP>\<Instance Name>:<Port>; DatabaseName=<SLD 

Database>  

3. The database user name.  

4. New password for the database user.  

Cannot change security certificate for System Landscape Directory 

If you use a database user to install the System Landscape Directory (SLD) and then later change the password 

for the database user, the SLD cannot connect to the SAP Business One client and you are unable to change the 

certificate for secure connection to the SLD.   

To update the certificate, perform the following steps: 

 On the server, navigate to the folder <Installation Path>\System Landscape Directory\tools\.  

 Execute the batch file update_https_certificate.bat.  

 In the command prompt, enter the following information step by step:  

1. Path to the tomcat server for the SLD (<Installation Path>\System Landscape 

Directory\tomcat\).  

2. Path to the new certificate.  

3. Password for the new certificate. 
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10 Getting Support 

We recommend that you assign a contact person who can deal with issues concerning SAP Business One. This 

contact person should follow the support process described below. If you cannot solve a problem using this 

process, contact SAP support. 

 Note  

Before you contact SAP support, check the version information of your SAP Business One application. 

To view the version number, from the SAP Business One Help menu, choose About. 

You can get support from your partner using either the Customer Portal or the Hotline. 

The Hotline is a number provided by your partner that you can call to get support during official support hours. 

The partner support staff logs the problem on SAP Service Marketplace. The partner support staff try to solve 

your problem. If they are unsuccessful, they forward the problem to the SAP Support team. 

 Recommendation  

You can log your problem message in SAP Business One Customer Portal at 

http://service.sap.com/smb/sbocustomer/documentation. This lets you track the status of the 

message. Your SAP Business One partner can provide a user name for this portal. There you can find 

more information about how to create a message and track its status. 

10.1 Using Online Help and SAP Notes 

If you have a question or problem concerning SAP Business One, check the online help. 

If that does not provide an answer, search for corresponding SAP Notes, as follows: 

Procedure 

 Log on to the SAP Business One portal as follows: 

o If you are a partner, log on to http://sappartneredge.com. 

o If you are a customer, log on to https://service.sap.com/smb/sbocustomer. 

 Choose the SAP Notes option. 

You can either display a Note directly by providing the number of the Note, or you can search for a Note by 

entering key words.  

 Recommendation  

The following example illustrates the difference between a usable and an unusable search. 

Problem Message 

“The performance of the SAP Business One program is not acceptable. Executing 

all operations takes a long time. The problem occurs only on one front-end.” 

http://service.sap.com/smb/sbocustomer/documentation
http://sappartneredge.com/
https://service.sap.com/smb/sbocustomer
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o Use: Key words Performance and Front End. Specify the component SBO-BC*  

o Do not use: Phrases such as SAP Business One runs long or SAP Business One is too slow. 

10.2 Using the Support Desk 

You can use the support desk to search for known solutions in the SAP support database on SAP Service 

Marketplace. The support desk establishes a direct link to SAP Service Marketplace, which stores all the known 

solutions to known problems. 

For more information, see the online help for SAP Business One on the SAP Business One product DVD or in the 

documentation area of SAP Business One Customer Portal at 

https://service.sap.com/smb/sbocustomer/documentation. 

Prerequisites 

You have a valid S user ID number. 

An S user has authorization to access online support functions offered by SAP. The S user ID information is 

shipped with the SAP Business One product. If this information is missing or incorrect, contact your SAP Business 

One partner. 

Procedure 

To find solutions on SAP Service Marketplace, do the following:  

 From the SAP Business One menu bar, choose Help → Support Desk → Find a Solution. 

The Support Desk – Find a Solution window appears. 

 In the Search Term field, enter one or more words for which to search. 

You can search for key words or phrases of up to 60 characters. 

 Choose the Find button. 

The system calls up the connection to SAP Service Marketplace. 

 Specify your S-user ID and password. 

The system defaults your search criteria and the application area to SBO* and starts the search. 

https://service.sap.com/smb/sbocustomer/documentation
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